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1. PI System Basics 

1.1 What is a PI System? 

Objectives 

• Define the components of a PI System.  

• Draw a diagram of the architecture of a PI System. 

1.1.1 The PI System described 

The PI System collects, stores, and manages data from your plant or process. Your 
data sources connect to one or more PI Interface nodes. The PI Interface nodes 
collect data from your data sources and store into the PI Data Archive.  
Asset Framework (AF) organizes and enhances the data. Users consume the data 
by the use of a tool of the PI Visualization Suite (PVS) such as PI Vision. 

 

The following is a diagram of the components of a simple PI System: 
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1.1.2 PI System Components 

In a more detail, the following components constitute the PI Server: 

 

Data Archive 

The PI Data Archive is a component of the PI 
Server that provides efficient storage and archiving 
of time series data enabling high performance data 
retrieval by client software.   

Note: Traditionally, the PI Data Archive was referred to as the 
"PI Server”. 

Asset Framework 

PI Asset Framework (PI AF) is a single repository 
for asset-centric models, hierarchies, objects, and 
equipment. It integrates, contextualizes, refines, 
references, and further analyzes data from multiple 
sources, including one or more PI Data Archives 
and non-PI sources such as external relational 
databases. 

Asset Analytics 

A feature of PI Asset Framework (PI AF) used to 
create and manage analyses. Analyses read values 
of PI AF attributes, perform calculations, and write 
results to other attributes or create event frames. 

Event Frames 

Event Frames help to capture, track, compare, or 
analyze important process or business events and 
their related data for a repeatable period of time. 
Event frames represent occurrences in your process 
that you want to know about, such as asset 
downtime, process excursions, equipment startup or 
shutdown, environmental excursions, product 
tracking batches, product runs, or operator shifts. 

Notifications 

The PI System can send notifications to users or 
systems when key events occur. You set conditions 
that define these events and specify notifications for 
them, including recipients and actions to take, such 
as what to do when a recipient is unavailable. In 
operation, the PI System detects the events you 
specified and automatically generates and sends 
out notifications for them. 
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1.1.3 Machine Friendly and Human Friendly Side in the PI System 

 

Machine Friendly Side: 

• PI Interfaces and Connectors 

• PI Data Archive 

• PI Tag 

 

 

 

 

 

 

PI Interfaces and Connectors 

PI Interfaces collect data from external data sources, providing real-time, fault-
tolerant data to the PI System. 

PI Connectors are similar to PI Interfaces. They collect data from sensors and control 
systems. Different to interfaces, they also automatically create a PI Asset Framework 
(AF) model for your asset. (In that regard, also belong to the human friendly side) 

 

PI Tag 

A unique storage point for data in the PI System.  It is simply a single point of 
measurement. A point represents a single named stream of data coming from an 
instrument, device or sensor (-> time-series data).  

Note: A PI tag is the same as a PI Point.  
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Human Friendly Side: 

• PI Asset Framework 

• Assets and Attributes 

• Visualization Tools 

 

 

 

 

 

 

Assets  

In AF, the equipment and processes that you want to monitor 
are called assets. An asset represents a logical or physical 
component of a process. Example assets include company 
locations, sites, and pieces of equipment.  

Assets are configured in AF as elements. The AF representation 
of all your assets and processes together is called an asset 
model, which is a hierarchical structure.  

 

 

Attributes 

An attribute represents a unique property associated with an asset. 

 

Attributes can hold simple values representing fixed information such as the 
manufacturer of a pump. Attributes can also reference a PI point, a formula, a value 
from a relational database or internal AF table, and other information. 
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1.1.4 Architecture of a Typical PI System 

Sometimes the architecture can be very simple. Some customers have as few as 
one or two PI Interfaces feeding data to a Data Archive from which the data can be 
consumed by various applications. The following is an example of a fully developed 
PI System, which includes most of the widely used OSIsoft products. 

 

 

 

In the diagram above, two PI Data Archive computers are shown to represent a PI 
Data Archive collective. A collective is a configuration of multiple servers that act 
as a logical PI Data Archive server in your PI System to provide high availability 
(HA), disaster recovery, load distribution, and increased scalability. A collective 
consists of one primary server and one or more secondary servers. 

For information on high availability options for PI Asset Framework refer to KB 
article: KB00634 - High Availability (HA) options for PI Asset Framework (PI AF) 

Note: In computer security, a demilitarized zone, named after the military usage of the term and 
normally abbreviated to DMZ; also known as a Data Management Zone or Demarcation Zone or 
Perimeter Network, is a physical or logical subnetwork that contains and exposes an 
organization's external services to a larger, untrusted network, usually the Internet. The purpose 
of a DMZ is to add an additional layer of security to an organization's Local Area Network (LAN); 
an external attacker only has access to equipment in the DMZ, rather than the whole of the 
network. [Reference: http://en.wikipedia.org]  
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1.2 The Basic Building Blocks in the PI System 

 

 

1.2.1 Point Properties   

Data Archive points have a set of properties that define them (these properties are 
called attributes of the tag). Some common properties are defined in the following 
paragraphs. 

 

Point Name 

This is the unique name used to create points for storage in the Data Archive. 
Examples:  P294H.FI.PV, M03_E1P1_MOTDRV1202_RUNSTAT  

 

Descriptor 

This is the human-friendly description of the Data Archive point.  The descriptor is 
often a search criterion since the point name is not always intuitive.  Often the point 
name is some sort of abbreviated convention and the descriptor captures the “full 
name.” 

 

Point source 

Points can be related to their interfaces that collect the data by a point attribute 
called pointsource.  Grouping by point source allows all of points associated with a 
particular device to be identified by searching for all points of a certain point source. 
This assumes that the user knows the point sources in use and that will not be true in 
some situations. 

 

Point type 

This is the attribute that specifies the data type for the values that a point stores. The 
possible point types are: 

int16, int32, float16, float32, float64, digital, string, BLOB, timestamp 
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1.2.2 Attribute Data Reference Types 

Attributes represent a unique property associated with an asset. The Data Reference 
Type of an attribute defines from where to get the data for the attribute. The following 
Data Reference Types exist: 

•  PI Point  

•  PI Point Array  

•  Formula  

•  Table Lookup  

•  String Builder  

•  URI Builder  

Note: <none> means there is a static value for this attribute. 

Data Reference Types (Setting Examples) 
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1.2.3 Directed Activity – Assets Defined: Data Reference Types 

 

You are invited to watch what the instructor is doing or perform the 
same steps at the same time to explore the different concepts 
presented in this chapter or section. 

 

Problem Description 

Identify the type of attribute data references in the AF Server. 

 

Questions 

Identify the corresponding Data Reference Type of the following attributes: 

 

1. Nominal Power: There is a list with the nominal pressures for all the pumps 
in the pump room and information can be read out of that list. 

_____________________________ 

2. Flow Rate: receives actual measurements from the data source. There is a 
related tag in the PI Data Archive.  

_____________________________ 
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3. Pump Location: Specifies the location of the pump. The location 
corresponds to the name of the parent element. 

_____________________________ 

4. Electrical Current: maximum amperage of a pump. The electrical current of 
a pump is calculated from the nominal power of the pump and the voltage 
(220 V). 

_____________________________ 

5. Manufacturer: brand of the pump. This information never changes. 

_____________________________ 

6. AdHoc Pressure trend: link to PI Vision with parameters to specify the 
element and the attribute and the start and end time for the trend. 

_____________________________ 
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1.3 Time and the PI System 

Objectives 

• Define the time abbreviations in the PI System. 

• Define the time expressions in the PI System. 

• Introduction to Future Data. 

• Explain how the PI System handles times zones and daylight savings time 
(DST). 

 

You can use a special syntax, called PI System time, when specifying inputs for 
timestamps and time intervals. The PI System time uses specific abbreviations, 
which you combine to create time expressions.  
 

1.3.1 PI System Time Abbreviations 

When specifying a PI System time, you can use specific abbreviations that represent 
time units and reference times. 

 

Abbreviation Time-unit 

s second 

m minute 

h hour 

d day 

w week 

mo month 

y year 

 

To specify time units, you can specify the abbreviation, the full time unit, or the plural 
version of the time unit, such as s, second, or seconds. You must include a valid 
value with any time unit. If specifying seconds, minutes, or hours, you can specify a 
fractional value. You cannot specify fractional values for other time units. 

 

Abbreviation Full Reference-time 

*  Current time. 

t (or T) today 00:00:00 (midnight) of the current day 

y (or Y) yesterday 00:00:00 (midnight) of the previous day 
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Abbreviation Full Reference-time 

sun Sunday 00:00:00 (midnight) on the most recent Sunday 

mon Monday 00:00:00 (midnight) on the most recent Monday 

tue Tuesday 00:00:00 (midnight) on the most recent Tuesday 

wed Wednesday 00:00:00 (midnight) on the most recent Wednesday 

thu Thursday 00:00:00 (midnight) on the most recent Thursday 

fri Friday 00:00:00 (midnight) on the most recent Friday 

sat Saturday 00:00:00 (midnight) on the most recent Saturday 
 

1.3.2 PI System Time Expressions 

The PI System time expressions can include a reference-time and a time offset, 
indicated by a direction (either + or -) and a time unit with a value. PI System time 
expressions might include: 

• Only a reference time, such as “y”  

• Only a time offset, such as “+3h”  

• A reference-time with a time offset, such as “y+3h”  

A reference-time can be a fixed time, such as “24-aug-2012 09:50:00”, or a valid 
reference-time abbreviation, such as “t”. 

You can only include one time offset in an expression. Including multiple offsets can 
lead to unpredictable results. For example, the following time expressions are not 
valid: 

 
 

1.3.3 Timestamp Specification 

To specify inputs for timestamps, you can enter time expressions that contain: 

Fixed times  

A fixed time always represents the same time, regardless of the field or the current 
time. 

Input Meaning 

23-aug-12 15:00:00 3:00 p.m. on August 23, 2012 

25-sep-12 00:00:00 (midnight) on September 25, 2012 
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Reference-time Abbreviations  

A reference-time abbreviation represents a time relative to the current time.  

Input Meaning 

*  Current time (now) 

3-1 or 3/1 00:00:00 (midnight) on March 1 of the current year 

2011 00:00:00 (midnight) on the current month and day in the 
year 2011 

25 00:00:00 (midnight) on the 25th of the current month 

t 00:00:00 on the current date (today) 

y 00:00:00 on the previous date (yesterday) 

tue 00:00:00 on the most recent Tuesday 

 

Reference-time Abbreviations or Fixed Times with a Time Offset 

When included with a fixed time or a reference-time abbreviation, a time offset adds 
or subtracts from the specified time.   

Input Meaning 

*-1h One hour ago 

t+8h 08:00:00 (8:00 a.m.) today 

y-8h 16:00:00 (4:00 p.m.) the day before yesterday 

mon+14.5h 14:30:00 (2:30 p.m.) most recent Monday 

sat-1m 23:59:00 (11:59 p.m.) last Friday 

 

Time Offsets 

Entered alone in a time field, time offsets specify a time relative to an implied 
reference-time. The implied reference-time depends on the field where you enter the 
expression: 

• For a start time, the reference-time is the current clock time.  

• For an end time, the reference-time is the start time. 

• For a single time stamp, the reference-time is the current clock time. 
 

Time field Input Meaning 

Start time -1d One day before the current clock time (24 
hours before the current clock time) 

End time +6h Six hours after the start time 

End time -30m 30 minutes before the start time 

Time stamp -15s 15 seconds before the current clock time 



PI System Basics 

 

Page 13 

 

1.3.4 Future Data 

Future data is data associated with a future time stamp. Data Archive 2015 allows 
storage and retrieval of data with time stamps beyond current time, allowing you to 
store data within a time range of January, 1970 through January, 2038. With Data 
Archive 2015 you can capture and analyze data with future time stamps, and use PI 
visualization tools to graphically create possible forecasts or predictions for your 
business. 

Just as with historical data, to specify inputs for timestamps, you can enter time 
expressions previous discussed fixed time, reference times, and reference-time 
abbreviations or fixed times with a time offset.  The difference being the timestamp 
will be in the future. Some example expressions are: 

 

Input Meaning 

*+1h An hour from now 

t+3d Three days from today at midnight 

Y+1y A year from yesterday 

 

1.3.5 How Does the PI System Adjust for Time Zones and DST? 

The short answer is: we do not! 

When we collect data, we convert it to UTC (Universal Coordinated Time), or what 
used to be called Greenwich Mean Time (GMT). This means that each day has 
exactly 24 hours. The local machine clock of the user looking at the data makes any 
adjustments for time, such as time zone or DST. 

If your region observes DST, once a year the day will look like it has 23 hours and 
another 25, but the PI Server never knows anything other than 24-hour days. 

In addition, because the clients and PI Server know what time zone they are in, the 
data can be viewed with respect to the server time or the client time. This is 
determined by a setting in the client tool. 
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1.3.6 Exercise – PI System Times 

 

This solo or group activity is designed to maximize learning in a specific 
topic area.  Your instructor will have instructions, and will coach you if you 
need assistance during the activity. 

Problem Description 

Determine the “real” dates and times indicated by the PI System times in the table 
below: 
(assume now: Tuesday, 20-May-2014 10:12:23 AM) 
 

Abbreviation Answer 

* - 30m  

T-1d  

y + 8h  

12  8:  

Tuesday – 2d  
 

 

Express the following times in valid PI System time abbreviations: 

 
 

Abbreviation Answer 

Today at 6:30 AM  

Monday at 5:45 am  

12 hours ago  

The first day this 
month 

 

Tomorrow at 7:00 AM  

2 hours from now  
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2. Introducing Asset Framework 

2.1 PI AF Server 

2.1.1 AF Server Installation and Software Requirements 

In a production environment, the AF Server component is typically installed on a 
dedicated Windows server machine. 

For the database management the AF Server is using a Microsoft SQL Server, 
which has to be defined during the AF server installation. The default name of the 
SQL database used for AF is PIFD. 

The client program for AF is PI System Explorer (PSE), which is used to configure 
and maintain the asset structure. 

AF Server is compatible with several SQL Server versions (SQL Server 2008 or 
later; for a complete list refer to AF Server software requirements). The PI AF server 
works with 32-bit or 64-bit SQL Server versions. 

Several SQL Server editions are supported: Express, Standard, Business 
Intelligence, Enterprise, Datacenter. The Express version is free of charge, but has 
several limitations. Depending on your AF asset structure size and the AF functions 
you are using (such as audit trail functionality), the Express version may not be 
sufficient. Refer to related OSIsoft Hardware System Sizing recommendations.  

The SQL Server can reside on the same machine as the AF Server or on another 
machine. It is possible to use an existing SQL Server that is also used for other 
applications. 

SQL Server Requirements for PI AF High Availability 

To take advantage of the PI AF High Availability (HA Collective) feature, the primary 
collective member must run SQL Server Standard Edition, SQL Server Business 
Intelligence, SQL Server Enterprise Edition, or SQL Server Datacenter Edition. SQL 
Server does not need to reside on the same machine as PI AF Server. 

SQL Server Requirements for PI AF Audit Trail Functionality 

The PI AF Audit Trail feature requires SQL Server Enterprise edition for supported 
SQL Server versions of SQL Server 2014 and earlier. 

The PI AF Audit Trail feature is also supported in: 

• SQL Server 2016 (Windows Update or Microsoft KB 3164398 required) 

• SQL Server 2016 SP1 Enterprise or Standard Editions 

• SQL Server 2017 Enterprise or Standard Editions (Windows Version Only) 

For complete information about the system requirements for the AF Server, refer to 
the AF Server software requirements. 
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2.1.2 Asset Framework Key Features 

Asset Framework provides an additional data layer in the PI System. It is based on 
an asset model of your plant that is defined by the customer. The model consists of 
elements and attributes.  

The model organizes and structures the data according to 
objects that customers are most familiar with, such as 
physical objects in their processes like reactors, 
transformers and meters.  

Since the AF asset model can span PI Data Archives, it 
allows customers to organize and search for PI System 
information across multiple PI Data Archives.  

 

The basis for the asset model is an Element, which contains Attributes that can 
reference PI System data, design data or data from other systems: 

   

 

AF Event frames allow users to associate or bookmark events, which occur over a 
time span with those assets. 

Asset Analytics provides real time calculation engine that allows users to configure, 
schedule and run calculations written using Performance Equation syntax acting on 
their AF attributes. Calculation results can be stored as time series data in PI Points 
or create event frames, notifications can automatically be sent out for them if 
needed. 

Client applications including but not limited to, PI Vision, PI DataLink, PI 
ProcessBook and PI Integrators can utilize the asset models to provide context 
driven displays, reports and analyses.   
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2.2 PI System Explorer Components 

2.2.1 Directed Activity – Familiarize with the PI System Explorer Components 

 

In this part of the class, you will perform a learning activity to explore the 
different concepts presented in this chapter or section. You may be invited to 
watch what the instructor is doing or perform the same steps at the same time. 
Your instructor will have directions. 

Problem Description 

You may follow along as your instructor shows and explains the PI System Explorer 
components and their general use. 

Approach 

Click on the PI System Explorer icon  in the task bar to start the program. 

Note: the very first start of PI System Explorer can take some time. In the beginning, no dialog 
box is displayed. Subsequent starts will be much faster. 
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Navigator Panel 

PI System objects are grouped into sections displayed in the Navigator Panel. 
Groups appearing by default include Elements, Event Frames, Library, and Unit of 
Measure and Management.  

Menu Bar / Toolbar 

Use these options for such tasks as opening/creating a database, searching for 
elements or contacts, applying and checking in changes, setting view options, and so 
forth. Menus and the Toolbar are context sensitive and will present different options 
depending on what section is selected from the Navigator Panel. 

Browser 

Use the Browser to select the objects you want to work on and display in the Viewer 
panel. The Browser displays the PI System objects that have been added to the AF 
database, such as elements, templates, notifications, etc. Depending on the section 
selected from the Navigator Panel, the following will be available from the Browser: 

 

• Elements: Elements represent either physical or logical entities in your 
process. They can be organized in several hierarchies. An element can be 
created from a template or created from scratch. When based on a template, 
the element derives its initial attribute configurations from the template. Later 
modifications to the template will propagate to all elements based on said 
template. 
 

• Event Frames: An event frame is any event, defined by a start time, an end 
time, and a context. Event frames also have attributes containing supporting 
data. Event Frames can represent downtime events, process and 
environmental excursions, material transfer events, equipment maintenance 
events, batch processing steps, safety incidents, and any other events 
important to your organization. A transfer is a special type of event frame that 
marks the movement of material in discrete quantities. 
 

• Library: This is a collection of objects that can be re-used throughout the AF 
hierarchy. Types of objects that appear in the Library include Categories, 
Element Templates, Enumeration Sets, Reference Types, and Tables. 
 

• Units of Measure (UOM): The UOM database provides automatic handling 
of simple conversions between units of measure for attributes of the same 
UOM class. A UOM class is defined by the fundamental dimensions of its 
measurement. Examples of UOM classes are Mass, Volume, and Density. 
The UOM database comes preloaded with numerous standard unit-of-
measure classes and conversion factors. You can extend these classes by 
adding new units of measure, as well as new measurement classes. The 
implementation of UOM is based on the International System of Units (SI). 
 

• Management: This section provides a summary of all analyses and 
notification rules configured on the current AF database. It allows you to 
perform administrative tasks like starting, stopping and backfilling. 
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Viewer 

This is the primary work area. Use it to create and edit elements, attributes, 
templates, tables, contacts, notifications, analyses, and so forth. When configuring 
attributes through the Viewer, the Configuration Panel comes into view allowing you 
to make configuration changes. 

Configuration Panel 

The configuration panel is used to configure properties associated with attributes. 
These properties include categories, attribute references, units, data types, and 
values for static attributes.  

Palette 

The Palette displays templates, data references and contacts that can be associated 
with objects being defining in the Viewer. Often the Palette is hidden to optimize 
screen real estate. 

Status Bar 

Check the status bar after clicking an item in the Browser to see its status. For 
example, last modification time, if the object is checked out or if a notification is 
currently loading. 
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2.3 Connecting to a PI System 

Objectives 

• Describe the different ways we can connect to a PI System. 

• Connect to an AF Server. 

• Examine your connected credentials. 

• Connect to a Data Archive. 

• Create a new connection to a Data Archive. 

2.3.1 What Do We Connect for Data? 

During this class, the PI System data will be retrieved mainly using PSE. A 
connection to an AF Server will be needed to access all the metadata related to your 
assets while a connection to the Data Archive will be required to access the process 
data from the Data Archive points. 

2.3.2 Connecting to a AF Server 

To connect to the AF Server simply open PSE. The default AF Server was set during 
installation, so you will be automatically connected to it. If a default AF database has 
already been defined, PSE will automatically connect to it as well. If no default AF 
database has been defined, a window will pop up and you will be invited to create a 
new AF database. 

It is possible to see which AF server the user is connected to by selecting the 

 button on the toolbar. The Select Database dialog box will show the current 
server name in the top drop-down “AF Server” list. 

 

To connect to a different available AF server, simply select it from the drop-down AF 
Server menu and click on the Connect button. 
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2.3.3 Directed Activity – Examining Credentials When Connecting to the AF Server 

 

In this part of the class, you will perform a learning activity to explore the 
different concepts presented in this chapter or section. You may be invited to 
watch what the instructor is doing or perform the same steps at the same time. 
Your instructor will have directions. 

Problem Description 

You may follow along as your instructor shows you how to validate connections to 
Data Archives and AF servers. 

Approach 

Click on the PI System Explorer icon  in the task bar to start the program. 

To find out the credentials being used for connecting to the AF Server, go to File > 
Connections…  
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2.3.4 Connecting to a Data Archive 

You can validate your connection to the Data Archive via PSE. Notice AF Server icon  

( ) is different than Data Archive server icon ( ). 

The PI SDK utility provides you with more features to configure and diagnose 
connections to the Data Archive. 

Open the PI SDK Utility (PI System > PISDKUtility (64-bit)). From the PI-SDK > 
Connections section, the Data Archive servers configured on the local machine are 
displayed. To validate a connection to a Data Archive, simply check the checkbox 
next to its name or IP address. If connection succeeds, connection information will 
be shown. 

 

 
 

The user that was used to authenticate on the Data Archive will be shown in the 
status bar and the connection information section on the right. 

Note: The PI SDK Utility is a particularly useful tool to troubleshoot permission issues. 
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2.4 Finding Data 

Objectives 

• Demonstrate the ability to find element data within the Asset Framework (AF) 
hierarchy. 

• Demonstrate the ability to search for points from within PI System Explorer 
(PSE). 

• Examine point attributes. 

2.4.1 Directed Activity – Finding Elements and Attributes 

 

In this part of the class, you will perform a learning activity to explore the 
different concepts presented in this chapter or section. You may be invited to 
watch what the instructor is doing or perform the same steps at the same time. 
Your instructor will have directions. 

PI System Explorer has two element search options: a quick search and an advanced search 
with multiple search criteria. 

 

Activity Objectives 

• Perform a quick element search based on a name pattern 

• Perform an element search with multiple search criteria. 

• Perform an attribute search. 

 

Approach 

Quick Element Search 

1. Open the PI Big Tires Co. AF database in PSE, select Elements in the 
Navigator. 

2. Explore the element hierarchy: it contains 3 locations (Houston, Montreal and 
Philadelphia (“Philly”)) with four presses in each location. 

3. Enter HOU into the quick search and click on Enter. 

 

 

 

4. Enter HOU*Press into the quick search and click on Enter. 
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Note: The search is shown with a little asterisk . When you select Save from the 
context menu, the search will be available the next time you log into PI System Explorer. 
When you select Rename from the context menu, the search will be renamed and 
saved. 

 

Advanced Element Search (multiple search criteria) 

5. From the PSE menu, select Search – Element Search… 

6. (optional) If criteria were cached from the last search, click the blue “x” in the 
search line on the top to reset. 

7. Enter criteria to search for the presses in Montreal (Element Search Root= 
Montreal, template= PressTemplate), click on Search to get the results. 

8. Enter *1 in name field to specify another criteria, click on Search to get the 
results. 

Note: All Descendants specifies whether the search returns elements from the selected 
levels and all levels below. The option should be set to true in most cases. The Name 
field can make use of the wildcard characters (* and ?). 

9. Reset the criteria. When you specify a template (e.g. PressTemplate) you can 
add a criteria for an attribute value. Search for all presses with Press Status = 
“Running”. 

 

 

Attribute Search 

10. From the PSE menu, select Search – Attribute Search… 

11. Select PI Big Tires Co. AF database. 

12. Enter Press Status into the attribute name field. Make sure the Search Sub-
Elements option is selected. Click Search. Result: the Press Status attributes 
for all 12 presses are listed. Click on OK. 
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2.4.2 Directed Activity – Finding Points within PSE 

 

In this part of the class, you will perform a learning activity to explore the 
different concepts presented in this chapter or section. You may be invited to 
watch what the instructor is doing or perform the same steps at the same time. 
Your instructor will have directions. 

A Tag Search window is available from PSE in order to find the appropriate point to map to a PI 
Point Element Attribute. This tag search window is accessible from the Search – Tag Search… 
menu item. 

 

Activity Objectives 

• Understand the search capabilities and options of PSE Tag Search. 

Approach 

1. From the PSE menu, select Search – Tag Search… 

2. (optional) If criteria were cached from the last search, click the blue “x” in the 
search line on the top to reset. 

3. Search for tags matching the name pattern CD*158 

4. Search for tags matching the name pattern CD?158. What is the difference to 
the previous search results? 

5. By default, this window allows searching using a point name mask. If you 
click on the control to display extra search features, you will get more options 
to further refine the search using additional common point attributes like the 
descriptor.  
 

 
 
Enter criteria to search for all tags with point source=R and name= sinus*. 
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3. A Walkthrough of AF 

3.1 What does Asset Framework (AF) do for me? 

 

The PI Data Archive is focuses on a points database and is extremely good at 
storing vast amounts of data collected by interfaces. It allows easy and 
performant retrieval of time-series data. The PI Data Archive architecture is 
scalable, maintainable and highly available.  

 

The Asset Framework (AF) supplements the architecture by 
providing a Meta-data structure for all data in the organization 
(“Data Directory”). Asset Framework (AF) has a rich set of 
features and functions to organize and enhance the data in the PI 
Data Archive. Because it offers user-friendly access to the data it 
is the preferred way for users to interact with their PI system data.  

 

 

What are the benefits of Asset Framework? 

 

Easy way to navigate throughout the system 

The hierarchical asset structure gives a convenient way for navigation that can also 
be used by people, who are not familiar with the technical details of how the data is 
retrieved from the data source. 

 

Unify data from disparate source systems 

PI Point attributes get their data from PI Data Archives. AF is not limited to one PI 
Data Archive. Attributes can refer to multiple PI Data Archive Servers (either 
standalone or collective)  

The origin of data can also be a relational database. While some attributes of an 
element representing a reactor are time-series data coming from PI tags (such as the 
temperature), data for some other attributes can be from an external database (such 
as the physical characteristics or inventory data).  

All attributes are listed side by side giving the user a comprehensive insight into all 
the relevant data of the asset. 
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Supports different Units of Measure 

PI Asset Framework (PI AF) attributes are associated with specific Units of 
Measure. AF is preloaded with numerous standard unit-of-measure classes and 
conversion factors based on the International System of Units (SI). It also 
supports user defined classes and Units of Measure. For example, the source 
unit for a temperature sensor attribute in a reactor in the USA can be 
associated with degrees Fahrenheit, the corresponding attribute for a reactor in 
Italy can be associated with degrees Celsius. When working with the data 
(doing calculations or displaying the data) this is properly taken into account.  

 

Standardization with Templates 

At many sites there are no rigorous naming standards for the points. There may be 
missing descriptions and/or engineering units. The PI System is often used to 
integrate information from different sources and these sources may not have been 
configured consistently: 

 

Element templates in AF provide the basis for standardization. When applied for 
elements that represent the same type equipment, all elements have the same set of 
attributes with a consistent, user friendly naming. The attributes have same unit of 
measurement, same data type, the same description, etc. This allows a harmonized, 
consistent representation of your system. 

Another benefit of using templates is the quick creation of many elements of the 
same type. 

 

Powerful Calculation Options (Asset Analytics) 

Users can configure, schedule and run calculations written using PI Performance 
Equation (PE) syntax acting on their PI Asset Framework (PI AF) attributes. PE 
expressions, Rollup calculations and generation of PI Event Frames based on trigger 
conditions are all supported analysis types. In addition, analysis templates enable 
users to manage their analyses in a standardized and consistent manner. Typical 
applications are Key Performance Indicator (KPI) calculations and condition based 
maintenance (CBM).  
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3.2 Introducing Elements and Attributes 

3.2.1 Directed Activity – Velocity Terminals 

 

In this part of the class, you will perform a learning activity to 
explore the different concepts presented in this chapter or section. 
You may be invited to watch what the instructor is doing or perform 
the same steps at the same time. Your instructor will have 
directions. 

Activity Objectives 

• Create an AF element with attributes using PI Point, Table Lookup, and 
Formula data references. 

• Define the value types and units of measure for attributes in the element and 
in the element template.  

• Create and populate an AF table. 

• Create an AF element template from an element. 

• Extend the template with new attributes and see how these affect the original 
element. 

• Create an AF enumeration set and use it for data validation in a template. 

• Create an element from a template. 

• Move AF Elements under a parent element. 

• Create more elements with the PI Builder Excel add-in. 

Problem Description 

You are working for Velocity Terminals, a chemical company producing various 
chemicals. The company has a number of storage tanks located in different countries 
that they would like to monitor. You have been tasked with creating an asset model 
for these tanks in AF. 

Approach 

Follow the instructor as he or she performs steps to create various AF objects that 
will lead to the creation of a single PI ProcessBook display to monitor all of Velocity 
Terminals’ tanks. 

You will have opportunities to work on your own later on in the course. For now 
follow and listen closely to the information in this initial exploration of AF. 
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3.2.2 Creating and Selecting AF Databases 

Open PSE from the start menu and, if necessary, connect to the AF server PISRV01. 

If PSE opens normally, choose File > Database. If PSE does not open and a pop-up 
appears, click on the Select option to get to the Select Database window. 

To create a new database, right-click anywhere in the list of databases and choose 
New Database or click on the New Database button on the toolbar.  

To select the existing database for entering the Velocity Terminals structure, select 
AF Startup and click the OK button or double-click on it to open the database.  

 

 

 

 

About Databases 

PISRV01 setup for training has many AF databases, which are specific for class exercises. In 
practice, it may be better to build fewer, larger databases. That is because references in AF only 
work within the same database; it is not possible to compare elements and values across 
databases. Companies may find it better to organize their database at the business unit level 
and not the plant level.  

The Configuration database 

As an administrator, it is possible to view a database called Configuration. Do not use this 
database to organize your assets as it is only shown to administrators and used to store 
configuration data for PI System software. 
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3.2.3 Creating AF Elements 

Make sure the Elements section is selected from the Navigator Panel and create a 
new element called Tank01. 

From the Browser, right-click on  and select New Element or click the 

 button from the toolbar and select <None> as the element template. 

Under the General tab from the Viewer, change the name of the element to Tank01. 

About Elements 

The element is the basic building block of AF. It is an organizational feature that can be thought 
of like a folder. It has relationships with other elements and has searchable characteristics. An 
elements has no Data Reference and does not have a value. Elements are generally organized 
hierarchically, though this is not required. 

Elements represent physical or logical entities in your process, this can be: equipment, lines, 
products, systems, organizations or sites. They can be based on a template or created without 
one, although later sections will emphasize the fact that templates are highly recommended. 

Elements in a AF database must be uniquely named to their path. An element named 
“Transformer” can exist under an element named “System A” while another element named 
“Transformer” can exist under “System B”. However, two elements named “Transformer” can 
not coexist under the same element “System A”. It is recommended that unique names are 
considered for all elements regardless of their position in the hierarchy. 

The name of an element can contain any character except control characters or any of the 
following ( ;  ?  `  ‘  “  \  |  {}  [] ). 
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3.2.4 Creating AF Attributes 

From the Viewer, select the Attributes tab and then right-click on the white space to 

select New Attribute to define attributes or click the  button from the 
toolbar.  

As with elements, attributes must also be uniquely named along their path within the 
element they belong to. Attributes can have a configured constant value or can get a 
value dynamically from a Data Reference. 

 

Value Type 

The Value Type field for the attributes defines the format the value itself will have. 
The various types will be familiar to those with programming experience. In general, 
value type Double can be used for most analog/numeric values and value type String 
for everything else. Other types may also be useful in certain circumstances. For 
example, a value type of Boolean allows either a 0 or a 1, which is represented as 
False (0) or True (1). 

 

Display Digits 

The Display Digits field (new in AF 2018) can be used to control the number of 
digits you want to see for the attribute: zero or positive numbers indicate the number 
of digits to display to the right of the decimal point. A negative number indicates the 
number of significant digits to display. In this case, the absolute value of Display 
Digits is the number of significant digits 

If your AF Server version is before 2018, the functionality is like for Display Digits = -5 

Example (Value= 23.45) 

Display Digits Format 

3 23.450 

2 23.45 

1 23.5 

0 23 

-1 2E+001 

-2 23 

-4 23.45 

-5 (default) 23.45 
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Three (3) attributes will be created for Tank01. Start configuring the attributes using 
the table below: 

Attribute Name Default UOM Value Type Value Display 
Digits 

Capacity US gal (Volume) Double 20,000 -5 

Level % (Ratio) Double N/A 2 

Volume m3 (Volume) Double N/A 3 

 

Units of Measures for Attributes 

Attributes will generally be assigned units of measures (UOM). These UOM are organized into 
comparable classes. The Default UOM configuration field defines the default unit of measure to 
use to display the attribute’s values. This default unit of measure does not need to be the same 
as the instrumentation. Later sections will show how this can be used. 

Note: Always assign a unit of measurement! Do not leave this undefined. This will avoid 
misinterpretation of the measurement in all subsequent operations. 

• To enter an UOM, select the UOM from the corresponding UOM Class (here: 
UOM class= Ratio, UOM= percent). Alternatively, enter the first characters 
(such as per), then select from the list of matching UOMs. 
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Level Attribute 

• With the Attributes tab selected, select the Level attribute, change its data 
reference to PI Point, and then click on the Settings button. 

 

 

 

• Select the correct Data Archive at the top and enter TANK01LI.PV (or use the 

tag search ( )). Change the Source Units from “<Default> (%)” to “%”. 

 

 

Note: Make sure you always assign a unit of measure (UOM) rather than just keeping 
the default. This prevents that the PI Point value is misinterpreted in case the attribute 
UOM is changed later in time. 
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Volume Attribute 

• Select the Volume attribute and set Data Reference to Formula.  

• Clicking on Settings to bring up the Formula Configuration window. 

• Use the formula data reference to calculate the volume using the level (%) 
and the capacity (m3).  

• Use the new button ( ) to add parameters to use in the formula.  

• Expand the list of functions from the equations section ( ) to pick the 
operators/functions to use in the formula. 

 

 

Units of Measures in Formulas 

You can perform unit conversions by setting the units of measure (UOM). Units of measure can 
be explicitly set for the parameters as well as for the result. Do this from the parameters 
configuration section by choosing the appropriate UOM from the Unit of Measure drop down. Do 
this also in the Result section at the bottom left. 

Note: It is recommended that you always assign the units explicitly! If you leave units selector 
at “<default> then no unit conversion takes place. If the default UOM of an attribute is changed 
later on, then no corresponding conversion will happen and results will not be correct! 
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• Press the  button on the toolbar and then the  button or 
select it from the menu: File > Check In to save these changes. 
The following table will help you to evaluate whether the calculation is correct. 

 

Tank01 Level Volume (US Gallon) Volume (m3) 

0 % 0 US Gallon 0 m3 

20 % 4,000 US Gallon ca. 15 m3 

40 % 8,000 US Gallon ca. 30 m3 

60 % 12,000 US Gallon ca. 45 m3 

80 % 16,000 US Gallon ca. 60 m3 

100 % 20,000 US Gallon ca. 75 m3 

 

About Saving Modifications 

The AF Server uses a sandbox concept for modifications. It holds the changes until they are 
published to the end users. When  is pressed, the changes made in your active 
session are published as the single public version that others can now see. 

Until you check in, other users will not be able to edit a checked out object. The checked out 

icon will be shown ( ). As for the user currently editing an object in AF, the object icon will 

signify some changes were made to the object, that are not yet published ( ). The “Undo all 

changes to the Database” button ( ) next to the check in button will reset your sandbox 
changes and set your sandbox back to the database state as it was before you started working. 

• To explore the Display Digits setting, change Capacity from 20,000 -> 
200,000. Once you have entered the modified value, the value will be shown 
as 2E+05 US Gal. This is because the value cannot be displayed with just 
five digits (Display Digits = -5), and the display is switched to scientific format.  
2E+05 has to be interpreted as 2.0 * 10 ^ 5 (= 200,000). Change Capacity 
back to 20,000. 

To familiarize with scientific format, open Windows Calculator and switch to Scientific View. 
Enter 200,000 and change to scientific display (F-E button).  
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3.2.5 Creating AF Tables 

Building the table is similar to building a table in other programs that have simple 
table building capabilities. 

In the PSE, first navigate to the Library section from the Navigator 
Panel. Right-click on the Tables item to select New Table, or click on 

the  button from the toolbar. 

Under the General tab, change the name of the table to “Material 
Properties”. 

 

Select the Define Table tab and add two (2) rows by right-clicking in the blank area to 

select Insert or by selecting the starburst “Insert a row” button ( ) on the right-hand 
side. Define the table as follows: 

Column Name Value Type Unit Of 
Measure 

MaterialID String <None> 

Density Double kg/m3 (Density) 

 

Under the Table tab, enter the following fictitious chemicals: 

MaterialID Density 

AQ4500 2100 kg/m3 

HC1500 3422 kg/m3 

WX1200|Old Recipe 8943 kg/m3 

WX1200|New Recipe 9213 kg/m3 

About Tables 

Tables are held in the AF database to provide contextual information through the Table Lookup 
data reference. Tables can provide information about the equipment or process entities or they 
can be used to store tag names or other configuration information to be used in AF. 
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Tables can be created internally (like in this exercise), imported from an external relational or 
tabular data source, or linked dynamically to an external relational data source. In this way, 
Tables can expose information in maintenance, production planning, or equipment databases 
for use by PI client applications. 
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3.2.6 Creating AF Enumeration Sets 

About Enumeration Sets 

An enumeration set is an ordinal list of sequential integer values, which are mapped to names. It 
allows AF attributes to refer to a common term instead of a number. This is analogous to the 
Data Archive digital state sets used by Digital points. It is not needed to rebuild the digital state 
sets or maintain them in AF. Enumeration sets are just a meaningful way to display information, 
perform data validation and maintain data consistency across the AF structure. 

Hierarchical enumeration values (new in AF 2017 R2): 

Enumeration values can be nested in hierarchy. The hierarchy can have as many levels as 
needed. In our case, WX1200 is produced with different recipes, which result in different 
physical characteristics and so in different density values. In a different level below the WX1200 
value we can distinguish between the old and new recipe.  

From the Navigator Panel, select the Library section.  

Right-click on the Enumeration Sets item to create a New Enumeration Set, or click 

the  button from the toolbar and name the new set MaterialID.  

Enter the material IDs from the table below as the names of that set: 

Value Name 

0 AQ4500 

1 HC1500 

2 WX1200 

 

To distinguish WX1200 produced with either the old or new recipe, we will add two 
child values in a level below WX1200: 

Value Name 

3 WX1200|Old Recipe 

4 WX1200|New Recipe 
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Note: Hierarchical enumeration value feature is available since AF 2017 R2 

 to save newly created objects to the AF database. 

3.2.7 Creating AF Element Templates 

Select Tank01 from the Elements section in the Navigator Panel and right-click on it 
to select Convert > Convert to Template (note this does not delete or change the 
element, but does set it to a new template). When converting you have to decide, 
how the PI Point Data Reference for the Level attribute should be set. Select 
Substituted, which will set the PI point name according to a naming pattern rule. 

The default naming rule is %Element%.%Attribute%.%ID%.  

Under Suggested Point Name, enter %Element%LI.PV and click Apply.  

 
 

If you create elements for another tank based on the template, the substitution 
parameters in the point reference (enclosed with %) for the Level attribute will be 
replaced according to the name of the new element: 

Naming Pattern: %Element%LI.PV 

Element Name PI Point Name 

Tank02 Tank02LI.PV 

Tank03 Tank03LI.PV 

Tank04 Tank04LI.PV 

etc. 

Substitution parameters will be explained later.  
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Locate your new element template from the Library > Templates > Element 
Templates section and change its name to “Tank”.  

Under the Attribute Templates tab, add four (4) new attribute templates by clicking 

the  button from the toolbar. 

Attribute Name Default UOM Value Type Data Reference Display 
Digits 

Product <None> 
Enumeration 

Sets > MaterialID 
<None> 

NA 

Density 
kg/L (Density 

class) 
Double Table Lookup 

-5 

Mass kg (Mass class) Double Formula -6 

Tank Name <None> String String Builder NA 

When you create the Product attribute, enable the Configuration Item Property. 

Configure the Table Lookup data reference for the Density attribute using the 
following: 

Table Result Column Where 

Material 
Properties 

Density MaterialID = @Product 

 

Configure the Formula data reference for the Mass attribute using the following: 

Parameters Equations 

Variable Attribute Unit of Measure 

D * V D Density kg/L 

V Volume L 

 

To configure the String Builder data reference for the Tank name attribute: 
Select String Builder from the Data Reference dropdown selection and click on the Settings… 

Click on the Add New String  button, click on  to get further selection options, then select 
“%Element%” from Substitution Parameters: 
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 the changes.  

Go back to the Elements section, select the Tank01 element and look at its 
attributes.  

Pick material “HC1500” for the Product attribute enumeration list and then click on 

.  

Note the value of the Density attribute. Check the correct tank name. 

Note: Elements should always be created from a template, even if at the moment of creation 
only one asset would make use of that template. This ensures consistency in the creation and 
management of AF elements. 

However, for elements that would act only as organizing assets (folders) and that have no 
attributes, a template is not required.  
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3.2.8 Creating New Elements from Templates 

Create a new element called “Tank02” based on the Tank element template and 
assign to its attributes the values found in the table below. 

Attribute Name Value 

Capacity 30,000 

Product AQ4500 

Commit these changes to the AF database ( ). 

The Power of Templates 

The term template suggests a cookie-cutter way to create new objects with consistency. AF 
element templates do this and more for elements. They ensure similar equipment stay alike in 
AF. 

When changes (in default values, attribute definition, or structure) are made to the template, the 
elements created using that template are automatically updated. 

Note: If changes were made at the element’s attribute level, a change to the attribute template 
will not replace the modifications made by the user. That is, if you uniquely set values or 
configuration strings in the data references of unique elements’ attributes, they will not be 
overwritten by a modification of those attributes’ default values at the element template level. 

Attributes derived from a template have a Reset to Template option on their right-click menu to 
remove any unique value or configuration string definition for this attribute and reset it to the 
default values established at the template level. 

This allows to create, but also to maintain many elements with the template, knowing that 
changes are applied to all appropriate related elements. 

Templates also allow the AF database to grow into an analysis tool when ready to do so. It is 
possible to add calculations and analytics into the template at any time since that information 
will be propagated to all of the elements automatically. It is not necessary to have the complete 
analysis at the time of template creation. 

In this example we created a template from an existing element, but it is possible to go directly 
to the Library to create a new template by right-clicking Element Templates and selecting New 

Template or by clicking the  button from the toolbar. 

AF Templates have an  check box under the General tab. Checking this box 
allows for additional attributes to be created at the element level, outside of the element 
template. Obviously, this will no longer guarantee all elements have the same set of attributes. 

Templates may be the most powerful and unique feature in AF. Very few applications would not 
benefit of the use of templates when building AF elements. 
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3.2.9 Moving Elements under a Parent Element 

Elements can be moved under other elements (then called Parent Elements) in order 
to represent a logical hierarchy to be used by your applications 

Tip 

 

When dragging and dropping elements under a parent, make sure that 
parent element was first saved to the database (check-in)! If the parent 
element was not checked in before moving another element under it 
(child element), the move operation might cause the child element to be 
deleted because AF doesn’t yet know the parent element exists.  

 

Moving Elements Around 

 

You can move elements around in the Viewer using the mouse and keyboard. This will result in 

creating an element reference, or making a copy of the element or simply moving it. 

 

Dragging an element 
while pressing the… 

Action 

Ctrl Key 
Copies the original element under another parent 
element. The original and the copy will not be linked. 

Shift Key Moves the element. 

No key 

Creates an Element Reference. The element will now 
exist in two places in the hierarchy. In this case, the 

element icon has a “link” designator ( ), like in the 
case of a file shortcut. 

 

 

Create a new element not based on any template named “Montreal”. Check-in the 
changes. 

Select both tanks using the mouse and drag and drop them while holding the Shift 
key on the keyboard in order to move those elements under the Montreal element so 
they become child elements of that location. 

Select the Parent-Child Reference Type for each tank element. The different 
reference types will be discussed in the next chapter. 

Tip:  When moving an object, be deliberate with the shift key, drag and drop manipulation. It is 
safer to right click the element, copy it to the new location and then delete the original. 
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3.2.10 Creating AF Objects in Bulk Using the PI Builder Add-in 

PI Builder is an add-in to Microsoft Excel 2007 and later allowing rapid creation and 
edition of AF objects and PI points in bulk.  

Open Microsoft Excel, and select the PI Builder ribbon menu.  

In the Connections section, select the Asset Server (AF Server: PISRV01) and the 
AF database (AF Startup).  

To connect to your AF database click on Database. 

 

 

Import the tank elements from AF. To do this, select Elements > Find Elements from 
the PI Builder ribbon menu, then select the Tank Template to search and find both 
tanks.  

Make sure to search child elements. 

 

 

Select to import the Template configuration of the element. 
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Select capacity and product attributes to import their configuration and values. 

 

Once you click OK, the objects imported from AF on the spreadsheet should look like 
the following: 

 

 

Use Excel functionalities (find-replace, Ctrl+H) to create records for two (2) additional 
tanks (Tank03 and Tank04).  
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Make sure the Data Archive name is correct for the Level attribute definition. 

Verify the Product name matches one of the valid material from the Material 
Properties AF table. 

Name |Capacity |Product 

Tank03 10000 HC1500 

Tank04 10000 WX1200|Old Recipe 

 

The records are now ready to be exported to AF; which will create two new tanks.  

Click on the “Publish” button from the ribbon menu ( ). 

Confirm your work by going to PSE > Elements and pressing the  button or 
the F5 key on the keyboard. 

Note: To rename an element, simply right-click on it in PI System Explorer > Elements and 
select Rename. Or use the NewName column in the PI Builder in Excel. 

Because AF keeps relationships using the elements’ GUID, elements can be renamed without 
breaking relationships between elements or elements and their attributes or their templates. 
GUIDs are also used in the relationships of elements in data references as well.  
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3.2.11 Attribute Traits 

Attribute traits hold characteristic information for their parent attribute. These can be 
limits, forecast values, geolocation information, reason codes, asset health, and 
analysis start triggers. They can either be defined as a fixed value or in combination 
with a Data Reference such as e.g. PI Point or Table Lookup. Attribute traits are child 
attributes. 

Limit attribute traits: limits typically represent the expected range of a process 
variable. Following limit traits are defined:  

• Minimum and Maximum (very lowest/highest possible value)  

• LoLo and HiHi (very low/high value for an abnormal situation, typically 
initiates an alarm)  

• Lo and Hi (low/high value that needs attention, typically initiates a warning)  

• Target (aimed-for value such as setpoint)  

Forecast attribute traits: forecasts contain predicted values, which allow to 
compare actual value with the parent attribute. It typically comes from a future PI 
point. 

Location attribute traits: use location attributes to define longitude, latitude, and 
altitude information for an asset. You can use this information to identify the location 
of the asset on a map. Used by Integrator for ArcGIS. 

Reason attribute traits: use reason attribute traits on event frames and transfers to 
enable users to select a reason code for excursions, downtime, and other events. 
The reason attribute trait must be an enumeration set that is previously defined, or a 
system enumeration set delivered with PI AF. 

Analysis start-trigger traits: When users configure analytics to generate event 
frames, they can optionally elect to store the name of the start trigger in the value of 
an attribute (string) and mark that attribute with the analysis start trigger trait. This 
enables clients like PI Vision to indicate the start trigger that created that particular 
event frame. 

Health attribute traits: use health attribute traits on elements and models to enable 
users to set a numeric health score and a health status (for example, healthy, out of 
service, in maintenance, warning, or error). The HealthStatus attribute trait uses 
values from the Health Status enumeration set, which is delivered with PI AF. 
Administrators can modify the Health Status enumeration set as required. 
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3.2.12 Directed Activity – Adding value limits for the tank level 

 

In this part of the class, you will perform a learning activity to explore the 
different concepts presented in this chapter or section. You may be invited to 
watch what the instructor is doing or perform the same steps at the same time. 
Your instructor will have directions. 

Problem Description 

You would like to use attribute traits to maintain limits for the normal operation of the 
tanks. For all tanks the limits are the same. 

Approach 

1. In the PSE Navigator, select Library and open the Tank element template in 
PI System Explorer. 

2. Select Limits… from the context menu of the Level attribute: 

 

 

3. Set the limit traits as follows and click on OK. 
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3.2.13 Units of Measure (UOM) 

The units of measure (UOM) feature allows automatic unit conversions for data 
values. AF considers the technical unit for a measurement and allow to display it with 
a different unit. 

For example, suppose AF attributes of a tank represents the diameter and the height 
and have a UOM of meters. AF considers the selected unit of measure. This 
provides the option to show the diameter and height in other units than in meters, 
e.g. to show it in inches. Another consideration is in attributes with a formula. It is 
possible to calculate the tank volume in liters based on the physical dimensions 
provided in meters. AF does the automatic conversion for you. 

The relations between UOMs are defined with simple or formula conversion 
methods. 

There is one repository with all units of measurement 
(UOMs), which is shared by all AF Databases. In other 
words, the UOMs defined for one AF database maybe 
used in any other AF database.  

Unit of Measurements are organized in UOM classes. 
UOM classes represent measurable properties, such as 
temperature, length, time, and mass. To facilitate region 
specific use of UOMs, the UOMs are associated with a 
UOM group, which can either be Metric or US Customary 
(additional UOM groups can be defined). 

 
 

Click on Unit of Measure in the PSE Navigator to edit UOMs, UOM classes and UOM 
groups. 
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3.2.14 Directed Activity – Exploring how UOMs are organized and how they are used 

 

In this part of the class you will perform a learning activity to explore the 
different concepts presented in this chapter or section. You may be invited to 
watch what the instructor is doing or perform the same steps at the same time. 
Your instructor will have directions. 

Activity Objectives 

• Understand the organization for UOMs, the UOM classes and the UOM 
groups and their relationships. 

• Apply unit of measures for a calculation of liquid in a container  

Problem Description 

 

A container at your plant has a shape of a 
cylinder. The diameter is 1 m, the height of 
the liquid inside (PI point: sinusoid) varies 
and is measured in number of centimeters 
(range 0 … 100 cm). Use a formula to 
calculate the reactor volume in liters. Apply 
units of measures properly. 

 

 

• 1 meter (m) = 10 decimeter (dm) = 100 centimeter (cm) 

• The volume of a body in liter is calculated from dimensions in decimeter  
(1 liter = 1dm x 1dm x 1dm).  
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Units of Measure, UOM classes and UOM groups 

1. Navigate to Unit of Measure and from the list of UOM classes, locate the 
UOM class for Length and display its properties. What is the canonical UOM? 

2. From the list of UOMs for Length, open the Properties for centimeter. What is 
the conversion between meter and centimeter? What is the corresponding 
unit for the US Customary UOM group?  

Note: Per default, attributes are displayed in the PI System Explorer with the unit of measure in 
which they were defined. With Tools > Options you can change that the attribute is displayed 
with a unit from the selected UOM group. 

3. Add new UOM for decimeter (1 decimeter = 0.1 meter), click on OK and 
Check In. 

 
 

4. Locate the UOM class for Area and display its properties. Note that the base 
units is Length ^ 2. Locate the UOM class for Volume and display its 
properties. Note that the base units is Length ^ 3. 

5. Use the Conversion Calculator at the right hand side and convert 1 m3 (cubic 
meter) into liters.  

6. (bonus) Use the Search UOMs control at the top right  
and search for units starting with sec. What is the 
difference between the two units you get? 

7. (bonus) How many kW has the motor of your car? Convert into horsepower. 
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Container Element with attributes for Diameter, Fill Level and Liquid Volume 

1. Select the Demo AF database, select Elements in the Navigator. 

2. Locate the Container01 element (below UOM Demo). 

3. Add an attribute for the Diameter, set the default UOM to meter (from UOM 
class Length), Value Type= Double, and set value to 1 

4. Add an attribute for the Fill Level, set the default UOM to meter (from UOM 
class Length), Value Type= Double.  
 
Set Data Reference to PI Point. Click on Settings to define tag name 
SINUSOID, and under Unit of Measure set the Source Units to cm. 
Values for SINUSOID are in range 0 … 100, in which range will the values for 
Fill Level attribute be? Answer:   0 m  ….. ________ m 

5. Add an attribute for the Liquid Volume, set the default UOM to liter (from 
UOM class Volume), Value Type= Double.  
 
Remember that you get the proper value in liters, when you multiply the 
values in decimeters. Set data Reference to Formula and define it as follows: 
 

 
 
Hint: you get pi() from the Functions drop-down 

 

6. Select Tools > Options and set Display UOM Group = US Customary. Click 
Refresh to display UOMs from the US Customary group. Revert the setting 
back to <None>. 

7. (bonus) Remove the Read Only flag for the Fill level attribute and enter 
maximum fill level of 1m. What is the Liquid Volume? Confirm result by using 
the Windows calculator. 
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4. Modeling and Organizing the Assets 

4.1 Starting to Build a AF Structure 

In a AF database, assets can be organized or structured into hierarchies. According 
to its definition a hierarchy is “a system of persons or things arranged in a graded 
order” (thefreedictionary.com). Logical hierarchies of assets or people are common in 
companies from any industry. They are used to convey the place/location of each 
entity in the company. Since the AF system is probably not the only enterprise 
system in your company, other systems in place might already make use of asset 
hierarchies (maintenance systems, etc.). 

Those systems will often have an option to export the hierarchy information into a flat 
file (.csv, .txt, .xml, etc.). The content of this file can then be opened in Microsoft 
Excel and be used as a starting point to build the hierarchy in AF using the PI Builder 
add-in. 

Note: The whole company does not need to be modeled in AF for you to be able to get value 
out of it. In fact, the AF structure build-up is often project-driven. This means to begin with, a 
small structure containing your pumps might be built for use in PI ProcessBook displays. As 
more and more applications start making use of AF, the structure will continuously grow to 
include more and more of your assets. 

That being said, it is still a good idea to define the various hierarchy levels that will be 
represented in the AF structure (divisions, locations, production lines, process, etc.) before 
gradually adding the assets to that hierarchy. 

4.2 Styles of Approach for Designing Assets 

There are several styles for designing asset models in AF.  

Note: Even if the following approaches will result in a complete asset model, there will always 
be more information to add in the future. That is fine and is in fact a relief, since it means the AF 
model does not need to be perfect and complete the first time. 

4.2.1 Bottom-up 

Often a Data Archive is already in place so one approach is to group the assets by 
similar Data Archive points. These “similar object” groups become AF element 
templates, and the “objects” become AF elements. Any foreign data that is available 
is imported. Next, analytics that may seem useful are added, and finally consumers 
such as PI ProcessBook displays or PI Datalink reports.  
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The bottom-up approach has the advantage of being a clear, reality-based path to 
follow. The Data Archive points are known and analytics can be added on top of 
them.  

However, a clear disadvantage is that this approach lacks vision. This approach 
does not guarantee the result to be useful since the asset model was not built with a 
particular goal in mind.  

4.2.2 Top-down 

Another approach is to start by asking theoretical questions:  

✓ What is the goal of the asset model?  

✓ What do the consumers need from AF?  

✓ What are the business requirements?  

✓ What analytics will be desirable?  

✓ What sort of foreign data might be useful? 

After answering these questions, the element templates and elements can be 
sketched, and organized in a hierarchy. Next, AF attributes can be added for the 
desired data points, even if the source for the data is not known yet. The first stage is 
simply to add the placeholders for that data, i.e. non-configured attributes. If these 
attributes are confirmed to be the ones needed, then the analytics can be added, the 
Data Archive tags can be mapped, and the model can be fully implemented. 

This top-down approach has the advantage of planning for the usefulness of the AF 
model. Confidence that the model will be well designed and reusable is assured. 
This advantage cannot be understated and usually outweighs all of the following 
disadvantages.  One disadvantage is that the design can drift away from reality and 
be incredibly hard to implement while having little benefit over an easier alternative, 
which is hard to tell beforehand. Another inherent disadvantage is that much of the 
available raw data that is not “necessary” will be ignored from the model. 

4.2.3 Design top-down, then work bottom-up  

The preferred approach will be a compromise: begin top-down, identifying goals and 
trying to identify a “good” design for everything, then quickly move to a mix of this 
theory and bottom-up experimentation. If a piece of data looks useful, add it to the 
model because it is rarely a mistake to do so. 

This planned approach combines the advantages of top-down and bottom-up: 
assurance that the model will be useful, yet a good grounding in reality and 
completeness during construction. The steps of this approach are: 

• Define the assets. 

• Design the element templates and inheritance tree. 

• Add attribute templates. 

• Configure the attributes to point to foreign data or Data Archive points, all with 
proper units of measure. 

• Add calculations/analytics. 

• Test the model using consumers (sample reports, displays, etc.). 
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4.3 Organizing AF Elements in Hierarchies 

Avoid same names for different devices 

If you have multiple devices in different environments, do not assign the same name 
to them, as this can cause confusion. The following structure is possible but not 
recommended: 

 

 

To avoid this situation, either assign unique names (such as Tank1, Tank2 in 
Montreal and Tank3 and Tank4 in Houston) or make the names unique by adding a 
location code: 

 

 

 

 

Different Views for the assets 

Once a hierarchical structure has been built in AF and the assets have been defined, 
it is possible to organize the assets underneath that structure. Depending on the type 
of hierarchy that was created, the equipment will be organized by geographical 
locations, by enterprise divisions, by type of equipment, etc. However, having one 
kind of asset organization does not imply another type cannot also be used in the 
same AF database. 

AF has this ability to let the system manager organize their assets in multiple 
different ways. It is then possible to have different “views” of the same information 
but without duplicating that information. This can be done using Element References 

( ).  
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4.3.1 Directed Activity – Familiarize with multiple asset views  

 

In this part of the class you will perform a learning activity to explore the 
different concepts presented in this chapter or section. You may be invited to 
watch what the instructor is doing or perform the same steps at the same time. 
Your instructor will have directions. 

Activity Objectives 

• Understand how to organize assets in different views in order to 
accommodate different AF user groups in the company. 
 

Problem Description 

In the Demo AF database there is a branch for Asset 
Views. The main view is organized according to the 
geographical location of the devices, a second view is 
maintained based on the equipment types, and in a 
further view is a general inventory list. You would like to 
locate the first boiler in Frankfurt in all the views. 

Approach 

Open the Demo database in AF. Expand both the Locations, the Equipment and the 
Inventory branch and locate the first boiler in Frankfurt in all the views. Explore that 
the same information is represented in two locations of the asset tree. 
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1. Select the Demo database in AF. Select Elements in the Navigator and 
explore the Asset Views branch. Locate FRA Boiler1 in all the three views.  

2. Open the General tab for the FRA Boiler1 element.  

Click on the Parents link:   
The three positions in the element tree are listed by their corresponding 
paths. The icon for the element itself has a little checkmark in the top right 

corner ( ). 

 

 

 

3. Select the element under Locations - Frankfurt and enter an element 
description. Check-In the change. Then select one of the element references 
in the other views and verify the modified description in there. 

 

  



Building PI System Assets and Analytics with PI AF 

 

Page 58 

 

4.3.2 Element Reference Types 

Whenever you create a new element or element reference in the asset tree, you are 
asked to define the reference type related to its parent element.  

Composition 

The composition relationship binds two elements together so that whenever one is 
changed or calculated, the other is too. Deleting the parent element deletes the child 
as well.  

For example, a valve attached to a tank may be represented as a separate element in 
AF, but is really a part of the tank asset and cannot exist outside of it. Removing the 
tank from a site removes the valve as well.  

Typically, an element having a composition relationship with its parent would not be referenced 
elsewhere by itself. 

Parent-Child 

With a Parent-Child reference, the child can have multiple parents. The child element 
can thus be part of multiple hierarchies. 

Parent-Child is the default for a new child element creation. When you use that reference type 
substitution parameters in the element attributes are resolved according to the hierarchy the 
element is in. 

Weak Reference 

A Weak element reference is like a Parent-Child element reference, but a weak 
referenced element cannot exist on its own.  

Weak is applied for element references when you have a main view (e.g. master view organized 
according to geographical location) and you create additional views for your assets (e.g. 
organized according to business function). Different to a parent-child reference the element 
reference in an additional view will not exist on its own when removed in the master view. 
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4.3.3 Directed Activity – Understanding Reference Types (optional)  

 

In this part of the class you will perform a learning activity to explore the 
different concepts presented in this chapter or section. You may be invited to 
watch what the instructor is doing or perform the same steps at the same time. 
Your instructor will have directions. 

Activity Objectives 

• Understand the use of different reference types in context with what happens 
when you delete an element. 
 

Approach 

Open the Demo database in AF. Expand the Reference Types Demo. Explore the 
reference types between the elements in the structure below. 

 

Composition 

The HeatExchanger01 in Production Line B has a valve that is an integral part of the 
exchanger that can not exist on its own. Therefore, the relation between the valve 
and the exchange is Composition. 

1. Select Heat Exchanger01 and click the Child Elements tab on the right. 
Check the Reference Type option: 

 

2. Select Heat Exchanger01 and select Delete… from the element context 
menu. Select Delete option to delete the object and all references to it.  
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3. Check-In and Refresh. Result: the valve element and all the valve element 
references disappear (this is independent from whether the valve element 
reference has a strong or weak reference to the parent element) 

 

Weak Reference 

Pump01 is located as a child under Production Line A - Pumps. This is the main 
view for Pump01. An element reference for Pump01 is below the Secondary View 
element, which is an additional view. For this view, the reference Type between 
Secondary View and Pump01 element reference is Weak Reference.  

1. Select Pumps and click the Child Elements tab on the right. The child 
element Pump01 has a Parent-Child reference with its parent. 

2. Select Secondary View and click the Child Elements tab on the right. The  
Pump01 element reference has a Weak Reference with its parent. 

3. Select Pumps and select Delete… from the element context menu. Select 
Delete option to delete the object and all references to it. Check-In and 
Refresh. Result: the element reference for Pump01 below Secondary View 
disappears, because by deleting Pumps and Pump01 you have deleted the 
last strong parent. 

Typically you will be using Weak References for element references as you usually have one 
main, primary view and further views are additional, secondary ones. However, the next part of 
the exercise is to explore the use of Parent-Child with element references.  

 

Parent-Child 

Pump02 is located as a child under Production Line A - SiteABC. However, this is 
not considered as the only view for this pump, because an element reference for 
Pump02 is also below the Strong Families element, which is another view that is 
considered with the same importance Reference Type between Strong Families 
and Pump02 element reference is Parent-Child.  

1. Select Site ABC and click the Child Elements tab on the right. The child 
element Pump02 has a Parent-Child reference with its parent. 

2. Select Strong Families and click the Child Elements tab on the right. The  
Pump02 element reference has a Parent-Child reference with its parent. 

3. Select Site ABC and select Delete… from the element context menu. Select 
Delete option to delete the object and all references to it. Check-In and 
Refresh. Result: the element reference for Pump02 is promoted to an 
element. It changes from an element reference icon to an element icon. 
(Sometimes the PSE does not show that properly even after a Refresh. 
Switch to another database and back to the Demo database for a complete 
refresh.) 
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4.3.4 Exercise – Organizing the Tanks for Velocity Terminals 

 

This solo or group exercise is designed to maximize learning in a specific 
topic area. Your instructor will have instructions and will coach you if you 
need assistance during the activity. 

Exercise Objectives 

• Build additional elements with PI Builder. 

• Create parent elements to build a hierarchy. 

• Organize the elements into hierarchies with drag & drop. 

Problem Description 

Now that four (4) of your tanks are defined and organized under their site (Montreal, 
Canada), you now want to model and organize the tanks for other sites in your 
company, Velocity Terminals. The sites are: 

• Montreal, Canada 

• Tokyo, Japan 

• Sydney, Australia 

You also want the ability to view the company’s tanks as part of a separate hierarchy 
containing the receiving and distribution divisions. After searching on the enterprise 
portal, you find the following documents: 
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Approach 

Model the extra tanks in AF using the VelocityTerminals_Assets.xlsx worksheet 
located in the Class folder.  

1. To create the elements for the tanks Sydney and Tokyo, open the 

spreadsheet. Use PI Builder Publish ( ) function to create the new elements 
in your AF database.  

2. Using PSE, create new elements, not based on any template, to model the 
locations and divisions.  

3. Use the drag and drop techniques discussed previously to move the tanks 
into their appropriate hierarchies (Shift Key = Move Element).  

4. To create the element references under the Divisions, drag the tank elements 
into the corresponding element under Divisions (No key pressed = Create 
Element Reference). 

Note: Make use of Element References. Use Parent-Child references under the locations and 
Weak references under the divisions. 
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4.4 Using the Import and Export Feature in PSE 

From PSE, it is possible to use an Import and Export feature to export an entire AF 
database or just a AF object to an XML file. With the Import functionality, it is 
possible to import this AF object into another AF database. This can also be used to 
back up a AF structure before performing potential destructive actions. 

It is possible to export almost any AF object by simply right clicking that object and 

selecting the  option. To export the whole AF hierarchy along with all 
the necessary information to rebuild it completely, simply use the File > Export to File 
option. 

 

 

In order to be able to rebuild the structure as is, it is required to check the Include All 
Referenced Objects, so that Templates, Tables, UOMs, etc. are also exported to the 
.xml file. 
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4.4.1 Directed Activity – Export and Import a Database 

 

In this part of the class, you will perform a learning activity to explore the 
different concepts presented in this chapter or section. You may be invited to 
watch what the instructor is doing or perform the same steps at the same time. 
Your instructor will have directions. 

Activity Objectives 

• Learn how to export an XML file from an AF Database and import into another 
AF Database. 

Problem Description 

The AF structure for Velocity Terminals has been created in an AF database 
dedicated to training and checkout. We would like to release it to production in a 
different AF database. To do that, we will export contents of the AF Startup 
database and import it into another AF database called Velocity Terminals. 

Approach 

• With AF Startup database opened, select File > Export to File from PSE 
menu. 

• Click on the  icon and change settings to save the XML file as 
C:\Class\Exercises\01_Velocity Terminals\My Velocity Terminals.xml. Click 
on Save button (Note: this will not actually create the XML file!) 

 

• Check the Include All Referenced Objects option. Click on OK. 
 

• (optional) Use the editor and inspect the .XML file: locate units of measures, 
the Tanks templates, the table, the elements created for the VT Tanks etc. 

 

• Click on the  button and select the Velocity Terminals database. 
 

• Select File > Import from File from PSE menu and select the file that was 
saved recently. 

 

 
 

• Verify that objects in production database have been created successfully. 
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5. Visualizing Data 

5.1 Visualizing AF Data in PI Vision 

PI Vision is a modern and intuitive web-based visualization tool allowing ad hoc 
analysis through rapid display creation. PI Vision allows you to: 

• Search for PI data on desktop or mobile platforms.  

• Visualize PI data as symbols, such as trends, tables, values, and gauges.  

• Configure multi-state symbols to create visual alarms for critical process 
states.  

• Design, format and save displays for easy retrieval and further analysis.  

• Analyze and compare process events.  

• Monitor process data in displays.  

• Share displays with other members of a group or anyone with access to PI 
Vision.  

• View PI ProcessBook displays.  

Note: Before version 2017 the previous name for PI Vision was PI Coresight.  

PI Vision homepage: 

 

PI Vision makes use of an efficient search engine to let you browse through the 
organization’s AF structure and rapidly find the information you are interested in. As 
you begin looking at and analyzing some data, PI Vision will find related information 
that might also be of interest to you.  

If you have added a new database in AF and would like to access with PI Vision, you 
have to update the list of allowed AF Databases in PI Vision:  



Building PI System Assets and Analytics with PI AF 

 

Page 66 

 

Open the PI Vision Administration Page, then select AF Servers tab in the 
Configuration section. You may have to expand the structure under the AF Server 
name to see available databases. To add an AF database, select the checkbox next 
to the AF database name and click on Save. 

5.1.1 Directed Activity – Visualizing Velocity Terminal Data in a PI Vision Display 

 

In this part of the class you will perform a learning activity to explore the 
different concepts presented in this chapter or section. You may be invited to 
watch what the instructor is doing or perform the same steps at the same time. 
Your instructor will have directions. 

Activity Objectives 

• Create a PI Vision display with tank data (AF database: Velocity Terminals) 

• Incorporate objects with current data (trend, table, value object, gauge) 

• Incorporate a picture 

• Asset swap in PI Vision displays 
 

Problem Description 

Your manager has asked to visualize the tank data in a PI Vision display (name: 
Velocity Terminals Tank) in the following way: 

 

 

 

The display is setup for one of the tanks and should allow to swap between all tanks 
at Velocity Terminals. 
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Approach 

 

1. Click on the desktop link to open PI Vision. The link is http://pisrv01/PIVision. 

There is also a bookmark  for PI Vision under the favorites. 

The homepage provides an overview with thumbnails of the displays, which 
have been prepared for the training. 

2. To create a new display, click on the link  

Note: you are in Modify Display operation: the operation icon background is orange  and the 
canvas border is orange. To switch to Monitor Operation (you can do that in any non-empty 
display) click on the operation icon, the canvas border will disappear and the operation icon 

background switches to blue . You can toggle back and forth between the two operation 
modes. 

3. The search pane displays search paths for elements in the AF databases and 
for tags in Data Archive. 

 

4. Expand the asset structure to navigate to the Tank01. Select AF database 
Velocity Terminals and penetrate to Locations > Montreal > Tank01. Select 
Tank01 to get the attributes for that tank. 

 

http://pisrv01/PIVision
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5. Select Level attribute and drag it to the display canvas on the left hand side. 

 

 

6. Click on the > of the Level attribute to expand the structure and display the 
traits. Drag Hi, HiHi, Lo, LoLo and Target into the trend. Select Format Trend 
from the right mouse button menu. 
Under Single or Multiple Scales select Show Single Scale. 
Under Scale Range select Use database settings. 
Click into the canvas to close the Format Trend settings. 
Click on the time selector at the bottom and switch time display range to one 
hour. 
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7. Click on Image icon  and drag a rectangle in the display canvas. Under 
the Browse.. selection navigate to VT Tank.jpg under 
C:\Class\Exercises\01_Velocity Terminals 
 

 

8. From the object list, select the Value object . Drag Tank Name to the top 
of the tank picture.  

 

9. From the right mouse button menu of the Value object, select Format Value. 
Uncheck Label, UOM and timestamp. Change Value color to black. 

 

 

10. Accordingly, position a value object for the Product attribute in the right 
bottom corner 
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11. From the object list, select the Vertical Gauge object . Drag Level to the 
center of the tank picture. Use Format Gauge to change the appearance. 

 

12. From the right mouse button of the gauge object, select Add Multi-State. 
Change the colors as following: 
 
Bad data:  magenta 
HiHi – Maximum: blue 
Hi – HiHi:  light blue 
Lo – Hi:  light green 
LoLo – Lo:  orange 
Minimum – LoLo: red 

 

 

 

13. Click on < for Tank01 to collapse the structure again. 

From the object list, select the Table object . Select Capacity, Density, 
Product and Volume  (keep Ctrl-key pressed). Then drag them above the 
trend. You get a table with a header row and four rows for the four attributes 
you had selected. 
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Select Table Columns… from the right mouse button menu and uncheck 
Description, Trend, Minimum and Maximum. 

 

14. Click on the Save icon  on top right corner. Save display as Velocity 
Terminals Tank. 

15. Use the Asset selector  to switch to another tank, Tank02. 

16. Use the time control at the bottom to change the display ranges. Use the left 
arrow to step through past time periods. 

17. Position the cursor in the bottom area of the trend and drag it to switch the 
time range. 

 

 

18. To revert to the last hour from now, click on the Now button, then select the 
1h from the time range selector. 

19. Note: the display name has an asterisk at its end to indicate there have been 
changes.  
 

 
 

Click on the Save icon  to change these changes. To save the modified 
display under another name select Save As from the dropdown next to the 
Save button and save under another name. 

20. Add a symbol from the library to your display. The library is opened by 

clicking the symbol on the left hand side: . 
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5.2 PI ProcessBook Element Relative Display 

Open PI ProcessBook and use the File > New menu to create a *.PDI (standalone 
display document) named “Tank Monitoring”. 

From the View menu, select Element Relative Display and note the panel, which 
appears on the left.  

There is a PSE icon ( ), select it and select your AF Server-AF System-Database 
from the resulting Element Search dialog.  

Make sure to check the Search Sub-Elements check box and then click the Search 
button and select the four (4) tanks.  

The tanks will be added as Elements of Interest. 

 
 

Select from the menus Tools > Build and then Draw > Symbol Library.  

Now, from the drawing area of the screen, add a new symbol from the symbol library 
by dragging out a square of approximately 1 ½ inch on the screen, as shown below. 

  

This brings up the Symbol Library window. 

Select a tank symbol from the Tanks category to add to the display. 

Make sure you are still in Build mode (if not click again on the hammer ( ) icon). 
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Add a Bar next to the tank to represent its level by selecting Draw > Bar and then 
dragging out a bar shape on the screen.  

From the Define Bar window, open the pull/down fly-out menu next to the Tag 
Search button and select Element Relative. 

 

 

The selected tank should appear with its attributes.  

Select Level and use the down arrow to push it into the Selected Attributes list, then 
click OK.  

Add a dynamic value by selecting Draw > 
Value and clicking just below the tank symbol 
on the drawing area.  

Still using the Element Relative option, select 
the Level attribute again. 

Add a trend by selecting Draw > Trend and 
dragging out a rectangle the size of the trend 
wanted.  

Still using the Element Relative option, select 
the Mass attribute to be shown on that trend. 

Add another Value symbol above the tank, 
but this time select to Add Element Name by 
clicking this button at the bottom of the Select 
Attributes window (refer to the picture on the 
right). 

(Optional) Add two other value symbols to 
display the Capacity and the Volume 
attributes. 
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Switching to Run mode from Tools > Run. 

Select a different tank from the left panel to confirm the PI ProcessBook display is 
now element relative; meaning the information shown depends on which tank is 
selected on the side pane.  

Leveraging the AF structure and templates allows creation of reusable PI 
ProcessBook displays to represent similar equipment. 

Note the Mass attribute shown on the trend symbol has a history displayed, even 
though the attribute was created moments ago. Formula results are not stored in the 
Data Archive, rather they are calculated on demand when data is requested by a 
client.  

AF has the power to transform PI System data into information. 
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5.3 AF-based symbols in PI Processbook (optional) 

With Element Relative displays, switching between tanks is made easy, but what if 
you don’t want to switch between the tanks.  You want to have all tank information in 
one display, e.g. information for all Montreal tanks in one display? 

 

 

To support that capability, Processbook has AF-based symbols which can be assign 
to an AF asset element template or element.  
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5.3.1 Directed Activity – Assigning Symbols to Templates or Elements 

 

In this part of the class you will perform a learning activity to explore the 
different concepts presented in this chapter or section. You may be invited to 
watch what the instructor is doing or perform the same steps at the same time. 
Your instructor will have directions. 

Activity Objectives 

• Demonstrate assigning symbols to template. 

Problem Description 

The four tanks at Montreal are experiencing problems.  Your manager does not want 
to switch displays to compare tank properties.  He would like to see the four tanks on 
one display for troubleshooting purposes. 

 

Approach 

Let us create a PI Processbook group of symbols for one of the tanks, which we will 
associate with the tank template in AF. Then it is easy to duplicate this for the other 
tanks.   

Open PI ProcessBook and open the display Tanks Montreal.PDI (located in the 
class\exercises folder): 

 

 



Visualizing Data 

 

Page 77 

 

In the area for Tank01, add value objects for Material, Capacity and the Current 
Volume. In Build Mode, click on Draw > Value and click into the display to position 
the symbol on the right hand side of the text Material. In the Define Value dialog box, 
click on the drop down arrow and select AF2: 

 

 

Note: The AF2 dataset provides access to the AF database allowing you to configure a PI 
ProcessBook symbol with an AF attribute. 

In the Select AF attribute dialog, click on Tank01 in the AF asset tree and select 
Product Attribute, UOM= <none>: 
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Repeat the same for attributes Capacity (attribute: Capacity, UOM=US Gallon) and 
Current Volume (attribute: Volume, UOM=cubic meter).  

In Build Mode, click on Draw > Bar, position the cursor on the tank symbol and click 
to open a rectangle for a vertical bar. In the Define Bar dialog box, click the drop 
down arrow and select AF2. In the Select AF attribute dialog, click on Tank01 in the 
AF asset tree and select Attribute  Level, UOM= %. 

 

 

Now select the objects in the bottom rectangle (the tank, the bar, the texts and the 
value objects) and select Arrange > Group to combine them into one object. 

 

From the context menu select Assign Symbol to Template… and select the Tank 
template. 

Note: if the Assign Symbol to Template… menu item is greyed out, select another object in the 
display, then reselect the group symbol. The menu item should now be available for selection. 

Click on View > AF Browser. To duplicate the tank symbol for the remaining tanks, 
select Tank02 in the AF Browser and drag it into the corresponding space in the 
display. Repeat for Tank03 and Tank04. 
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5.4 PI Datalink 

PI Datalink is a Microsoft Excel add-in that allows you to import data from your PI 
System into a spreadsheet.  Combined with the computational, graphic, and 
formatting capabilities of Microsoft Excel, PI Datalink offers powerful tools for 
gathering, monitoring, analyzing, and reporting PI System data. 

5.4.1 PI Datalink Support for AF 

With PI Datalink 2013+, it is possible to create reports that will leverage the AF 
model, allowing reports to be reusable across similar assets. PI Datalink 2013+ 
benefits from the new integrated search engine, allowing searches for tags and 
assets all at once. 

PI Datalink 2014 introduces support for Event Frames, which will be discussed later 
in the class. 
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5.4.2 Directed Activity – PI Datalink Basics: Access Sampled Tag data 

 

In this part of the class, you will perform a learning activity to explore the 
different concepts presented in this chapter or section. You may be invited to 
watch what the instructor is doing or perform the same steps at the same time. 
Your instructor will have directions. 

This exercise is a brief introduction into PI Datalink. It familiarizes with recommended steps to 
create a spreadsheet with dynamic data from the PI system. 

 

Activity Objectives 

• Use the Sampled Data function to get interpolated data for a tag in specified 
time intervals. 

• Understand how to reference spreadsheet cells to specify parameters for 
Datalink functions. 

 

Problem Description 

You would have a report with interpolated tag values from tag TANK01LI.PV. The list 
should cover the last 4 hours and list values in 15 minute intervals.  

 

Approach 

1. Open AF Class Datalink Exercises spreadsheet located in the 
c:\class\exercises\01_Velocity Terminals folder. 

2. Select the PI DataLink ribbon. Explore the different groups of PI Datalink 
functions (see also the list on the next page). Which is the function that you 
have to use? 
 
_______________________________________________________ 
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Group Function Name Function Example 

Single 
Value 

Current Value 
Retrieve the current or 
most recent value of a 
data item 

What is the current outside air 
temperature? 

Archive Value 
Retrieve a data item 
value for a specified 
point in time 

What has been the tank level 
this morning at 8:00 AM? 

Multiple 
Value 

Compressed 
Data 

Retrieve data item 
values for a specified 
time range 

What are the values stored in 
the archive for the pressure 
sensor for yesterday? 

Sampled Data 

Retrieve evenly-spaced, 
interpolated data item 
values for a specified 
time range 

What is the generated Wind 
turbine power, listed for every 
full hour on the last Sunday? 

Timed Data 

Retrieve interpolated 
data item values that 
match with an array 
specified of time stamps  

What are the CO2 level values 
for the tank at those times 
yesterday when there is value 
in the archive for the pressure 
sensor? 

Calculation 

Calculated Data 

Retrieve calculated data 
item values. The 
calculation performs an 
aggregation over a time 
period (like minimum, 
maximum, average etc.) 

What are the hourly averages 
for the reactor’s internal 
temperature for yesterday? 

Time Filtered Calculate the amount of 
time over which a 
performance equation 
evaluates as true for a 
specified time range. 

How long has the motor been in 
the “Running” state yesterday? 
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3. Select the Spreadsheet tab named Tags. 

4. Enter the tag name TANK01LI.PV into cell B1. 

5. Put the cursor in cell D1. This is where we want to have the result from the 
Datalink function. 

Note: before selecting a PI Datalink function, select the cell in the spreadsheet where 
the result from the Datalink function should be output! This should be a free area in your 
spreadsheet, so that existing contents is not overwritten!  

6. Select Sampled Data function from Multiple Value group. Result: you get the 
Sampled Data parameter window on the left hand side. Put the cursor into 
Data Item(s) to select this parameter. 

Note: click on the upper half of the icon. If you select the lower half, you select the 
function along with pre-defined parameters.  

7. With Data Item(s) selected, click cell B1 to reference the tag TANK01LI.PV. 
Result: the parameter is set to ‘Tags’!$B$1 

8. Put the cursor into Start time to select the parameter, then click cell B2. 

9. Put the cursor into End time to select the parameter, then click cell B3. 

10. Put the cursor into Time interval to select the parameter, then click cell B4. 

11. Check Show time stamps.  
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12. Click on OK button. Result: data is returned into cell area D1 … E17. 

Note: if you click Apply instead of OK, the Sampled Data parameter window is not 
closed. 
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5.4.3 Directed Activity – PI Datalink Basics: report with data from AF 

 

In this part of the class, you will perform a learning activity to explore the 
different concepts presented in this chapter or section. You may be invited to 
watch what the instructor is doing or perform the same steps at the same time. 
Your instructor will have directions. 

This exercise repeats the previous exercise, but instead of referring to a tag, an attribute in AF 
(with PI Point Data Reference) is referenced. 

 

Activity Objectives 

• Understand how to specify an AF attribute in PI Datalink functions. 

 

Problem Description 

The report from the previous exercise should be built by referring to the Level 
attribute of Tank01 in AF. 

 

Approach 

There are two ways to do that: 

• refer to the Level attribute with the full AF path in one parameter for the 
Datalink function 

• refer to the Level attribute with the path and the attribute name in two 
parameters 
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Full AF Path 

1. Select the Spreadsheet tab named Attributes (1). 

2. Put the cursor into cell B1, then click on the lower part of the Search icon and 
select In a row. Result the Datalink Search window appears. You can either 
search for tags or for information in AF. Select the AF Server PISRV01. 
Result: PISRV01 is shown in the search path above. 

3. Click on Velocity Terminals database, then penetrate further on to elements 
Velocity Terminals – Locations – Montreal. 

4. Enter Level into the search field and click on the magnifier glass at the right 
side. Result: four Level attributes are listed, one from each of the four tanks in 
Montreal, Tank01 … Tank04. 

5. Drag the slider for Data item length to the left position, which is Full Path. 

6. Select the line for Tank01 is the list above, then click on OK. Result: the full 
path appears in cell B1: 
\\PISRV01\Velocity Terminals\Velocity Terminals\Locations\Montreal\Tank01|Level 

Note: the | character separates the path from the attribute name. 

13. Select Sampled Data function from Multiple Value group. Result: you get the 
Sampled Data parameter window on the left hand side. Put the cursor into 
Data Item(s) to select this parameter. 

14. With Data Item(s) selected, click cell B1 to reference the cell with the full 
path.  

15. Set parameters for Start time, End time and Time interval and check Show 
time stamps. 

 

 

16. Check Show time stamps. Click on OK button. Result: data is returned into 
cell area D1 … E17. 
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Path and Item (attribute name) in two parameters 

1. Select the Spreadsheet tab named Attributes (2). 

2. Put the cursor into cell B1, then click on the lower part of the Search icon and 
select In a row. Result the Datalink Search window appears.  

3. Run the same search as in the previous exercise (it is probably still preset) 
and get the same four Level attributes listed as before. 

4. Drag the slider for Data item length to the right position, which is Name Only. 

5. Select the line for Tank01 is the list above, and select Insert root paths in: 
Column or Row. Click on OK. Result: the path appears in cell B1, the attribute 
name appears in cell B2. 

6. Put the cursor in cell D1. This is where we want to have the result from the 
Datalink function. 

7. Select Sampled Data function from Multiple Value group. Result: you get the 
Sampled Data parameter window on the left hand side. Put the cursor into 
Root path to select this parameter. 

8. With Root path selected, click cell B1. Result: the parameter is set to 
‘Attributes (2)’!$B$1 

9. Set parameters for Start time, End time and Time interval and check Show 
time stamps. 

 

 

10. Click on OK button. Result: data is returned into cell area D1 … E17. 
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5.4.4 Directed Activity – PI Datalink: switch asset context in a report with data from AF 

 

In this part of the class, you will perform a learning activity to explore the 
different concepts presented in this chapter or section. You may be invited to 
watch what the instructor is doing or perform the same steps at the same time. 
Your instructor will have directions. 

PI Datalink search window allows the possibility to generate drop-down lists in Excel to allow a 
report to be applicable to multiple similar assets. This exercise repeats the previous exercise, 
but shows how to create a cell with a drop-down selection to switch the asset context.  

 

Activity Objectives 

• Create a Datalink report that can be switched between different assets.  

 

Problem Description 

The report from the previous exercise, which gives values for the Level attribute of a 
tank, should be enhanced to allow the switch between the twelve tanks. 

 

Approach 

 

1. Select the Spreadsheet tab named Attributes (3). 

2. Put the cursor into cell B1, then click on the lower part of the Search icon and 
select In a column. Result the Datalink Search window appears.  

7. Expand the search for tanks in all locations. You can do that by click on 
Locations in the search above. Enter Level into the search field and click on 
the magnifier glass at the right side. Result: twelve Level attributes are listed, 
one from each of the twelve tanks, Tank01 … Tank12. 

3. Drag the slider for Data item length to the right position, which is Name Only. 

4. Select the all lines in the list above (you can click on the checkbox in the 
header line for that), and select Insert root paths in: Drop-down list. Click on 
OK. Result: the path appears in cell B1, the attribute name appears in cell B2. 

5. If you click cell B1 you get a drop-down selector icon for one for your 12 
tanks. 

6. Put the cursor in cell D1. This is where we want to have the result from the 
Datalink function. 

7. Select Sampled Data function from Multiple Value group. Result: you get the 
Sampled Data parameter window on the left hand side. Put the cursor into 
Root path to select this parameter. 
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8. With Root path selected, click cell B1. Result: the parameter is set to 
‘Attributes (2)’!$B$1 

9. Put the cursor into Data Item(s) to select this parameter. With Data Item(s) 
selected, click cell B2. 

10. Set parameters for Start time, End time and Time interval and check Show 
time stamps. 

11. Check Show time stamps. 

 

 

12. Click on OK button. Result: data is returned into cell area D1 … E17. 

13. If you switch the tank selection in cell B1, the report will retrieve data for the 
selected tank. 
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5.4.5 Exercise – Tank Level Report 

 

This solo or group exercise is designed to maximize learning in a specific 
topic area. Your instructor will have instructions and will coach you if you 
need assistance during the exercise.  

Objectives 

• Exercise the searching in PI Datalink. 

• Get familiar with PI Datalink function to retrieve archive data. 

Problem Description 

The production supervisor needs an Excel report displaying the change in the level 
of tank in Montreal between 8:00 AM and 9:00 AM today. 

Approach 

Select the Spreadsheet tab named LevelReport. 

Use the Archive Value function to retrieve the level at 8:00 AM and at 9:00 AM today. 
Once you have the level in two columns, you can calculate the difference using 
Excel. Watch and follow along while the instructor creates this PI Datalink report. 
Use Excel conditional formatting (Excel Home tab, Styles group) to highlight a 
negative change. 
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5.4.6 Exercise – Building an Element Relative PI Datalink Report 

 

This solo or group exercise is designed to maximize learning in a specific 
topic area. Your instructor will have instructions and will coach you if you 
need assistance during the exercise.  

Objectives 

• Experiment with PI Datalink’s Asset Relative feature. 

• Follow the steps needed to create a report applicable to similar assets. 

Problem Description 

Create a small report that has the hourly averages for the level and mass present in 
one of the Velocity Terminals tanks for the previous day. The report should have the 
data for one tank, but should allow switching to another tank.  

 

 

Approach 

Select the Spreadsheet tab named Tank Analysis Report. 

Which Datalink function allows to aggregate data such as getting the average over a 
period of time? 
 
_______________________________________________________ 

 

 

 

 



Visualizing Data 

 

Page 91 

 

Hint: Cell C8 and F8 were prepared to show spark lines. Here is how the spark line 
has been added for the Level data:  

− Select the cells with the data (just select the values, not the timestamps) 

− From the Excel Insert ribbon, select Sparkline 

− Select the output cell (C8) 
 

 

(Accordingly for the Mass spark line) 
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6. Adding Analytics to the Assets 

PI Asset Framework provides several options to enhance the data with calculations 
that are carried out on top of the values in the PI Data Archive. These calculations 
transform raw process data into decision making information that is provided by the 
PI System. 

AF Calculation Option Examples 

Value Retrieval Methods 
(defined in PI Point data Reference) 

Get interpolated value for a PI Point from a 
particular point in time (e.g. from 2 hours 
ago), get aggregated data for a PI point for a 
defined time period (e.g. maximum from the 
last 24 hours) 

Formula Data Reference 
Ad-hoc calculation (add volumes from two 
tanks) 

Asset Analytics 
(Expression, Rollup, Event Frame 

Generation, SQC) 

Expression: perform all kind of simple and 
complex calculations such as summaries, 
consumptions, metric data, KPIs etc.  
Rollup: aggregate/summarize data over 
several levels in the asset hierarchy (e.g. 
maximum temperature for all reactors, overall 
production in all production lines) 
EF Generation: monitor process for special 
conditions and capture in event frames (e.g. 
downtimes, process excursions) 
SQC: online statistical calculations   

For a decision on what calculation options to use, consider the following aspects: 

• What load will the calculation place on the PI System? 

• Do I need to keep the history for the calculation? 

• Will the calculation be applied to multiple assets? 

• How complex is the calculation? 

For related information refer to the Comparison table at the end of the next chapter. 

Beside options in AF, there are further options in the PI System: Performance 
Equations (PE) points and Totalizer tags (tag-based analytics in PI Data Archive 
(*)),Calculated Data function and PI Expressions (PI Datalink), PI Calculation 
datasets (PI Processbook) and PI Advanced Computing Engine (PI ACE). 

(*) Note: Rather than using tag-based analytics in PI Data Archive, OSIsoft strongly 
recommends that users upgrade to asset analytics that support event frames, formula data 
references, and other newer features of PI Asset Framework. 



Adding Analytics to the Assets 

 

Page 93 

 

6.1 AF Calculation Options Overview 

This section is an overview of calculation options in the PI System, all options are 
explained individually in more detail later. 

 

Value Retrieval Methods 

• Configurable option within the PI Point Data Reference 

• By default the current value of a tag is displayed 

• By Time: get data from another point in time  
(e.g. value from 2 hours ago) 

• By Time Range: get aggregated data  
(e.g. maximum value from last 15 minutes, total amount of material based on 
the inflow) 

 

 

 

Formula Data Reference 

• Ad-hoc calculation, no history saved 

• Calculation is defined in one or multiple equations 

• Equation syntax based on variables,  
operators (+, *, …) and functions (sin, cos, abs, sqrt,…) 

• Examples: volume based on capacity and level, value of your stock based on 
amount of goods and current prize 
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Asset Analytics (Analyses) 

• Analysis Types: Expression, Rollup, Event Frame Generation, SQC 

 

Expression Analyses: 

• Calculation defined based on attributes, variables, operators and functions   

• Functions include Performance Equation (PE) functions  
(e.g. FindEq, TimeGE, TagMax, Tag Avg,…) 

• Results stored in attributes (Analysis Data Reference, PI Point Data 
Reference) 

 

Note: This is for a first orientation. Expression Analyses as well as the other analysis types will 
be explained in more detail later on. 

Comparison 

To help you with the selection for the best calculation option, use the following table. 

 Value 
Retrieval 
Methods 

Formula Data 
Reference 

Expression 
Analysis 

(Output to non PI 
Point Attribute) 

Expression 
Analysis 

(Output to PI 
Point Attribute) 

Creation Method Configuration Expression Expression Expression 

Functions No Limited PE PE 

Historization No No No Yes 

Recalculation/ 
Backfilling 

No No No Yes 

Calculation Load Server Client Client Server 

Time Awareness Relative No Yes Yes 
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6.2 Formula Data Reference 

Formula Data References allows the creation of simple custom calculations. 
Calculations can be in the form of a single formula or a sequence of calculations. 
The calculations are executed on demand, and the results are not archived 
anywhere. The functions available are limited and they are not time-weighted.  

 

 

6.3 Value Retrieval Modes 

By default, the PI Point Data Reference retrieves the current value of a particular 
point. The value retrieval methods of the PI Point Data Reference can be configured 
so that the value will be either 

• the value of a point at a specific time (By Time retrieval mode) 

• the result of a calculation on the point’s value over a time range, e.g. an 
average  
(By Time Range retrieval mode). 

 

 

For full information refer to "Configure value retrieval by time" and 
"Configure value retrieval by time range" in Chapter "PI point data 
references" in the PI System Explorer User Guide, version 2015, p. 
140 and 141. 

  

http://icons.mysitemyway.com/wp-content/gallery/black-white-pearls-icons-culture/024263-black-white-pearl-icon-culture-book3-open.png
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By Time - Retrieving a value other than the current one. 

 

 

By Time mode options are After, At or Before, At or After, 
Automatic, Before, Exact Time and Interpolated. To get a 
value other than the current value these options are used in 
context with the Relative Time field. Relative time 
expressions have to be in the PI System Time format (see 
examples below).  

 

By Time Relative 
Time 

Meaning 

At or After -15m Returns the recorded value from 15 minutes before the current 
time. If no value exists at that time, the next recorded value is 
returned. 

After -2h Returns the first recorded value after the point in time that is two 
hours ago. If a value exists exactly at that time, it is not returned. 

Exact -2h Returns the recorded value from two hours before the current 
time. If no value exists at that time, “No Data”-error is returned. 

Interpolated T+6h Returns an interpolated time for 6:00:00 of the current day. 

 

Note: Do not choose the Not Supported, Time Range, and Time Range Override options for By 
Time. These options are for attribute values based on time range calculations (see below) 
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By Time Range – Retrieving the result of an aggregation. 

 

 

By Time Range options are: 

Average (time-weighted), Count, Delta, Maximum, Minimum, Population Standard 
Deviation, Standard Deviation, Start Time, End Time, Total. 

In case of Total, an extra drop-down appears to specify the time units of the rate 
point or attribute over which the calculation is performed. That is required since the 
Data Archive always assumes a rate point to be in units/day. Selecting the right time 
units is thus essential to retrieve a correct result. 

The options in the By Time field for a By Time Range retrieval are Not Supported, 
Time Range and Time Range Override. Depending on what time context the client 
application is providing the behavior is in the following table.  

 

By Time 
Setting 

Meaning 

Not Supported If client application sends a time range, it is considered for the 
calculation. If client application sends point in time (and not a time 
range), an error is returned.  

Time Range If client application sends a time range, it is considered for the 
calculation. If client application sends point in time (and not a time 
range), the time range specified under Relative Time is used. 

Time Range 
Override 

The time range specified under Relative Time is used in any 
case. 
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6.3.1 Directed Activity – Understanding Value Retrieval Modes for Times Ranges 
(optional) 

 

In this part of the class, you will perform a learning activity to explore the 
different concepts presented in this chapter or section. You may be invited to 
watch what the instructor is doing or perform the same steps at the same time. 
Your instructor will have directions. 

Activity Objectives 

• Distinguish retrieval modes for time periods: Not Supported, Time Range and 
Time Range Override 

 

Problem Description 

• You are measuring a temperature and would like to get minimum and 
maximum for the last hour as well as for the time period applied in your PI 
Vision trend.  

 

Approach 

Open the Demo database and select the Value Retrieval Demo element.  

1. Display the elements attributes and get their function. 

Attribute Name Value 

Temperature Actual Value from now 

Temperature.Min. 
TimeRangeNotSupported 

Temperature Minimum for a time period: The time range 
is taken from the client (here: PSE). Because the PSE 
does not supply a time range, a corresponding error (The 
attribute requires a time range…) is displayed. 

Temperature.Min. 
TimeRange.1HR 

Temperature Minimum for a time period: If the time range 
is supplied by client (here: PSE), it is used. Because the 
PSE does not supply a time range, the specified range is 
used (1hr). 

Temperature.Min. 
TimeRangeOverride.1HR 

Temperature Minimum for one hour time period 

(according to the three minimum attributes, there are three corresponding maximum 
attributes) 

2. (optional) From PSE Tools > Options > Time Context set a time range for 
PSE of e.g. last five minutes. Discuss the value attribute changes. Reset the 
time context back (Query Date Time= Latest Available) 
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Click on the desktop link to open PI Vision and select the Retrieval Modes Demo 
display.  

 

1. Display the elements attributes and get their function. Set time period selector 

to 1h:  

 

Attribute Name Value 

Temperature Actual Value from now 

Temperature.Min. 
TimeRangeNotSupported 

Temperature Minimum for a time period: The time range 
is taken from the client (here: PI Vision). PI Vision time 
range is one hour. This means the Temperature 
Minimum is for a hour time period. 

Temperature.Min. 
TimeRange.1HR 

Temperature Minimum for a time period: If the time range  
is supplied by client (here: PI Vision), it is used. PI Vision 
time range is one hour. This means the Temperature 
Minimum is for a hour time period. 

Temperature.Min. 
TimeRangeOverride.1HR 

Temperature Minimum for one hour time period 

(according to the three minimum attributes, there are three corresponding maximum 
attributes) 

 

2. Set the time period selector to 8 hours. 

Attribute Name Value 

Temperature Actual Value from now 

Temperature.Min. 
TimeRangeNotSupported 

Temperature Minimum for a time period: The time range 
is taken from the client (here: PI Vision). PI Vision time 
range is eight hours. This means the Temperature 
Minimum is for an eight hour time period. 

Temperature.Min. 
TimeRange.1HR 

Temperature Minimum for a time period: If the time range 
is supplied by client (here: PI Vision), it is used. PI Vision 
time range is eight hours. This means the Temperature 
Minimum is for an eight hour time period. 

Temperature.Min. 
TimeRangeOverride.1HR 

Temperature Minimum for one hour time period 



Building PI System Assets and Analytics with PI AF 

 

Page 100 

 

  



Adding Analytics to the Assets 

 

Page 101 

 

3. Set the start time to y+22h, set the end time to t. This is the time period of the 
two hours before midnight today. 
(yesterday 22:00:00 – today 00:00:00). 
 

Attribute Name Value 

Temperature Value from today midnight (today 00:00:00) 

Temperature.Min. 
TimeRangeNotSupported 

Temperature Minimum for a time period: The time range 
is taken from the client (here: PI Vision). PI Vision time 
range is two hours. This means the Temperature 
Minimum is for the two hour time period before midnight 
today. 

Temperature.Min. 
TimeRange.1HR 

Temperature Minimum for a time period: If the time range 
is supplied by client (here: PI Vision), it is used. PI Vision 
time range is two hours. This means the Temperature 
Minimum is for the two hour time period before midnight 
today. 

Temperature.Min. 
TimeRangeOverride.1HR 

Temperature Minimum is for the one hour time period 
before midnight today (yesterday 23:00:00 – today 
00:00:00) 
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6.3.2 Directed Activity – Apply Value Retrieval Modes for Tank Level Attribute 

 

In this part of the class, you will perform a learning activity to explore the 
different concepts presented in this chapter or section. You may be invited to 
watch what the instructor is doing or perform the same steps at the same time. 
Your instructor will have directions. 

Activity Objectives 

• Use the Value Retrieval mode to get the value of a tag from two hours ago 
and its average for the last two hours. 

 

Problem Description 

• In addition to the actual material content level in the tanks, the operational 
personnel would like to see what the level has been 2 hours ago and what 
the average level has been for the last 2 hours.  

 

Approach 

Open the Tank template in the Library of the Velocity Terminals database. 
Select Attribute templates tab.  

For the value from two hours ago: 

1. Select the line with the Level attribute and select New Child Attribute 
Template from the right-mouse button context menu. 

2. Attribute Name = Level.2HoursAgo 
Default UOM = percent 
DisplayDigits=2 
Data Reference = PI Point 

3. PI Point Settings: 
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For the average value of the last two hours: 

1. Select the line with the Level attribute and select New Child Attribute 
Template from the right-mouse button context menu. 

2. Attribute Name = Level.2HoursAverage 
Default UOM = percent 
DisplayDigits=2 
Data Reference = PI Point 

3. PI Point Settings: 

 

 

 

 

 

 

 

 

 

 

 

 

Verify the results: 

1. Open one of the Velocity Terminals tanks (look at Tank03 because Level for 
Tank01 and Tank02 changes too often). 

2. Select the lines with the Level attribute and the two recently created child 

attributes and select  Trend from the right-mouse button context menu. 

3. Set Start Time= *-8h and End Time= * and click on  Refresh button. 
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6.3.3 Directed Activity – Simple Calculations for PI Big Tires Co. 

 

In this part of the class, you will perform a learning activity to explore the 
different concepts presented in this chapter or section. You may be invited to 
watch what the instructor is doing or perform the same steps at the same time. 
Your instructor will have directions. 

Activity Objectives 

• Use the Formula Data Reference and the Value Retrieval modes to create 
analytics. 

Case study 

As a consultant for a tire manufacturing company, PI Big Tires Co., you help create a 
smarter AF structure; your client wants to have more insight on his operations by 
taking advantage of the calculation and analytics features provided by the PI System. 
The tire curing presses are an essential part of the production process and currently 
there is a lack of key performance metrics; your client wants you to start working on 
this section of the factory. 

Here is how a Tire Curing Press works: raw tires are loaded individually into a Tire 
Curing Press. Once the tire is loaded, the press closes up and temperature and 
pressure is applied to cook and mold the tire. After the cooking time has elapsed, the 
press opens up and the tire is unloaded into a cooling unit where fans blow air until 
the tire reaches a specific temperature. 

Below a screenshot of the current press template. Open PSE, connect to the AF 
Server and AF database indicated by the instructor and take a minute to familiarize 
yourself with the template and attributes. 
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Problem Description 

1. The maintenance coordinator would like a new attribute to display the total 
steam consumed during the last 24 hours. He does not need to archive the 
result of that calculation in the Data Archive. 

2. The cost of a scrap tire is 20 dollars. The quality inspector would like 
everyone to see in an AF attribute how much money the company has lost in 
scrap tires. The production supervisor agreed to display this in AF but not to 
archive the result in the Data Archive. 
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Approach 

1. Create a new attribute on the press template and use the value retrieval 
methods to calculate the total.  

 

 

2. Create a new attribute and use the formula data reference to calculate the 
cost of scrap tires. 
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6.4 PI Analysis Service, Expression Analysis 

Asset analytics is a new feature of PI Analysis Service released with AF 2014 (2.6).  
Asset Analytics allows you to create and manage analyses on top of your AF assets.  
An analysis is a scheduled calculation that gets input values from attributes in any 
level of your AF hierarchy and outputs its results to other AF attributes.  

Asset analytics features three types of analysis: 

• Expressions: Wide range of functions to create powerful analyses. 
Expressions use the Performance Equation syntax. 

• Rollup: Aggregation calculations for a group of selected attributes. 

• Event Frame Generation: Specify conditions to trigger the start and the end of 
an event.  

• SQC: Uses Statistical Quality Control (SQC) methods to monitor that attribute 
values lie within pre-determined boundaries. 

 

Asset analytics provides the following capabilities: 

• Historization:  When the output attribute is mapped to a PI Point, the 
calculation results are archived in the Data Archive. 

• Backfilling/Recalculation:  
Backfilling: Run the analysis over an earlier time period to backfill data for the 
PI Points mapped to its outputs. Example: a new analysis to calculate daily 
overall consumptions is created on April 1st. With Backfilling the overall 
consumptions are calculated for a past period such as e.g. January - March 
and stored in the archive of the output tag.  
Recalculation: In case the values for the inputs of a calculation have changed 
the recalculation feature allows to update the calculation results accordingly. 

• Security: It is possible to configure and manage permissions to limit access to 
analyses and analysis templates. 

• Preview and Test: Calculation results can be previewed before putting the 
analyses into production.  

• Calculation Dependencies: The result of a calculation can be used as an 
input to another calculation. 

• Scheduling options: Calculations can be configured to be executed according 
to a schedule or they can be event based.  

Every analysis is associated with an element and can be created directly on that 
element by selecting the Analyses tab; however, it is recommended that analyses 
be associated with an element template. In order to do this, select the corresponding 
Element Template and then use the Analysis Templates tab (see figure below). 
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Analyses can be managed (e.g. start, stop, backfill) directly at the element level 
under the Analyses tab, or by using the Management plug-in from the navigator 
panel. See below a screenshot presenting a short description of the different 
components of the Management plug-in. 
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6.4.1 The Expression Analysis 

The expression analysis allows you to create and schedule calculations using the 
Performance Equation (PE) syntax and a broad gallery of functions. Before 
discussing expression analysis in detail, it is essential to review the syntax for 
expression analysis (also referred as Performance Equation (PE) syntax). 

6.4.2 Syntax for Expression Analysis (PE Syntax) 

The syntax for expression analysis is an algebraic syntax used to perform 
calculations and filter data in multiple client and server products from the PI System 
suite. Besides PI Analysis Service, the following products use this syntax: 

• Data Archive through a PE points. 

• PI ProcessBook through a PI Calculation dataset. 

• PI Datalink through use of Filter Expressions or PI Expressions. 

• Notifications through use of a PI PE Trigger Condition. 

 

This syntax has three (3) rules when it comes to writing expressions: 

1. AF Attributes or Data Archive tag names and time stamps are written enclosed 
in single quotes (‘): 

For example: ‘Pressure’, ‘CDT158’, ‘*-1h’, ‘03-Feb-2013 13:38’ 

2. Text (strings) or digital states are written enclosed in double quotes (“): 

For example: “This is a comment.”, “OFF”, “Active”, etc. 

3. Mathematical operators and PE functions are written as is. 

For example: +, -, *, ^, TagTot(), FindGT(), etc. 

The expression functions reference guide is available under the PSE help menu. 
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6.4.3 Directed Activity – Checking Out the Expression Functions Reference 

 

In this part of the class, you will perform a learning activity to explore the 
different concepts presented in this chapter or section. You may be invited 
to watch what the instructor is doing or perform the same steps at the same 
time. Your instructor will have directions.  

Activity Objectives 

• Learn where to find information about analysis expression functions. 

• Explore the functions of the Expression Analysis syntax.  

Approach 

Information about analysis expression functions can be found at:  

1. Analyses tab (Elements and Element Templates): Select the Demo AF Database and 
locate the Analysis Demo element. Select the Analyses tab. Expression Functions are listed 
at the right hand side. Use the drop-down for segregation according to functionality. 

 

 

2. PI System Explorer Help: Asset Analytics > Expression functions reference 

With the instructor, examine the highlights of Expression Analysis syntax and its 
available functions. 

• What function would you use to calculate the time-weighted average of an 
attribute over the last 8 hours? ______________________. 

• You want to find the total time that an attribute was greater than 100.What 
function would you use? ___________________________. 

Note: Each function presented in the reference guide features examples that can be copied 
over to notepad or to other PI System products directly. 
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6.4.4 Exercise – Applying Expression Analysis Syntax 

 

This solo or group activity is designed to maximize learning in a 
specific topic area. Your instructor will have instructions and will 
coach you if you need assistance during the activity. 

Exercise Objectives 

• Learn to apply the Expression Analysis Syntax to different calculation and 
filtering problems. 

Problem Description and Approach 

You may want to construct your equations in Notepad or another text editor rather 
than in the space below so you can cut and paste from the help file. 

Problem Your solution… Hints 

Get a ten-minute “rolling” 
average of the SensorX 
attribute 

 TagAvg() 

Get the time-weighted 
total for the SensorY 
attribute over the last 24 
hours, but only if at least 
80% of the values used in 
the calculation are 
considered “good”. 

 
TagTot() 

 

The amount of time the 
Mode attribute was 
“Manual” during the past 
four days. 

 

TimeEQ() 

The amount of 
time returned is in 
seconds. 

Display “Overload” when 
the SensorX attribute is 
greater or equal than 90 , 
“Normal” when between 
10 and 90 (excluding the 
boundary values), and 
“Empty” when lower or 
equal than 10.  

 If... then… else 

 

Try to do this exercise on your own before referring to the exercise solutions section 
at the end of the book. 
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Familiarize with the function entry (optional) 

1. Open the Demo database and select the Analysis Demo element. 

2. Select the Analyses tab 

3. Click on the  New Analysis icon. 

4. Enter the expressions in the Expression tab. 
 

 
 

5. The analysis is not needed any more, so you can click on Check-out to undo 
the entry. 
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6.4.5 Directed Activity  - Overall Equipment Effectiveness (OEE) Metrics 

 

In this part of the class you will perform a learning activity to 
explore the different concepts presented in this chapter or section. 
You may be invited to watch what the instructor is doing or perform 
the same steps at the same time. Your instructor will have 
directions. 

Activity Objectives 

• Create and configure an expression analysis. 

• Create an analysis template. 

• Backfill an analysis. 

• Manage an analysis via the Analyses plugin. 

Problem Description 

Management would like to track the productivity of the tire curing presses by using 
Overall Equipment Effectiveness (OEE). In short, OEE, developed in the mid 1990’s, 
enables the monitoring of plant floor productivity and improvement of the efficiency of 
a manufacturing process. OEE is composed of three different metrics: Availability, 
Performance and Quality. 

 

Metric Description Formula 

Availability 
Percentage of time that an equipment is 
up and running 

Operating Time / Planned Production 
Time 

Performance Actual yield to the target yield Total pieces / Target 

Quality 
Percentage of good units that are 
produced  

Good pieces / Total Pieces 

OEE Availability*Performance*Quality 

 

For this exercise, OEE metrics will be calculated daily.  

Approach 

The metrics represent a ratio, which can be in the range 0 … 1. We could also 
represent this as a percentage in the range 0 … 100. We will use units for ratio and 
percentage to convert the figures accordingly.  

Each press has a status attribute. A press is considered to be operating whenever it 
is in the running status; any other status indicates that the press is out of order. 

Follow the instructor as he or she performs the steps to create an analysis to 
calculate the availability of the presses. You will later be working on your own. 

  



Adding Analytics to the Assets 

 

Page 115 

 

Adding a unit of measure for the ratio 

There is already a UOM class for ration, which has percent in it. Let us add another 
unit of measure for the ratio. 

With Unit of Measure selected in PI System Explorer Navigator, navigate to the UOM 
class Ratio. Add a new unit of measure named ratio: 

 

 

Note: A ratio of 1 means 100%. 
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Adding an Analysis Template 

As indicated previously, it is recommended to configure the analyses directly at the 
template level. So let’s open the press element template and click on the Analysis 
Templates tab. In this window (see figure below) you will be able to set up analyses 
that will be automatically created when a new instance of the corresponding element 
is added to the AF structure.  

First, enter a name and a meaningful description for the analysis (e.g OEE Metrics), 
and then select the expression analysis type using the radio buttons.  

 

Note: We have selected to enable the analysis right-away when it is created from the template. 
Uncheck the option if you are not confident that your analysis does the right calculation. The 
analyses can be started at a later time for the related elements. 
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Entering an Expression  

The next step is to enter the expression, which is the equation that will be executed. 
An expression can be written in a single row or multiple rows. Asset analytics allows 
you to assign the result of a row to a variable; this variable can be used later in 
another row. 

Tip: Take advantage of the variables to simplify complicated expressions; testing and 
debugging will be much easier since you will be able to evaluate smaller expressions one at a 
time. 

Let us use the first row to calculate the OEE availability. Start by giving a name to the 
variable, for example Availability. The pane on the right lists descriptions of all 
available functions that you can use to build your equation.  

How can we get the time the press was running today? 

 ___________________________________________________.  

 

In what way will the time be returned? 

___________________________________________________.  

 

Let us assume the press should run all time. How can we get the number of seconds 
until now since midnight? 

___________________________________________________.  

 

The ratio between these two times will be in range 0…1.  
To assign the appropriate engineering unit, use the function Convert.   

Note: The Convert function converts a value from its current unit of measure (UOM) to a 
specified UOM. For a value with no UOM, assign the specified UOM.  
 
Example:  
Convert ('Outside Air Temperature', "degC") 
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So the complete expression is: 

Convert(TimeEq('Press Status','t','*',"Running")/DaySec('*'),"ratio") 

 

Here are some tips concerning entry of expressions: 

• Tip1: Auto completion (aka. IntelliSense) is available to assist you with the 
syntax. 
 

• Tip2: If you enter something that is syntactically incorrect, a curly underline 
will occur: 

 

• Tip3: If you click on Functions in the right hand side, the pane will list all 
available functions. The drop-down on the top allow to filter function groups 
(e.g. Date and Time). Select a function and click on the green Plus icon to 
add it into the expression (you don’t have to type it) 
 

 
 
 

• Tip4: You can add comments to explain what you are doing. Comments start 
with two forward slashes (//). To start a new line use Shift-Enter.  
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• Tip5: If you click on Attributes in the right hand side, the pane will list all 
available attributes. The upper part allows to navigate in the asset tree. 
Select an attribute and click on either one of the green Plus icons to add it 
into the expression (you don’t have to type it) 
 

 
 

  Insert Relative: 
 
The attribute is inserted without the path in the element tree: 
This refers to the attribute in its actual element context. 
 

   Insert Absolute: 
 
The attribute is inserted along with the absolute element path. This refers to 
the attribute in the specified element path.  
 
You can pick attributes from other elements by navigating in the asset tree 
shown above. An example for use of an absolute path is when the attribute 
has a general meaning, e.g. the outside air temperature at a location:   
'\Houston|OutsideAirTemperature' 
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Mapping the output to an attribute 

The output of an expression can be mapped to either an existing or a new attribute. In 
order to map it to an existing attribute click to Map and select the corresponding 
attribute. We will be mapping the result of the availability calculation to a new attribute, 
so select New Attribute Template, which will open the Attribute Template Properties 
window. Set the name to OEE Availability. 

 

 

Switch to the Attributes Templates tab and select the OEE Availability attribute. Set 
Default UOM to percent. Assign a new attribute category OEE Metrics. Under Settings, 
you can now select a PI Point as an output. If an appropriate PI Point does not exist, 
you can enable automatic point creation; simply check the Tag Creation checkbox 
under Settings. 

Tip:  In case the output attribute’s data reference is a point, calculation results will be stored in 
the Data Archive; therefore you will be able to trend them in PI Vision or PI ProcessBook. 
Moreover, points also provide improved performance for AF. 

 

Note: When automatic tag creation is enabled, you can use substitution parameters to name the 
points. %Element%.%Attribute%.%ID% is the default for asset analytics output points. 
Substitution parameters will be presented later in the class.  
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Scheduling an expression 

Now that the calculation has been written, it is time to schedule it. Two scheduling 
options are available: periodic and event-triggered.  

• Event-triggered scheduling is event driven: the calculation is executed 
whenever one or multiple input attributes receive a new value. You get to 
choose which input attributes trigger the calculation.  

• Periodic scheduling is clock-based and in the configuration window, you can 
specify a period and an offset. Let us schedule the OEE calculations to be 
executed every minute (00h 01m 00s). 
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Testing an expression 

Now that the calculation has been written and the scheduling is defined, it is time to 
test it. The Evaluate button executes the expressions against values at evaluation (i.e. 
now) and against values at Last Trigger (in our case when the current minute has 
started). This will help you determine whether the results makes sense. Since we are 
working from a template, you will have to click on Example Element before you can 
test the expression.   

 

 

Another great way to validate your expression is to run it against archived values; we 
call this feature “preview results”. Right click the analysis name and select Preview 
Results (see screenshot below). 

Tip: You can export the results table to a spreadsheet or you can copy selected rows from the 
results table into other applications. 
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Checking in an Expression 

To the left of the analysis name the following icon is showing . This indicates that 
the analysis has been modified and it needs to be checked-in for the changes to take 

effect. Go ahead and click on . 

Upon Check In, the Analysis Service will create the points for the output attribute and 
start the analyses for all presses. 

If you go to the Elements plugin and navigate to one of the presses you will notice 
under the Attributes tab that the analysis’ output attribute (OEE Availability) is referring 
to a tag that has been created based on the settings in the template. In case the 
attribute value is “Pt Created” click on the Refresh button (after the full minute has 
elapsed) so you get a calculated value. In case the attribute would be showing “PI 
Point not found”, select Create or Update PI Point. 

Tip: By right clicking the parent element (i.e. Montreal) and selecting Create or Update Data 
Reference, PI Points for all presses will be created; so you do not have to do it one by one. 

 

Managing Analyses (Start, Stop, Backfill) 

The Analyses tab allows you to manage the analysis. You can even create new 
analyses for a particular element, however, as we said before, we recommend using 
analysis templates.  

Analyses should start-up automatically unless there is an error with the configuration. 

You can use the play ( ) and stop ( ) buttons to either start or stop an analysis. 
Below a screenshot of the management analysis pane. 
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An analysis can be in one of several states. The icon to the left of the analysis name 
indicates its status. See the table below for the meaning of each icon. 

Icon Meaning 

 

New analysis 

 
Starting or stopping 

 

Running 

 

Disabled 

 
Error 

 

Warning 

 

Unknown status 

 

Since the analysis has been started, the OEE Availability attribute should now be 
showing results. You may have to wait for a few minutes or refresh the screen to see 
updates. 
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6.4.6 Exercise – OEE Metrics – Performance and Quality 

 

This solo or group exercise is designed to maximize learning in a specific 
topic area. Your instructor will have instructions and will coach you if you 
need assistance during the exercise.  

Exercise Objectives 

• Create and schedule an expression analysis. 

Problem Description 

Create analyses to calculate the remaining two OEE metrics: performance and 
quality. After doing this you will be able to compute the OEE score. 

Approach 

Using the analysis template you just created (OEE Metrics), add two more expressions 
to calculate the quality and performance metrics.  

 

Quality 

The quality is calculated as net production of good items / net production count. The 
total number of tires produced on the day (this includes the scrap tires) is tracked 
under Tires Produced, the daily bad quality items are tracked under the Scrap Tires 
attribute. 

Expression: 

___________________________________________________________________. 

 

Performance  

Performance is calculated as the net production count / expected production count. 
The daily production count is tracked via the AF Attribute Tires Produced; the 
production target is expressed in tires/hour under the AF attribute Production Target. 

Hint: Since the production target is expressed in tires/hour, you will have to find the 
expected production count by multiplying the Production Target by the number of 
hours elapsed during the current day. 

Useful functions: hour(‘*’) and minute(‘*’) 

Expression: 

___________________________________________________________________. 
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OEE Score 

Calculated as the product of Availability*Performance*Quality. Expression: 

___________________________________________________________________. 

Tip: Every variable of an expression can be mapped to an output attribute.  

 

6.4.7 Backfilling/Recalculation 

An analysis writes new data to its output attributes starting from the moment it is 
created. It is however also possible to calculate the data for past periods of time. 
There are two related options for that, which control how existing data should be 
handled. 

Example: you create a new analysis on March, 1st 2017 to calculate the heat energy 
consumption, which is added from various sources. The designated output attribute 
with the total consumption will have values for the time from that date onwards. To 
get values for January and February 2017 as well you can use the backfill feature. 

 

The two options are: 

1. Leave existing data and fill gaps: existing data is retained and only 
missing data is back filled. 

2. Permanently delete existing data and recalculate: existing data will be 
deleted before the new data are backfilled. 

Notes:  

• The option for existing data handling is new with AF 2016 R2. In previous AF 
versions data were never deleted. This had to be carried out manually before 
the backfill. 

• Backfilling/recalculation requires that the output attributes have been mapped 
to PI Points. 

• Backfilled data is added into the archive files. With PI Data Archive versions 
before 2012 an upfront intervention could be required to make backfilling to 
work properly (e.g. PI archives reprocessing) 

• For an event-frame-generation analysis, data is automatically deleted and 
recalculated (which is the only mode allowed). Be aware that annotations on 
those event frames will be lost. 
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6.4.8 Directed Activity -  Backfilling OEE Metrics 

 

In this part of the class, you will perform a learning activity to 
explore the different concepts presented in this chapter or section. 
You may be invited to watch what the instructor is doing or perform 
the same steps at the same time. Your instructor will have 
directions. 

Activity Objectives 

• Learn how to backfill a calculation. 

• Get familiar with the Analyses plug-in and perform some administration tasks. 

Problem Description 

Management is very happy seeing real-time updates for the OEE score so they want 
more details. They have asked you to trend the OEE score for the last week for all 
presses belonging to the Houston site where they recently acquired innovative 
technology. 

Approach 

First, make sure that the OEE Metrics analyses are running and showing no errors. 
In order to do this, you can take advantage of the 
Management plugin under the Navigator pane. 

 

 

 

 

 

 

To backfill an analysis, one option is to browse to the corresponding element and 
then right click the desired analysis and select Backfill/Recalculate. 
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However, since we want to backfill an analysis belonging to multiple elements, it 
would take too many clicks to complete this task element by element. The Analyses 
plug-in offers the possibility to perform backfills in bulk. All you need to do is select 
the analyses, click on Queue backfilling for selected analyses under the Operations 
pane. Next, enter the start time and end time then hit Queue. 

 

 

6.4.9 Improving analyses for robustness and readability 

We have seen how to write an analysis to calculate OEE KPIs. There are some 
options to make the calculations more robust and improve readability. The following 
screenshot provides an example how to avoid divisions by zero and how to distribute 
the calculation into more steps to achieve that.  
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The following two articles provide more related information : 

 
Tips and Tricks for Asset Based Analytics 
https://pisquare.osisoft.com/community/all-things-pi/af-library/blog/2016/08/30/tips-and-
tricks-for-asset-based-analytics 

 

KB01520 - Asset Analytics Tips and Tricks 
https://techsupport.osisoft.com/Troubleshooting/KB/KB01520 
 
 

6.5 The Rollup Analysis 

The rollup analysis allows you to perform aggregations or summary calculations 
based on attributes associated with an element. The power of rollup analyses lies in 
their ability to perform aggregations on an element’s children.  

As an example, you might need to calculate the total energy consumption for a group 
of motors in a paper mill. To do this, you create a rollup analysis on the parent 
element (the paper mill) that sums the energy consumption attributes from its child 
elements the motors. 

When designing and building a AF hierarchy, the use of categories is going to pay off 
when you start using the rollup analysis type. This is because when configuring a 
rollup analysis, the attributes to be included in the calculation are selected by name 
or category. 

6.5.1 Directed Activity – Comparing Sites using Rollups 

 

In this part of the class you will perform a learning activity to explore the 
different concepts presented in this chapter or section. You may be invited 
to watch what the instructor is doing or perform the same steps at the same 
time. Your instructor will have directions. 

Activity Objectives 

• Configure and test a roll-up calculation. 

 

Problem Description 

Management of our fictitious tire company would like to start comparing the 
performance of the tire presses across all sites in the organization; the first metric 
they would like you to develop is the total production of good tires. 
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Approach 

Each press has an attribute for the current day’s total production and another one for 
the current day’s scrap tires; however, no attribute holds the count of good tires 
produced, so you will have to come up with one.  

Let us start by creating the Good tires production counter attribute. Since you do not 
want to archive the results of this intermediate calculation, you can use a AF Formula 
Data Reference. 

Under the press template, add the new attribute and calculate the difference 
between the Tired produced (represents the total production) and the Scrap tires. 
This new attribute should belong to the production category. 
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Creating a roll-up analysis 

Now it is time to shift focus to the parent elements, the sites. Select the Houston site 
and go to the Analysis tab, give a meaningful name to your analysis and select the 
Rollup analysis type. 

 

A list of all available attributes is displayed on the right pane. It is now necessary to 
select from that list the ones that will participate in the rollup calculation. You can 
narrow down your search by filtering by element category or template. You can then 
type-in the attribute name or category. The matching results will show a checkmark (

). 

Note: A rollup identifies input attributes each time it is executed, hence it automatically includes 
any new attributes that meets the selection criteria. You do not need to update the rollup 
configuration when you create a new element. 
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Selecting the roll up function  

Now that you have selected the attributes for the rollup, it is time to specify the 
function or type of summary calculation the rollup analysis will run. There are six 
available summary functions: 

• Sum 

• Average 

• Minimum 

• Maximum 

• Count 

• Median 

Since we want to calculate the total number to tires produced on a particular site, the 
summary function to select is Sum. 

Tip: You can select multiple functions in a rollup calculation, each one mapped to a specific 
output attribute. 

Mapping the output to an attribute 

Once the function is selected, you can map the output to an attribute. In case the 
output attribute does not exist yet, you will be prompted to create a new one. Let us 
create a new output attribute and name it Total Good Production. 
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Scheduling the roll-up calculation 

Finally, it is time to schedule the calculation. The same two scheduling options 
presented for the expression analysis type are available for rollups: event-triggered 
and periodic. For this exercise, it makes sense to update the result every time a new 
good tire is produced, hence, select event-triggered scheduling. 

Tip: Before starting the analysis it is a good idea to click on the evaluate button to preview the 
result. Furthermore, you can right-click on the analysis name and select Preview Results; this 
will show you a trend with the result of the calculation had it run for a previous period of time. 
These two actions will help you validate your rollup calculation. 

 

The calculation is ready to be started! Check-In your changes. 

Note: If the PI point of the Total Good Production attribute is not created use Create or Update 
PI Point function from the attributes right-mouse button context menu.  

Check the status of the calculation for any errors and validate that the output 
attribute is updating. 
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6.5.2 Group Question – One Site, Multiple Sites 

 

The following questions are intended to reinforce key information, or to 
discover a new insight. Your instructor may choose to have you try to 
answer the questions on your own or have the group answer them together 
out loud. 

Objectives 

• Convert an analysis to an analysis template. 

Questions 

The rollup calculation has been deployed to the Houston site only. What feature of AF 
can you use to deploy it to the remaining sites? ____________________ 

What steps would you take to achieve this? 

 

1. ____________________________________________________________. 

Note1: In the Convert Attribute to Template dialog box, enable the Include Tag 
Creation checkbox. This is needed because no tags have yet been created to store the 
results of the Analysis. 

Note2: set the PI Point naming pattern for Total Good Tires Produced attribute to 
follow the default pattern, which is %Element%.%Attribute%.%ID% 

 

2. ____________________________________________________________. 

 

Bonus Question 

How to display the three (3) Total Good Production Counters in one list? 

____________________________________________________________. 
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6.5.3 Exercise – Perform an advanced attribute search (optional) 

 

This solo or group activity is designed to maximize learning in a 
specific topic area. Your instructor will have instructions and will 
coach you if you need assistance during the activity. 

Exercise Objectives 

• You have recently created attributes in several places of your asset hierarchy 
that contain the string “Good”. Use the attribute search to get all their values 
in one list. 

Approach 

1. From the PSE menu, select Search – Attribute Search… 

2. Enter *Good* into the attribute name field. Make sure the Search Sub-
Elements option is selected. Click Search. Result: attributes containing string 
“Good” are returned. Click on OK. 

 

 

 

3. Click on the name of the Search to populate the Search Results at the right 
hand side. 
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6.6 Visualizing Calculation Results in PI Vision 

6.6.1 Directed Activity – Visualize OEE Metric calculation results 

 

In this part of the class, you will perform a learning activity to explore the 
different concepts presented in this chapter or section. You may be invited to 
watch what the instructor is doing or perform the same steps at the same time. 
Your instructor will have directions. 

Activity Objectives 

• Duplicate an existing PI Vision display for the tire presses  

• Visualize the OEE Metric calculation results. 

Approach 

Save the existing PI Vision display for PI Big Tire Presses under another name. 

Add Good Tire Production Counter into the existing trend. 

Add a trend for the OEE Metrics 

 

Duplicate a PI Vision Display 

1. From the PI Vision overview page, open the Big Tires Press display.  

2. Click the dropdown link in the upper right corner to open the Save As menu. 

 

3. Enter Big Tires Press Training as display name and click on Save. 

Note: If you have added a database in AF and would like to access with PI Vision, you have to 
update the list of allowed AF Databases in PI Vision. For more information see Visualizing AF 
Data in PI Vision above). 

 

Add data into a trend 

1. Switch to Modify Display operation: 
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2. In the Assets pane, navigate to HOU.Press.01 

 

 

3. From the Attributes pane, drag the Good Tires attributes into the trend with 
the Tires Produced counter. 

4. Configure the trend to have just a single scale. 

 

 

Add a trend for OEE Metrics 

1. Verify that trend has been selected in the symbol gallery. 

 

 

2. From the Attributes list, select the OEE Metric category and drag it into the 
display canvas. 
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7. Tracking Important Events 

Events are important process or business time periods that represent something 
happening that affects your operations. In the PI System, events are known as event 
frames. Thanks to Event Frames, you can analyze your PI data in the context of 
these events rather than by continuous time periods. Instead of searching by time, 
Event Frames enables users to easily search the PI System for the events they are 
trying to analyze or report on. 

With Event Frames, the PI System helps you capture, store, find, compare and 
analyze the important events and their related data.   

Event Frames represent occurrences in your process that you want to know about, 
for example: 

• Downtime tracking • Environmental monitoring 
excursions  

• Process excursions • Product tracking batches 

• Equipment startups and 
shut downs 

• Operator shifts 

 

The following table presents some of the features and advantages of Event Frames: 

Flexibility 

✓ Reference multiple elements within the 
same event.  

✓ Support multiple overlapping events on a 
AF element.  

✓ Capture any event; a “batch” is just one 
type of capturable event. 

Powerful search  

✓ Search by time range, type of event or 
event frame attribute. 

✓ Most common search attributes can be 
configures as indexed attributes to speed 
up end-user searches 

Scalability ✓ Event Frames are extremely scalable. 

 

A  Event Frame is defined by three characteristics: 

1. Name. 

2. Start time and end time: defines the event’s time range. 

3. Context: event attributes and related assets. 



Tracking Important Events 

 

Page 139 

 

7.1 Tracking Production Downtime Periods  

7.1.1 Directed Activity  - Downtime Tracking 

 

In this part of the class you will perform a learning activity to 
explore the different concepts presented in this chapter or section. 
You may be invited to watch what the instructor is doing or perform 
the same steps at the same time. Your instructor will have 
directions. 

Activity Objectives 

• Create an event frame template. 

• Configure an event frame trigger. 

 

Problem Description 

PI Big Tires Co. has been falling behind their production schedule because, for 
various reasons, the tires presses are frequently down. To improve the situation they 
want to use Event Frames in AF to track the downtime periods for all their presses in 
Houston, Montreal and Philadelphia.   

 

The Maintenance engineer has asked you to trace the root cause for every 
downtime. The curing press can be in one of five states, which have different 
criticality.  

 

 

They want to have a record of the investigations performed by the maintenance 
team. Therefore it should be possible to acknowledge and save individual comments 
for each Downtime Event Frame.    
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Approach 

1. For the first press in Houston, inspect the history of the Press Status value 
and create one event frame manually. Set the name, the Start and End Time, 
and the element reference. Define an event frame attribute to track the Press 
Status value at the beginning of the downtime (i.e. the reason code of the 
problem).  

2. Create a corresponding event frame template (convert the event frame 
created in the previous step into a template). 

3. Define a naming pattern for new event frames from that event frame 
template.   

4. Add an analysis for the first press in Houston that monitors the Press Status. 
Distinguish the different Press Status values and associate them with 
corresponding severities. 

5. Use an Output Expression to get and store the event frame duration to ease 
future analysis of the event frame data with Excel Power Pivot. 

6. Preview the analysis to assess whether the triggers were set correctly.  

7. Start the analysis. 

8. Backfill the analysis for the time since midnight today. 

9. Include the analysis into the press template to apply the analysis to all 
presses. 

10. Backfill the analyses for all presses for the time since midnight today. 

 

The instructor will show these steps and ask you to follow along in directed activities. 
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7.1.2 Manual Event Frame Generation 

To begin with, we will create a single event frame manually to have an example of 
what we would like to capture for the period of a press downtime. 

To begin with, let us identify a downtime period for the first press in Houston, 
HOU.Press.01, based on the Press Status values.  

1. Select Elements from the navigator panel and select Attributes tab for 
HOU.Press.01. 

2. Select the line for Press Status. Select Time Series Data… from the right-
mouse button context menu and display the values for the last two hours. 

3. Identify a period, when there was a downtime. It starts with a value that is 
different from Running and ends with a value of Running again. In our case 
below, the press was not running after 1:22:05 PM because of Planned 
Maintenance, and was not running again before 1:35:05 PM because of 
another Maintenance.  
 

 
 
Fill in the information for your case in the table below and close the window. 
 

 Example above: Your case: 

Start Time 13:22:05  

End Time 13:35:05  

Time in seconds 780  

Reason  
for the downtime 

Planned Maintenance  
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4. Select Event Frames from the navigator panel and click on the 

button. Select <none> for Event Frame Template. 

5. For name, enter Downtime Sample Period for HOU.Press.01. Enter Start 
and End Times in hh:mm:ss. As you do not specify a date, PSE will assume it 
is for today. 
 

 
 

6. On the Referenced Elements tab, select the blue Add Element Reference 

link, click on the  button in the Single section. 

7. In the Element Browser navigate to Houston -> HOU.Press.01 and click on 
OK. 
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Event Frame Attribute for the Downtime Reason Code 

8. Let us track the reason, why the press had a downtime. It is the value of the 
Press Status attribute at the start of the problem.  
On the Attributes tab, click on the blue New Attribute link. For the attribute 
name, enter Reason Code. For value type, select Press Status from 
enumeration sets. For Data Reference select PI Point. Click on Settings.  

9. The dropdown offers the attributes of HOU.Press.01, select 
.\Elements[.]|Press Status. For By Time Range select Start Time. Click on 
OK. 
 

 
 
You will get the Press Status value for the beginning of the event frame 
period as it has been recorded before.  
Note: If the value type was reset, switch it back to Press Status. 

Event Frame Attributes 
 
The generic format for attributes of event frames is .\Elements[.]|Attribute. 

The attribute reference starts with .\Elements[.]| to indicate the primary element of the 
event frame's Elements collection. .\ is the current reference, [.] is the default object of 
the collection. The pipe character (|) is used to separate the element from the attribute 
name.  
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Create a new Event Frame template based on our manually created event 
frame. 

Now, that we have defined what we would like to record for press downtimes, let us 
make a template out of it. 

1.  your changes 

2. Select the event frame you created, and from the right mouse button menu, 
select Convert > Convert To Template. 

 

 

 

3. For the Reason Code, keep  
.\Elements[.]|Press Status;TimeRangeMethod=StartTime 
Click on OK. 
 

4.  your changes 
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7.1.3 Finalize the event frame template 

Let us have a look at the event frame template that has been created and adjust and 
finalize it. 

1. Select Library from the navigator panel and expand the structure Templates > 
Event Frame Templates and select Downtime Sample Period for 
HOU.Press.01Template. Rename to Press Downtime. 

2. The Naming Pattern field enables you to dynamically build the name of the 
event frames produced from the template so that each event frame will have 

a unique, identifiable name. Use the arrow on the right ( ) for a list of 
available substitution parameters. The most common ones are presented in 
the following table: 
 

%ELEMENT% Referenced element. Asset 
where the event happened. 

%..\ELEMENT% Name of the parent element of 
the referenced element. To 
retrieve further ancestors, use the 
..\ notation, such as 

%..\..\Element%. 

%TEMPLATE%  Name of the event frame 
template. 

%STARTTIME:yyyy-
MM-dd 
HH:mm:ss.fff% 

Event start time and format. 

 

3. What naming pattern should we set so the downtime events are called 
something like the following? 
 
DownTime HOU.Press.01 (Houston) 2015-12-24 23:22:21 
 
_________________________________________________________ 
 

Note: In case the Naming Pattern field is not set, event frames created with asset analytics 
will be named NameOfTheAnalysis – Starttime (i.e. Press Downtime – 20140725 11:20:00). 

4. To track, whether the event frames was read by an operator, enable the 

option 
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5. Open the Attribute Templates tab. The Reason Code attribute we have 
defined before is listed here. 

6. Add an Event Duration attribute (default UOM: second, value type: Int32). 
The attribute value will be set by the analysis, which we will create in the next 
step. 

7. Producing one tire takes approximately 5 minutes. Based on the duration of 
the press downtime the number of tires can be calculated that could have 
been produced in case the press would have been running. 
Add a Production Loss attribute (default UOM: tires, value type: Double), 
set Data Reference to Formula. To get the amount of production loss, divide 
the duration in seconds by 300: 

 

 

8. Check in the changes. 
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7.1.4 Creating an EF Generation Analysis 

Let us create an EF generation analysis to track the downtime events in our curing 
presses. Create it directly under Houston’s press1. Once we validate that this is 
working fine we will convert the analysis into a template for deployment to all the 
presses in our company.  

Event frame analyses are configured in a similar way to expressions and rollup 
analyses. Browse to Houston’s press1 and under the Analyses tab select Event 
Frame Generation. Give a meaningful name and description to your analysis. 

An event frame analysis is based on an event frame template, go ahead and select 
the template from the dropdown list. 

Tip: Before you create an EF generation analysis, be sure an event frame template is available 
for it. 
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Triggering Conditions (Start Trigger Only) 

It is time to enter the conditions that will trigger the start and end event: StartTrigger 
and EndTrigger. These conditions are entered as expressions using the PE syntax 
presented earlier. 

When a single condition triggers both the start and the end of an event frame, only 
the StartTrigger expression is needed. When the expression evaluates to TRUE the 
event frame is started, and when it evaluates to FALSE the event frame is closed. 
For example a tank’s level rising above a threshold might start an overflow event, the 
event would end when level is below the threshold. 

 

 

Triggering Conditions (Start and End Trigger) 

You can specify an EndTrigger expression when the start and end conditions are 
different: 

 

 

In the case with Start and End Triggers, the end of the event is dependent on the 
End Trigger condition only. So after the event has started, the event ends when the 
End Trigger becomes true, independent from whether the Start Trigger is True or 
False. 
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Tip: If using start and end triggers, make sure the expressions never evaluate to TRUE at the 
same time since this may lead to event frames with zero second durations. Try to configure your 
event frames to use only a StartTrigger expression. 

For example, if the temperature rises in your reactor the foam level rises accordingly. 
When the temperature drops again, the foam level drops as well, but with some 
delay in time.  
You would like to capture the time, when temperature is too high until foam level is 
back to normal: 
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Defining Triggering Condition for the Press Downtime 

Since AF 2016 it is possible to define several start trigger conditions and associate 
them with different event frame severities. This meets our requirement to have event 
frames with different severity based on the reason why the press was down. Let us 
look at the first situation, when the press stopped running because of a Planned 
maintenance or a Press set-up. 

The expression to start the event in that case is:  

_________________________________________________________.  

Assign an Information severity level. 

 

To enter start and end triggers, click on blue Add… link and select 
corresponding option from the dropdown. 

 

 

Enter the start and end trigger expressions and assign the severity levels as follows: 

 

Tip: Use the StartTrigger True for option to require the start trigger remain true for a set time 
interval before creating the event frame. This is useful for attributes with continuous, non-
stepped data to prevent spikes in the input data from generating unwanted event frames.  
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Store the duration in the corresponding event frame attribute 

 

Since AF 2017 R2 there is an EventFrame function, which 
allows to get event frame properties such as the event frame 
duration in an easy way.  

 

 

To store the event frame duration in the Event Duration 
attribute of the event frame: 

1. To enter an output expression, click on blue Add… link on top of the triggers 
section and select Output Expression option from the dropdown. 

2. For the expression, enter EventFrame("Duration") 

3. Click on the blue Map link at the right hand side, and select the Event 
Duration attribute. 

 

 
 

Scheduling an Event Frame Analysis 

The last thing to do is to schedule the event frame analysis. As with expressions and 
rollups, two scheduling options are available: Event-Trigger and Periodic. For this 
exercise, schedule it as Event-Triggered. 

7.1.5 Previewing Event Frame analysis results and starting the analysis 

You can now use the Preview Feature to validate whether the events that would be 
generated are as expected. Select the Downtime analysis in the list of analyses. 
From the right mouse context menu, select Preview Results. 

 

If the results are OK, click on   changes. Result: the analysis will start 
running: 
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7.1.6 Backfilling Event Frame analysis 

The analysis we have created will monitor the Press Status from now on. However, 
with the Backfill function of analysis, it is possible to also backfill past periods in time! 
This means that the archived values for Press Status will be examined and event 
frames with dates in the past will be created accordingly. 

To backfill the time since midnight: 

1. Select the Downtime analysis in the list of analyses. From the right mouse 
context menu, select Backfill/Recalculate. 

 

 

2. For Start Time, enter a t (=today midnight), for End Time enter a * (=now). 
Click on Start button. The Backfilling column will show the progress of the 
backfill activity. 

 

 

 

3. After backfilling is completed, switch to the General tab and click on the blue 
Event Frames link. You will get a list with all event frames linked with that 
element. 

4. (optional) Verification: what is the start time of the first event frame?  

5. (optional) Scroll through the list and locate the manually created event frame. 
There will be a further corresponding event frame with same start and end 
time that was created by the analysis. Select the manually created event 
frame and select Delete… from the right mouse button context menu. This 
event frame is not required any more. 
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7.1.7 Converting an Analysis into a Template 

It is very common that customers create and test an analysis directly on an element 
(e.g. Houston’s Press01) before adding it to a template (e.g. Press template). 
Analyses can be added to a template so you do not need to configure them once 
again at the template level. Just right click the analysis and select Convert to 
Template as seen in the figure below. Then check-in. 

Note: Convert to Template does not create an element template; it just adds an analysis to an 
already existing one. 

 

 

 

Note: The analysis will be added to all assets created from the element template. Analyses will 
be started automatically after the Check-in. 
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7.1.8 Exercise – Backfilling Event Frames 

 

This solo or group exercise is designed to maximize learning in a specific 
topic area. Your instructor will have instructions and will coach you if you 
need assistance during the exercise.  

Exercise Objectives 

• Define and save a search that returns the downtime analyses for all presses. 

• Backfill the analyses in bulk. 

• Understand the backfill options. 

Problem Description 

Downtime events are now being tracked in real time for all presses in our company. 
Management does not want to wait for new events to start analyzing the causes of 
production loss; they want you to create the event frames for all presses since today 
midnight. 

 

Approach 

 

Use the Management plugin in the Navigator Panel  
to backfill multiple event frames.  

Initially, all analyses in that AF database will be listed. 

 

 

To work with a specific set of analyses (all the downtime analyses for all presses), 
you can define and save a search that will filter just those analyses: 

1. Click on the green  sign to add a new search: 

 

2. For the search name, enter Press Downtime Analyses and select Template 
under the Add Criteria dropdown. 

3. From the Template dropdown, select Press Template\Downtime and click on 
OK. Result: the list of analyses on the right hand side lists twelve analyses 
(four from each location). 
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To perform a backfill for all Presses: 

 

1. Click on the checkbox on top of the list to select all presses. 

 

 

2. Click on blue Backfill/Recalculate 12 selected analyses link. Acknowledge 
that existing event frames in the time range will be deleted, then click on 
Queue button. 

 

 

 

Note with regard to the required acknowledgement: For an event-frame-generation analysis 
(different to the backfill case in context with non event-frame-generation analyses), data is 
automatically deleted and recalculated. This is the only mode allowed. Be aware that 
annotations on those event frames will be lost. 
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Automatic Recalculation: (AF 2017 R2 and later)   

In case you expect that data from your inputs will be late-arriving or be out-of-order, you can 
request automatic recalculation for an analysis. The Management list allows to set this option for 
multiple analyses within one command. To set the option on an individual analysis base, use 
Advanced Options on the Analyses tab of an element or an element template.   
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7.2 Consuming Event Frames 

Event Frames are stored in the AF Server. Visualization clients, such as PI Vision 
and PI Datalink access the AF Server to retrieve the events and their related data 
providing you with powerful tools to analyze important events. 

Note: PI ProcessBook, PI BatchView, and PI Manual Logger do not support event frame 
visualization. 

7.2.1 Event Frames in PSE 

In this section, we will be exploring how to consume event frames in PI System 
Explorer (PSE). As an administrator, you can use PSE to search for events and 
analyze them. The results are presented in a practical table format that features a 
Gantt chart and columns for the attributes. Moreover, this is a quick way of verifying 
the creation of event frames.  

In order to access event frames in PSE, click on the Event Frames plugin under the 
navigator panel. 

Note: Unlike elements, it is not possible to browse events. You actually have to search for them. 

The following screenshot presents the main features of the Event Frames plugin: 
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Event Frame Search Results 

Event frames are listed with their information such as the event frame name, a Gantt 
diagram, the event duration, the severity, and the start and end time: 

 

 

 

Displaying the Event Frame attributes 

By default, the event attributes are not displayed in the result window.  

By right-clicking and selecting Column Visibility, you will be able to choose the 
attributes you want to display.  

 

 

Tip: To change the column visibility you can also click on the Settings icon  in the header 
row of the search results. 
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Column 
(Meaning) 

Column 
(Header Icon) 

EF Row 
Information 

Meaning 

Is Template 

  

Hover with the mouse over this column 
to get the event frame template. 

<empty> Event frame is not based on an event 
frame template. 

Is Locked 

 
 

Captured Values: values for the event 
frame attributes are saved in AF (see 
note below). 

<empty> Values for the event frame attributes are 
not saved in AF (see note below). 

Is Annotated 

 

 

Event Frame is annotated. Hover with 
the mouse over the icon to get the 
annotation(s). 
Use EF right mouse button menu option 
Annotate… to enter new annotations. 
 

<empty> Event Frame is not annotated. 
Use EF right mouse button menu option 
Annotate… to enter new annotations. 

Is Not 
Acknowledged   

Event Frame can be acknowledged. 
Use EF right mouse button menu option 
Acknowledge… to acknowledge the EF. 

 

Event Frame is acknowledged. 
Hover with the mouse over the icon to 
get acknowledgement info (by whom?, 
when?). 

<empty> Event Frame cannot be acknowledged. 
Whether an event frame can be 
acknowledged is defined in the 
corresponding event frame template 
(General tab)  

 

Note: You capture values to save the values for event frame attributes in a table in 
the PI AF database. This can improve performance since PI AF does not execute 
any data references. If you add new attributes to event frames with captured values, 
you should recapture those values to ensure that values are also captured for the 
new attributes. 
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7.2.2 Directed Activity - Downtime Event Frame Searches, Acknowledgement and 
Annotation 

 

In this part of the class, you will perform a learning activity to explore the 
different concepts presented in this chapter or section. You may be invited to 
watch what the instructor is doing or perform the same steps at the same time. 
Your instructor will have directions. 

Exercise Objectives 

• Familiarize yourself with the event frame search in PSE. 

• Acknowledge and annotate event frames. 

Problem Description 

You have AF analysis that will capture press downtimes.  

Due to a staffing issue in your plant, you want to get the details for any downtimes 
after 10PM yesterday triggered by a “No Operator” root cause so you can annotate 
the events, and acknowledge them. 

Approach 

Use the Event Frame Search window to perform the following: 

1. Select New Search from the right mouse button menu of the Event Frame 
search root. 

2. Enter following criteria: start time: y+22h, event frame template: Press 
Downtime, element name: Hou*, Reason Code= No Operator  ( you have to 
use Add Criteria to enter that) 

Hint: you can enter the criteria one by one and click on Search every time. If you enter 
more criteria, then you get less event frames that match your criteria. Click on OK when 
the returned event frames meet the desired scope. 

3. Rename your narrowed down search: Downtime Events No Operator after 
10PM yesterday 

Background: Once performed, your searches and their criteria are saved. Use Rename 
from the context menu of a search to assign a descriptive name for the search. To 
further refine an existing search, while keeping the existing search saved, select New 
Search from the context menu of the search and then modify the new one. 

4. Add columns for the Reason Code and the Event Duration attributes. Verify 
the Reason Code is No Operator in every case. 
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5. Select the first event frame and add annotation: “Bob was busy with 
representative from press manufacturer.” 

6. Select all event frames that started before midnight and acknowledge them in 
one action. 
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7.2.3 Exercise – Perform multiple Event Frame Searches with different criteria 

 

This solo or group exercise is designed to maximize learning in a specific topic 
area. Your instructor will have instructions and will coach you if you need 
assistance during the exercise. 

Exercise Objectives 

• Perform medium to advanced event frames searches. 

Problem Description 

Perform the following event frame searches in PSE: 

1. Find all downtime events for Montreal’s press2 for the last 12 hours. 

2. Add columns to show the Production Lost and Reason code. 

3. Narrow down your search to find events that lasted more than 10 minutes. 

4. Narrow down your search to find downtime events caused by Press set-up. 

Approach 

Use the Event Frame Search window to perform your searches. Make sure to add 
the necessary search criteria. 

 

 

. 
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7.2.4 Event Frame Reports in Excel with PI Datalink 

Explore versus Compare Events functions 

You can use PI Datalink (2014 or later) to import event frames from AF into Excel 
and then create reports for viewing and analyzing those events. Pivot tables and 
pivot charts are great Excel features for summarizing the data and getting better 
insight into event frames 

Under the PI Datalink ribbon in Excel you will find two functions (buttons) to import 
event frame data into Excel: The Explore Events function and the Compare Events 
function. 

The Explore Events function returns one event per row, which is useful to analyze 
events sharing the same EF template.  

 

Here: maximum temperature of event frame named Batch 1222 has been highlighted 
above in yellow (89.56). 

 

In case an event frame has child events, it is possible to also list child elements in 
further lines below the parent event. In the example below, there are nine child event 
frames (Material Add 1, Agitate, ,…):  
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Here: the maximum temperature of child event frames Material Add 1 and Agitate 
have been highlighted in green (12.45 and 13.08). 

 

The second function, Compare Events, allows you to compare hierarchical events, 
in other words, events with child events. The compare events function shows 
attributes from both the parent event and the child event(s). In the following example 
maximum temperature for the complete production batch as well as for the first child 
event frames Material Add 1 and Agitate is returned: 
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7.2.5 Directed Activity – Creating Downtime Event Frame Reports with PI Datalink 

 

In this part of the class, you will perform a learning activity to explore the 
different concepts presented in this chapter or section. You may be invited to 
watch what the instructor is doing or perform the same steps at the same time. 
Your instructor will have directions. 

Activity Objectives 

• Learn how to import event frame data into excel. 

 

Problem 

Management wants to answer the following questions about the downtime events: 

• What is the most offending cause of downtimes? 

• How much production are we losing because of downtime events? 

The best way to find an answer to these questions is by creating an Excel report 
which imports the event frames into an Excel spreadsheet. Excel offers some useful 
business intelligence tools that will help us aggregate the data so management can 
make decisions. 

 

Approach 

We will be using PI Datalink to import the event frame information and then use 
Excel PowerPivot and PowerChart to analyze the downtime events. 

 

Building the DownTime Analysis Report 

For this exercise, you will be using a template: Press DownTime Analysis.xlsx, 
located in the class\exercises folder. The template contains two sheets; we will be 
importing the event frames data into the Raw Data sheet, which will be read from the 
Report sheet via a pivot table and a pivot chart.  

Since we want to analyze the downtime events which are all based on 
the same EF template, we will be taking advantage of the Explore 
function in PI Datalink. Go to the Raw Data sheet, set the cursor into 
cell A2 and click on the Explore function in the PI Datalink ribbon 
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Configuring the Explore Events Function 

 

The Explore Events pane will show up. 
This pane offers several fields for you 
to refine your event frames search. 
Moreover, it features a results preview 
section.  

For the Search start and Search end 
fields point to the corresponding cells 
on the Report sheet (see figure).  

Keep * for event name and element 
name.  

 

Note: It is expected you will not get 
Event Frames that are not yet finished. 
To exclude Event Frames that are not 
finished, click on More Search Options 
and select entirely in range under the 
search mode.  

 

Select the seven columns to display; you can as well set the column order. The 
columns are actually the event frame attributes. The following columns are needed 
for the analysis:  

 

Make sure you selected Event Duration attribute (gives you the number of seconds), 
and not Duration (would give you the time in a format hh:mm:ss, such as e.g. 
0:06:30). 

Hit OK to display all event frame information in the Raw Data sheet.  
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Just by looking at this spreadsheet, it is very difficult to identify the most offending 
downtime cause or the production lost. By using an Excel tool, Pivot tables, we will 
be able to automatically extract, organize, and summarize the event frame data. 
PivotTables, and their graphical companions, Pivot Charts, are very versatile and 
easy to create. No formulas needed! 
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7.2.6 Directed Activity – Summarize Event Frame Data with Excel Pivot Chart functions 
(optional) 

 

In this part of the class, you will perform a learning activity to explore the 
different concepts presented in this chapter or section. You may be invited to 
watch what the instructor is doing or perform the same steps at the same time. 
Your instructor will have directions. 

Activity Objectives 

• Use Excel functionalities to summarize event frame information. 

 

Creating a PivotChart and a PivotTable 

Go to the Report sheet, select the Insert ribbon and select the PivotCharts option to  
create a PivotTable and a PivotChart. 

 

 

 

As input for the PivotTable select the cell range in 
the Raw Data sheet where the ExploreEvents 
function has returned the data (including the 
header line). 
Then choose to place the PivotTable and 
PivotChart in the Report sheet. 

Tip: if you want to correct the source area later in 
time, select all cells of your PivotTable (or choose 
the Analyse ribbon), then from the Analyse 
Ribbon, select Change Data Source.  
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The PivotChart field list should now be shown in your Excel worksheet and a range 
of the worksheet should be designated where the pivot table will be located, as 
shown below. 

 

 

 

Select the PivotTable, and review the PivotTable Field list. These fields come from 
the column names of the Raw Data sheet.   

To perform a downtime analysis for our Event Frames based on the corresponding 
reason code, select the Reason Code line and drag into the Values area. The 
applied Aggregation for the reason codes is COUNT, because these are non-
numeric values. Select the Reason Code line again and drag into the Rows area: 
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Select the Production Loss line and drag into the Values area. The aggregation 
applied for these numeric values is SUM. Your PIVOT table is extended by another 
row, which summarizes corresponding production losses, based on the reason 
codes: 

 

Tip1: if the PivotTable Fields pane was closed and you want to have it available again, select a 
cell of your PivotTable. From the right-mouse button menu, select Show Field List. 

Tip2: to change the aggregation that is applied to your data, select the dropdown icon on the 
field, and choose Value Field Settings… to select another aggregation type.  

 

Let us enhance our Pivot table for analysis depending on individual press 
selections.  

Which column of our data represents a press ? 

 

 

Select a cell in the Pivot table, and select the Analyze ribbon from the Pivot 
Table tools. Click on insert slicer, select primary element and click on OK.  
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The slicer for the primary element is added. It allows selecting any combination of 
one or more presses for our analysis. Check various combinations (use Shift- and 
Ctrl-key for selections in the slicer):  

• all presses 

• PHI. Press01 only 

• all “Number 01”- presses (i.e. HOU.Press.01, MTL.Press.01 and PHI. 
Press01) 

• all presses in Houston 

 

 

The PivotTable and the PivotChart will update to show you what reason code is 
causing most of the downtime events. In the screenshot above, it is clear that during 
the observed period of time, planned maintenance has caused most of the 
production losses for the Houston Presses. 
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7.3 Tracking Production Excursion Periods 

7.3.1 Group Exercise – Tracking a Controller out of Control 

 

This group exercise is designed to maximize learning in a specific topic 
area. Your instructor will have instructions, and will coach you if you need 
assistance during the exercise.  

Exercise Objectives 

• Review steps to create an event frame analysis, starting from the creation of 
the event frame template up to the analysis configuration and testing. 

Problem Description 

The process control team is concerned about the number of scrap tires and want to 
investigate the production conditions in more detail. They are asking for a list with 
those periods of time, when the internal temperature exceeds 25 C during the 
loading Phase and the lid has closed.  

In order for the process control team to start fixing the problem they’d like to keep 
track of these undesired events by monitoring how the internal temperature and 
pressure behaves for the rest of the cycle, until the press lid opens. Moreover, they 
care to know the maximum temperature and pressure during each of these events.  

It was observed that pressure and internal temperature behavior 3 minutes before 
the problem starts can provide them useful information to understand why there is an 
excursion from the normal production process.  

PI Big Tires company calls these events “Out of control events”. The event names 
should reference the concerned press, the start time and the kind of tires currently 
produced. Examples: 

OOC HOU.Press.02 2018-02-21 10:25:00 (Winter-Tire Production) 
OOC MTL.Press.02 2018-02-21 08:41:30 (Motorcycle-Tire Production) 

Approach 

As a group of 2 – 3 students, go through the table below to discuss common 
understanding of the steps required to monitor the tire production cycles and detect 
out-of-control situations. In an out-of-control situation the internal press temperature 
is too high during the Loading phase of the Press. 

Hint to get the kind of tires currently produced:  
Sine AF 2017 R2, the event frame naming pattern allows to use values from event frame 
attributes. If an event frame has an attribute called ProductType, %@ProductType% in the 
naming pattern will give you the value of that event frame attribute.   

Fill in the open positions in the table below.  
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Design event 
frame template 

Template Name 1. Naming Pattern: 

Attributes 
1. Name: ____________________. 

2. Name: ____________________. 

Attribute 
Configuration 

Attribute for Maximum Pressure: 

UOM: ______________________ 

DR Setting _________________________ 

Attribute for Maximum Temperature 

UOM: ______________________ 

DR Setting ___________________________ 

Attribute for Reference Type 

UOM: ______________________ 

DR Setting ___________________________ 

Create Event 
Frame Analysis 
on an element 

StartTrigger 
 

EndTrigger 
 

Scheduling  

Child Root Cause 
Event Frame 

 Generate child root cause event frame 

Testing  Evaluate   Preview Results 

Backfilling Backfill Last 24 hours 

Validating Event 
Frames via PSE 

Event Frame Search 
Define the Search Criteria to get the out-of-
control events for HOU.Press.01 for the last two 
hours. 

Event Frame 
Attributes 

Add attributes in the Event Frame Search results 
to get maximum Internal Temperature and 
Maximum Pressure 

Convert analysis 
to template 

Element template  Analysis in template. 

Analysis plugin 

 Analyses started 

 Analyses status 

 Backfill all presses (optional) 
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7.3.2 Directed Exercise: Review the Steps for Out Of Control Events  

 

The following information is provided to discuss your solutions with the 
instructor. You will also perform the steps in a directed activity.   

 

 

 

Design event 
frame template 

Template Name 

Naming Pattern:  
OOC %Element% 
%STARTTIME:yyyy-MM-dd HH:mm:ss% 
(%@Reference Type%-Tire Production) 

Enable the Can Be Acknowledged option. 

Attribute 1 

Name: Maximum Pressure 

UOM: PSI 

Data Reference Configuration:  
.\Elements[.]|Pressure; 
TimeRangeMethod=Maximum 

Attribute 2 

Name: Maximum Temperature 

UOM: ºC 

Data Reference Configuration:  
.\Elements[.]|Internal Temperature; 
TimeRangeMethod=Maximum 

Attribute 3 

Name: Reference Type 

UOM: <none> 

Value Type: Tire References 

Data Reference Configuration:  
.\Elements[.]|%Attribute%; 
TimeRangeMethod=StartTime 
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Create Event 
Frame Analysis 
on an element 

StartTrigger 
'Curing Phase'="Loading" and 'Internal 

Temperature'>25 and 'Lid Position'="Closed" 

EndTrigger 'Lid Position'="Open" 

Severity Critial 

Child Root Cause 
Event Frame 

 Generate child root cause event frame 

 

 

Scheduling Event –Triggered any input 

Testing  Evaluate   Preview Results 

Backfilling 

Backfill Last 24 hours, then verify the 
backfill status: 
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Validating Event 
Frames via PSE 

Event Frame 
Search and Event 
Frame Attributes 

Enter the following Search Criteria for 
Event Frame Search: 

1. Starting After *-4h 

2. Template= Out Of Control 

3. Element Name= HOU*1 

4. Uncheck All Descendants 
(otherwise the root cause events will also 
be returned in separate lines) 

Click on Search button. 

To display the event frame attributes, click 
on the  button to customize the columns 
for the Search results. Click on Select 
Attributes… Add Maximum Pressure, 
Maximum Temperature and Reference Type 

 

 

Click on OK. Rename the default name of the Search (Event Frame Search X) to 
OOC Houston Press 1 Last 4 hours. 

Record the start time and end time and the two maximum values for two selected 
event frames (do not select event frames that are not yet finished). In the next 
exercise, we will see how information for these Event Frames are presented in PI 
Vision.  

 

Convert analysis 
to template 

Element template  Analysis in template. 

Analysis plugin 

 Analyses started 

 Analyses status 

 Backfill all presses (optional) 
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7.4 Event Frames in PI Vision 

PI Vision discovers events related to assets on the display and it lists them in a 
dedicated Events tab. The time range and duration of the display determine for which 
period of time the events are listed. In case any event frames exist in that period, the 
icon for the event frames has a little blue dot on the top left edge. Click on the icon to 
switch from Assets pane display to Events pane display: 

 

 

 

Any event frame for the asset, where the start and/or the stop time falls into the time 
period is listed: 
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If you select one of the event frames and click the right mouse button, you have 
three options: 

 

Apply Time Range: 

Applies time range of the 
selected event to all symbols 
on the display.  

 

Event Details: 

Opens a dedicated screen to 
analyze, acknowledge and 
annotate events 

Compare Similar Events  
By Name / By Type: 

Opens another Browser tab to 
compare process data across 
multiple events on a single 
“overlay” trend. 

 

 

By Name When comparing events by name, the Event Comparison screen 
displays up to 11 events with the same name, Event Frame 
template, and referenced asset. 

By Type When comparing events by type, the Event Comparison screen 
displays up to 11 events based on the same Event Frame 
template and same referenced asset. 

 

When you change the time range for your display, the events list will be refreshed 
automatically. Uncheck button for Automatically refresh the list to avoid searches 
whenever you make a change for the time range of the display. 
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7.4.1 Directed Activity – Visualizing Events Using PI Vision 

 

In this part of the class, you will perform a learning activity to explore the 
different concepts presented in this chapter or section. You may be invited to 
watch what the instructor is doing or perform the same steps at the same time. 
Your instructor will have directions. 

Activity Objectives 

• Explore the process data for Houston.Press.01 during out-of-control periods  

• Analyse the out-of-control event details 

Approach 

• Switch the display time range to show data for several out-of-control periods. 

• Display the details of a particular out-of-control Event to get related asset 
information. 

 

Change the Display Time Range 

1. From the PI Vision overview page, open the Big Tires Press display. 

2. Switch to the Events list display  

3. To just get OOC events, edit search criteria and filter for event type = Out Of 
Control 

4. Set the time range to the last two hours: enter -2h into the field for the start 
time. The Now button on the left hand side should still be in green, so that the 
end time is current time. 
Because the time range is reduced from one day to two hours, the list of 
events will become smaller (Automatically refresh the list must be enabled). 
 

5. Select one of the out-of-control events and select Apply Time Range from the 
right mouse button menu. Display time range is adjusted to the time range of 
the event. Repeat for other events. 

 

 

Get Event Details 

1. From the right mouse button menu of a selected event, select Event Details. 

2. Explore related attributes for the Houston Press 01. Get minimum and 
maximum for the pressure and the internal temperature.   

3. Click on the Back control  to return to the Press display. 
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7.4.2 Directed Activity – Comparing Similar Events Using PI Vision 

 

In this part of the class, you will perform a learning activity to explore the 
different concepts presented in this chapter or section. You may be invited to 
watch what the instructor is doing or perform the same steps at the same time. 
Your instructor will have directions. 

Activity Objectives 

• Display process data from multiple events in one trend (overlay trend) for 
comparison 

• Use PI Vision functions to highlight particular event frames and to hide 
selected event frames for improved comparison experience. 

Approach 

Open a second browser tab for event comparison. 

Customize the display by highlighting and hiding event frames. 

 

1. If needed, adjust the time range so that you get the event frames you 
recorded before. Increase or decrease the start time (from -2h to -3h or to -
90m). When the time range is changed, the list of events will become smaller 
or greater (Automatically refresh the list must be enabled). 
The Now button on the left hand side should still be in green, so that the end 
time is current time. 

2. Select Compare Similar Events By Type  from the right mouse button menu. 
An additional browser tab will be added for the Event Comparison. 

Event Comparison can display data for up to 11 trends (including the one selected). 
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3. Select an event frame to hide it. Select an event frame and select Hide Event 
from the right mouse button menu to remove it from the display. (You can do 
that in the Events list pane or in the Gantt Chart pane)  

 

 
 

4. Remove all trends except Internal Temperature and Pressure.  

To remove a trends, click on the  icon.  
Add a trend for the Curing Phase. To add the trace, expand attribute structure 
below the HOU.Press.01 element and drag the Curing Phase attribute  
 

 
 

5. (optional) Save the display. 
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8. Taking Full Advantage of AF Functionalities 

8.1 AF Object Security 

Beginning with AF version 2.7, a security model similar to Data Archive security was 
implemented. This model relies on Windows integrated security for authentication, 
but provides its own authorization to AF objects using AF Identities and Mappings. 

In AF version 2.6 and before, permissions in AF were set based on Windows user and groups. 

8.1.1 AF Identities and Mappings 

An AF identity represents a set of access permissions on the AF server. 
Each AF mapping points from a Windows user or group to an AF identity.  

Built-In AF Identities are Administrators, Engineers and World 

According to the specific security requirements, AF identities are created on the AF 
Server, and the permissions for the AF server resources (such as an element 
collection or objects) are granted for these AF Identities.  

 

With AF Mappings, Windows users and groups are mapped to the AF Identities: 

  

Note: It is preferable to define the AF Mappings for Active Directory (AD) groups instead of 
individual windows users. Since it is inefficient to maintain individual user accounts directly, it is 
recommended that the mapping on a user basis be the exception. 

 

Members of the Windows groups that are mapped to an AF identity are automatically 
granted the access permissions for that AF identity.  

For example, the Active Directory (AD) group Engineering Team is mapped to 
Engineers, so all the members in that AD group have read/write permission for the 
Elements collection. 
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In case of multiple identities user is granted permissions based on all AF Identities to 
which he or she is mapped. In example below, Bob has all permissions from PI AF 
Identity 1 and PI AF Identity 2. 

 

 

 

Built-in AF Identities: 

 

AF Identity Description 

Administrators By default, this identity has all access permissions to every collection and 
object on the AF server, including all databases. It cannot be modified or 
deleted.  

It is recommended that access to this identity is restricted to only a few 
users. 

Engineers This identity has the same privileges as Administrators, with the 
exception of the Admin (a) permission. This identity is also not allowed to 
delete AF databases. 

It is recommended that this identity be restricted to those users who are 
defining the asset database. Additional identities should be created to 
narrow the scope of access within AF. 

World This identity has read access permissions to every collection and object 
on the AF server. More information see below.  
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World Identity: 

By default, World identity is mapped to the Windows Everyone users group: 

 

 

By default, World Identity has Read permissions on all items. World identity cannot 
be modified or deleted. However, Mappings for World can be removed and 
Permissions for World can be removed. 

 

 

8.1.2 AF access rights 

Access permissions can be granted for all AF Objects. Examples: 
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The following table describes the access permissions you can assign to AF identities 
for all objects in the AF hierarchy. 

 

Access right Abbreviation Definition 

Read r Enables a user to view the object.  

Write 

w Enables a user to create and modify an object. The 
exception is that event frames and transfers also 
require Write Data permission on the element template 
from which they are created. 
Additionally, if users do not have Write permission on 
the AF database, they cannot modify any object within 
the database, regardless of the specific permission on 
that object. 

Read/Write 
 Enables a user to read and write to the associated 

object. 

Read Data  
rd Enables a user to read element’s attribute values (non-

configuration items). 

Write Data  

wd Enables a user to modify element’s attribute values 
(non-configuration items). Additionally, this permission 
controls whether a user can create or modify event 
frames. 

Subscribe  
s Enables a user to subscribe and unsubscribe to a 

notification. 

SubscribeOthers  
so Enables a user to subscribe and unsubscribe other 

users to a notification. 

Delete  d Enables a user to delete an object.  

Execute  

x Enables a user to perform most actions on an analysis 
case. 
Only used in Pimsoft SigmafineTM data reconciliations. 
The PI Analysis Service does not use this permission. 
The Write permission is required to modify, run, and 
stop asset analyses. 

Admin  

a Enables a user to modify the security settings, or 
owner, of an object. Also allows to force an Undo 
Check Out on an object that is checked out to another 
user, as well as to lock and unlock an event frame.. 

 

Setting permissions can be done for individual AF objects or for collections of 
objects. When you create new objects, except for child elements, the collection 
security is used as the default security. When you create a child element, the 
security descriptor of the parent element becomes its default security. 
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8.1.3 AF Security Hierarchy 

The following chart shows the structure of the AF objects in a AF Server. Each 
securable AF object (element, event frame, and notification, and so on) throughout 
the hierarchy has an associated security descriptor that contains the access 
permissions information for that object. 

All AF objects of the same type belong to a collection. For example, every AF 
element in a database belongs to the Elements collection for that database. Each 
collection also has an associated security descriptor that contains access permission 
information. 
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8.1.4 AF Server Security 

Setting the security for a AF server 

To open Security Configuration window for AF Server: On the toolbar, click the 
Database button. In the Select Database window, click the Edit Security button.  

Alternatively, click the AF Server Properties button  to open the AF Server 
Properties window, then click the blue Security link below the Aliases field. The 
Security Configuration window displays the defined access rights and allows to 
change them.  
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The Items to configure list for the AF Server contains the following items: 

 AF Server 

 Contacts Collection  

 Notification Contact Templates Collection 

 Identities Collection 

 Mappings Collection 

 Databases Collection (entire AF hierarchy) 

 Analyses Collection (entire AF hierarchy) 

 Analysis Templates Collection (entire AF hierarchy) 

 Categories (entire AF hierarchy) 

 Elements Collection (entire AF hierarchy) 

 Element Templates Collection (entire AF hierarchy) 

 … 

The Security Configuration allows adding, removing or changing the permissions for 
AF Identities.  

• You can uncheck/check items to control the scope of the changes you are 
going to apply.  

• You can modify permissions for one of the AF identities that is listed, or add 
or remove identities, as needed.  

• The child permissions option defines the handling concerning permission 
inheritance.  

 

Setting the security for an AF database 

To open Security Configuration window for 
an AF database:  

On the toolbar, click the Database button. 
In the Select Database window, right-click 
a database in the Databases list and 
select Security. 
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In the Items to Configure list of the Security Configuration window, the selected 
database and every collection is checked.  

 
 
 

The Items to configure list for the AF Database contains the following items: 

 AF Database 

 Analyses Collection 

 Analysis Templates Collection 

 Categories 

 Elements Collection 

 Element Templates Collection 

 … 

The Security Configuration allows adding, removing or changing the permissions for AF 
Identities. You can uncheck/check items to control the scope of the changes you are going to 
apply. You can modify permissions for one of the AF identities that is listed, or add or remove 
identities, as needed. The child permissions option defines the handling concerning permission 
inheritance. 
 

Setting the security for an AF collection 

You can configure access permissions to collections (Elements collection, Event Frame 
collection, Templates collection...) at several points in the AF hierarchy. You can set them at the 
server level or at the database level. If set at the server level, the permissions assigned to 
identities on the server are also assigned to the same identities in every database. 
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AF Object Security 

You can set specific access permissions for an identity that differ from the default settings 
inherited from elsewhere in the AF hierarchy on any object (or object group) and collection in a 
database. 
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Permissions inheritance 

When you change the access permissions for an element, the following applies for 
access permissions of child elements: 

Reference Type Behavior 

Composition Access permissions for child and parent are always the 
same. 

Weak Access permissions are never inherited. 

Parent – Child When access permissions are set on a parent, the Child Permission 
settings in the Security Configuration window depend on option 
used 

 

  

Option Description 

Do not modify child 
permissions 

Prevents access permissions that have been set for the 
current object or collection from being replicated to child 
collections and objects in the AF hierarchy. 

Default for AF server 2.5 and earlier 

Update child permissions for 

modified identities 

For each selected item on the Items to Configure list in the 
Security Configuration window, replicates the access 
permissions for all child collections and objects for each 
identity on the Identities list whose access permissions have 
been modified. 

Default for AF server 2.6 and later. 

Replace child permissions for 
all 

identities 

For each selected item on the Items to Configure list in the 
Security Configuration window, replaces all child permissions 
for every identity on the Identities list with the parent access 
permissions. 

Hint: Before you apply this option, review access permission 
settings for all items on the Items to Configure list to avoid 
unintentionally overwriting custom permissions that may have 
been applied elsewhere in the collection hierarchy! 
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UOM Database security 

The AF Unit of Measure (UOM) database is shared across all AF databases. You cannot set 
permissions for individual UOMs or UOM classes. Permissions can only be set for the entire 
UOM database.  

To open UOM Security Configuration window:  

In the Navigator pane, select Unit of Measure.  

On the toolbar, click the UOM Security button. 

 
 
 

 

Security Tips 

Administrator privileges at the server level, provides access to every object 
regardless of their security settings. 

If you want to edit an element, you need write permissions on the Elements 
collection and on the particular element. 

Library objects, such as templates, enumeration sets, UOMs and reference 
types always have read permission regardless of their security settings 

Deny settings override any granted allow permissions 
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8.1.5 Directed Activity – AF Objects Security 

 

In this part of the class, you will perform a learning activity to explore the 
different concepts presented in this chapter or section. You may be invited 
to watch what the instructor is doing or perform the same steps at the same 
time. Your instructor will have directions.  

Exercise Objectives 

• Create AF Identity and use it for a mapping to a Windows user account. 

• Assign Permissions for an AF database and for AF elements. 

Problem Description 

Sheila, the new intern (student04@PISCHOOL.INT) has been hired at Velocity 
Terminals. To prevent unauthorized read access and unintended changes, the 
engineering supervisor has to change the security for the AF database: 

Because of confidentiality, only designated Windows users should be able to read 
the data for Velocity Terminals. Beside Administrators and Engineers, just the intern 
should be able to read the data. 

Sheila should not be able to see tanks in Sydney or Tokyo. Of course, if the intern 
browses to the Distribution or Receiving divisions he should only see the tanks 
belonging to Montreal. 

She will be doing some research on Tank01; hence, she should be able to edit this 
tank’s data and configuration. 

Note: In order to avoid negative impact on the Velocity Terminals production database, perform 
the steps on the AF Startup AF database! 

Approach 

1. Click on the AF Server Properties button ( ) to open the AF Server 
Properties window. Identities and Mappings tabs: Add a new Interns AF 
Identity and map the student04 account to it. 

 

2. Click on the Database button ( ), select Security for AF Startup 
database: 

• To remove the permissions for the World Identity: 

Select World identity, then click on  button. 
 

• To add Read and Read Data permissions for the Interns Identity: 

Click on  button, select the Interns identity. 
Uncheck Allow All, then enable Read and Read Data  

Select Update child permissions-Option and click on  button. 
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3. For the Tank01 element in Montreal… 
 

• To add Read/Write and Read/Write Data permissions for the Interns 
Identity: 
 
Select Security… from Tank01 element. 
Select the Interns identity. 
Enable Read/Wríte and Read/Write Data 

• Select Do not Modify Child Permission-Option, click on  button. 

 

4. For the Tokyo and the Sydney element… 

• Remove all permissions for the Interns Identity: 
 
Select Security… from Sydney element 
Select the Interns identity. 

Click on  button 

Select Update child permissions-Option and click on  button. 
(accordingly for Tokyo). 

 

Verification 

1. Maximize PI System Explorer (PSE). 

 

2. Open a second PI System Explorer (PSE) instance for connection with the 
intern’s account:  
 

 
 
With Shift key pressed, right-click the System Explorer icon in the Windows 
taskbar and select Run as a different user. Supply student04 credentials. 
(optional, for improved distinction) If needed, resize the window and bring it in 
front of the first PSE window.  

 

3. On second PSE: click the Database button ( ). In Select database 

window, click on the  button next to the AF Server name. 

 

4. The current connection is with pischool\student04. Note the effective identity 
permissions for pischool\student04 are (Interns | World) 
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5. Click on OK. Select the AF Startup database and verify the permissions on 
the tanks. Attempt to change descriptors for Tank01 and Tank02. 

  



Building PI System Assets and Analytics with PI AF 

 

Page 196 

 

8.2 AF Attribute Properties 

When attributes are created, there are four associated properties (configuration item, 
excluded, hidden, indexed). You have the option to set those properties for each 
element attribute. In case of an element derived from a template, the properties of 
the attributes cannot be changed any more except for the Exclude property: 
 

 

 

Configuration Item You assign the Configuration Item property to an attribute with a 
constant value that represents inherent properties of an asset (e.g. 
a device serial number). In PI System Explorer, configuration 
attributes are marked with a pencil icon ( ). 
When you change the attribute value of a configuration item PI 
System Explorer automatically checks out the attribute. To commit 

the change you need to .  

Indexed Indexed attributes are attributes that are optimized for fast search 
results and fast value retrieval. You can only index attributes 
whose values are stored in the AF database. This means that you 
cannot index attributes that get their values from PI point data 
references or from linked table references. 

Excluded 
(new in AF Server 
2015) 

In situations where not all attributes in an element template apply, 
attributes that are not applicable can be excluded.  
Example: only some of the tanks have a second container 
coating. Set the attribute for the material of the second coating to 
Excluded property for the tanks with a single coating. 

Hidden 
(new in AF Server 
2015) 

The Hidden property is useful if an attribute is being used to hold 
an intermediate result, such as a table lookup result that can then 
be retrieved by a PI point data reference, or is being used solely to 
populate a tag name in a substitution parameter. 
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8.2.1 Directed Activity – Use of attribute properties  

 

In this part of the class you will perform a learning activity to explore the 
different concepts presented in this chapter or section. You may be invited to 
watch what the instructor is doing or perform the same steps at the same time. 
Your instructor will have directions. 

Activity Objectives 

• Assign properties for attributes for specific use cases. 
 

Problem Description 

The Capacity attribute for a tank is considered as a constant that represent an 
inherent property for the tanks at Velocity Terminals. The value will always be the 
same except for a change of the equipment itself. Capacity changes should require a 
Check-Out and Check-In sequence in AF.    

Only the first tank in every location of Velocity Terminals (Montreal, Sydney, Tokyo) 
has a dedicated night shift operator. Add attributes with the operator names, which 
should only exist for tanks Tank01, Tank05 and Tank08.  

The tag name convention for process values at Velocity Terminals is the abbreviation 
“.PV” at the end of the tag name. The abbreviation should be defined in an AF 
attribute, but the attribute should not appear in PI Visualization Tools or in PI System 
Explorer Searches. 
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Approach 

Open the Velocity Terminals database in AF and navigate to the Tank template in 
the Library. (Do not use the AF Startup database any more.) 

Select the Capacity 
attribute and  
enable the 
Configuration Item 
property 

 

Add a Night Shift 
Operator attribute 
with Value Type 
String and Default 
Value Bob. 

 

 

Add a PVCode 
attribute with Value 
Type String, enable 
the Hidden property 
and enter the Default 
Value PV. 

 

 

Check-In the new attributes. 

Switch to elements and select Tank01. Change the Capacity from 20,000 to 22,000. 
Notice, that the Tank01 element has been checked out. It is marked accordingly in 

the Asset tree . If you select the element PI System Explorer status line 
displays details of the checked out element: 

 

Click on Undo Checkout button  in the toolbar to revert to the initial setting. 
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Notice that the PVCode attribute is marked as hidden . Perform an attribute 
search (search > Attribute Search) for all attributes in Montreal that start with P*. 
PVCode is not returned. 

Perform an attribute search for the Night Shift Operator attributes under Locations. 

Select the lines for tanks without a Night Shift Operator (Tank02, Tank03, Tank04, 
Tank06, Tank07, Tank09, Tank10): 

 

 

Select Properties and set Excluded. Click on OK. The change applies to all the 
selected attributes. Change the names for the first tanks in Tokyo (Akane) and 
Sydney (Alex): 

 

Click on Check-In. Then click on Refresh. Now the search returns only the non-
excluded attributes for Tank01, Tank05 and Tank08. 

Select the tank elements individually and observe what is displayed for the Night 
Shift Operator.  

Under Tools > Options select the General tab and uncheck the Show Excluded 
Attributes option. Click OK. Select the tanks individually again and observe what is 
displayed now for the Night Shift Operator. 
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8.3 AF Advanced Template Design 

8.3.1 Substitution Parameters in an Attribute Template 

Substitution parameters are variables that you place in attribute templates for PI 
point data references. AF resolves a substitution parameter when elements are 
created. As an example, the substitution parameter %Element% would resolve to the 
attribute’s element name.  

For example, in a truck template, the tag for the speed attribute is configured as 
%Element%.%Attribute%.PV. Once Truck1 is created from this template, AF would 
try to find a tag named Truck1.Speed.PV. 

 

 

 

Notice the default configuration for a PI Point Data Reference attribute template: 
\\%Server%\%Element%.%Attribute%.  

 

 

Substitution parameters can also be applied in Table Lookup and String Builder Data 
References. 



Taking Full Advantage of AF Functionalities 

 

Page 201 

 

8.3.2 Defining the Substitution Parameters 

AF supports numerous substitution parameters, which can be used in attribute 
templates. The following table lists the ones most commonly used. 

Parameter Name Substitution 

%Attribute%  Name of the attribute that holds this data reference.  

%Description%  Description of the attribute that holds this data reference.  

%Element%  
Name of the element in which the attribute resides. For 
event frames, this refers to the name of the primary-
referenced element.  

%..\Element%  
Name of the parent element of the element in which the 
attribute resides. To retrieve further ancestors, use the ..\ 
notation, such as %..\..\Element%.  

%Server%  

Name of the default Data Archive for the computer on which 
you create the attribute. The default Data Archive for the 
computer on which PSE is running.  

Note: The %Server% parameter does not resolve to the 
computer on which the AF database resides. The 
%Server% parameter can resolve to a different Data 
Archive depending on the default in AF Client.  

The following table lists the substitution parameters that are useful for event frames 
naming patterns. 

Parameter Name Substitution 

%EventFrame%  Name of the event frame in which the attribute resides.  

%..\EventFrame%  
Name of the parent event frame of the event frame in which 
the attribute resides. To retrieve further ancestors, use the 
..\ notation such as %..\..\EventFrame%.  

%StartTime%, 
%EndTime%   

Local start or end time, if obtainable from the time context.  

%UtcStartTime%, 
%UtcEndTime% 

Coordinated universal (UTC) start or end time if it can be 
obtained from the time context.  

 

See also Appendix A: Substitution Parameters at the end of the book. A helpful 
document for the use of substitution parameters is the Guide to Substitution 
Syntax in AF-EF Data References. It can be obtained from PI Square at 
https://pisquare.osisoft.com/thread/11188, copy is in the documentation class folder  

https://pisquare.osisoft.com/thread/11188
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8.3.3 Directed Activity – Substitution Parameters and Automatic Tag Creation 

 

This solo or group activity is designed to maximize learning in a 
specific topic area. Your instructor will have instructions and will 
coach you if you need assistance during the activity. 

 

 

Objectives 

• Use AF attributes substitution parameters. 

• Demonstrate automatic tag creation. 

Problem Description 

A new pressure transducer has been installed on every tank at Velocity Terminals. 
You have to add a pressure attribute to the tanks in your AF structure; however, the 
PI tags have not been created. Your colleague from instrumentation tells you that the 
tag configuration should be similar to a test tag he created a few weeks ago called 
MyPressureTag.  

Velocity Terminals would like you to use a meaningful naming convention for the PI 
tags created as part of this project; they would like the tags to be named something 
like: 

Montreal-Tank01.Pressure.PV 

Since our company has sites globally, it is better to use International units for 
pressure (Bar) 

Approach 

Add a new attribute to the Tank template, name it Pressure and use Bar as the 
default UOM.  

Select PI Point as the Data Reference, and click on Settings to configure it. 

Under Tag Name, what should you write? 

 
___________________________________________________________________. 

 

Since the tags have not been created, check Tag Creation and then the ellipsis (…). 
As your friend at instrumentation has already configured a tag to collect the pressure 
data, you may go ahead and import its settings (See figure below).  

Tip: You could configure the tag settings (PointSource, InstrumentTag,Location codes, etc.) 
from the Tag Creation Settings dialog window; however, importing the settings of a working tag 
will save you some time. 
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You probably noticed that the tag’s engineering units 
(engunits) were PSI. Since you want to display the 
attribute in AF in bars, you can take advantage of the 
on-the-fly-unit-conversion feature of AF. Select psi as 
the Source Units.  

 

 

 

 

 

 

Check your tanks: what value is showing for your existing tanks?  

________________________________. 

 

What do you do to create the tags for the already existing tanks?  

_________________________________. 
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8.3.4 Advanced Substitution Parameters 

Not only can substitution parameters resolve to the name of a AF object like an 
attribute, but also to the value of an attribute. 

Imagine the Velocity Terminals example again. Imagine the tag names are always 
built the same way following this tag naming convention: 

15Tank01TS.PV 

LocationCodeEquipmentNameMeasurementType.DataType 

Where   

LocationCode = Code for the location (ex.: Montreal is 15) 

Equipment Name = Equipment name (ex.: TANK01) 

MeasurementType = Measurement type (ex.: TS for temperature sensor) 

Data Type  = Type of data (ex.: PV for process value) 

 

This could lead us to determine that the Tank01’s temperature would have its tag 
named 15TANK01TS.PV. With that in mind, substitution parameters make it possible 
to configure the temperature attribute at the template level in such a way that any 
newly created tank in the AF hierarchy would automatically see its temperature 
mapped to the correct Data Archive tag. The idea here is to have all the required 
information somewhere in the structure so the attribute can reconstruct the tag name 
depending on where it is in the hierarchy. A solution to the above tag naming 
convention would simply be to add an ID attribute under the city name element. 

 

Then, the level attribute could be built using the following configuration string: 

 \\%Server%\%@..\|SiteID%%Element%TS.PV 
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Reading a Substitution Parameter 

The above %@..\|SiteID% substitution parameter can be read as: “Give me the value 
of the parent-element’s SiteID attribute.” In order to better understand the 
configuration string above, refer to the following table: 

 

Symbol Definition Examples 

%[…]% 
Consider the expression as a 
substitution parameter. 

%Element%, 
%Attribute% 

. Navigate a level down. %@.\<ChildElement>|<Attribute>% 

.. Navigate a level up. %..\..\Element%, %..|Attribute% 

\ References an element. %..\Element% 

| References an attribute. %..|Attribute%, %@|<Attribute>% 

@ 
References the value of the 
object instead of its name. 

%@..\..\|<Attribute>% 

 

  

mailto:%25@./%3cChildElement%3e%7C%3cAttribute%3e%25
mailto:%25@../../%7C%3cAttribute%3e%25
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8.3.5 Directed Activity – Using Substitution Parameters in a Template Attribute 

 

In this part of the class, you will perform a learning activity to 
explore the different concepts presented in this chapter or section. 
You may be invited to watch what the instructor is doing or perform 
the same steps at the same time. Your instructor will have 
directions. 

Exercise Objectives 

• Assemble substitution parameters to automatically map Data Archive tags to 
AF attributes. 

Problem Description 

Velocity Terminals will buy other facilities in the next few months where multiple 
tanks are present. They are going to implement the same tag naming convention at 
those new locations and will want to save time when adding those extra assets to the 
actual AF hierarchy. 

They want to use the substitution parameters to speed up the creation of additional 
assets in AF. To demonstrate that this is feasible, you are asked to add a new 
temperature attribute template to the Tank’s template so that it uses substitution 
parameters to automatically find the correct PI tag. 

Looking again on the Velocity Terminals portal, you find the below table in a 
spreadsheet: 

Site SiteID 

Montreal 15 

Sydney 23 

Tokyo 44 

Approach 

1. Create an attribute under each location to display its ID (hint: you may want to use the site 
template along with a table and a table lookup data reference). 

2. Add a temperature attribute to the tank template. Use substitution parameters so that the 
tag names are automatically built according to the expected tag naming convention. 

3. Validate the new configuration string by browsing the tanks. 

Extra Bonus point 

Add an (hidden) attribute to the tank template that displays the PI Point name of tank 
temperature. Use String Builder to assemble the tag name. Apply the Hidden 
attribute. 

  



Taking Full Advantage of AF Functionalities 

 

Page 207 

 

Note: When referring attribute values there are differences between substitution parameters 
used in PI Point Data References and the syntax in the String Builder.  
%@..\|SiteID% works in the PI point reference but has to be ‘..\|SiteID’ instead for the String 
Builder. 
For more information refer to “String Builder data references” in Chapter “Configuration of data 
references” in the PI System Explorer User Guide, version 2015, p. 124 ff. 
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8.3.6 The String Builder Data Reference 

The String Builder data reference allows you to use substitution parameters and 
functions to manipulate values and output a string.  

Below some cases where the String Builder data reference is useful:  

✓ Concatenate strings (Element Name + Attribute Name + Value). 

✓ Format dates and numbers. 

✓ Build paths to elements and attributes. 

✓ Parse comments from operators stored in PI tags. 

✓ Display element information as an attribute. 

Note: Since this data reference supports substitution parameters, when used in a template, 
value substitutions takes place at run time. 

 

 

String Builder allows you to manipulate strings located anywhere in your hierarchy by 
using the Related Attribute Values contextual menu (see figure below). 
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8.3.7 Exercise– Using the String Builder Data Reference 

 

This solo or group exercise is designed to maximize learning in a specific 
topic area. Your instructor will have instructions, and will coach you if you 
need assistance during the exercise.  

 

Create a new attribute with information in a string like the following:  

Tank01 is located in Montreal, level is at 99.8% 

 

Approach 

1. From the Navigator Panel, select the Library section. Open the Tank element 
template. 

2. Add the Tank Level Information attribute, value type= String, Data 
Reference= String Builder. 

3. Use the String Builder Data Reference dialog box to construct the string 
 

 
 

Note 1: to display the level value in the requested format (one digit after the decimal 
point), use the Format (real,format) function in String Builder. Format follows 
Performance Equation (PE) style syntax, e.g.: "%3.1f". The number before the decimal 
indicates the minimum total number of characters to output, pre-padding with blanks, the 
number after the decimal indicates the number of digits to display after the decimal point. 

Note 2: You can construct an expression on a single line, using semicolons to separate 
its terms. But you can also place each term on its own line, which eliminates the 
semicolons and makes the expression structure more apparent (see above). 

4. Switch to one of the tank elements and verify the attribute string as desired. If 
required, correct the String Builder definition. 

5. Click on Check-In  
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8.3.8 Template Inheritance and Base Template 

A powerful feature of the element template is the ability to set a base template. Once 
a base template is created, it can be used to create a number of derived templates. 
When an element is created from a derived template, the element contains all 
attributes from both the base template and the derived template. 

 

• An element created from the Tank element template has three attributes: 
Diameter, Height and Fill Level.   
 

• An element created from the Mixing Tank element template has five 
attributes: Diameter, Height, Fill Level, Mixer Speed and Mixer Blade Size 

 

A base template is best used when you are modeling elements that have a set of 
attributes in common with a few attributes that differ. For example, if you have a set 
of tanks, some with two valves and some with one valve, you can create an element 
template for the one-valve models and use that as the base template for the two-
valve models. Set the base template of an element template in the General tab; 
alternatively, you can set the base template at creation time by right clicking the base 
template and select New Derived Template. 
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To view the template inheritance tree from the PSE Library, simply organized the 
templates by inheritance. 
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8.3.9 Directed Activity – Working with derived element templates 

 

In this part of the class, you will perform a learning activity to explore the 
different concepts presented in this chapter or section. You may be invited to 
watch what the instructor is doing or perform the same steps at the same time. 
Your instructor will have directions. 

Activity Objectives 

• Create a derived template for a special tank that has an additional sensor for 
CO2 measurement 

• Use a derived template to accommodate a different PI Point reference for the 
Level attribute in a special tank. 

Two modifications were done on Tank10, which means that the tank deviates from the normal 
ones on the following details: 
 

• There is an additional sensor for CO2 measurement. The tag name is: 
Tank10CO2.PV 
 

• The name for the Level sensor is different now. Instead of Tank10LI.PV the 
name is  
Tank10LEVEL.PV 
 
This means the name does not follow the normal name pattern 
%Element%LI.PV. Instead the name pattern is %Element%Level. 

Approach 

Create an element template for a Special Tank that has an additional sensor and a 
different naming pattern for the Level attribute. 

 

1. Open the Tank template in the Library of the Velocity Terminals database.  

2. From the Tank template context menu and select New Derived Template 

 

3. Rename the new element template to Special Tank. 
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Additional Attribute for CO2 (PI Point: Tank10CO2.PV) 

4. On the Attributes Templates tab, add a new attribute template CO2: 
  
Default UOM = percent (Ratio) 
Value Type= Double 
DisplayDigits=2 
Data Reference = PI Point 

 

5. Click on Settings… to enter the PI Point name. Use substitution 
parameters to define a standard naming pattern based on the element 
and the attribute name. Make use of the PVCode attribute string. 
What do you write? 
 
___________________________________________________ 

 

6. Change the Source Unit from <Default> (%) to %. 

 

7. In the Navigator, switch to Elements. Select Tank10 and change the 
template from Tank to Special Tank. 
 

 
 

8. Verify the Tank10 has the CO2 attribute, the value is from PI Point 
Tank10CO2.PV. 

 

Attribute Overwrite for Level (PI Point: Tank10LEVEL.PV) 

9. On the Attributes Templates tab, add a new attribute template Level : 
  
Default UOM = percent (Ratio) 
Value Type= Double 
DisplayDigits=2 
Data Reference = PI Point 

 

10. Click on Settings… to enter the PI Point name. Use substitution 
parameters to define the different naming pattern based on the element 
and the attribute name. Make use of the PVCode attribute string. 
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What do you write? 
 
___________________________________________________ 
 

11. Change the Source Unit from <Default> (%) to %. 

12. To define the limits, select the Level attribute and click on Limits…in the 
context menu. Set the limits in the same way as for the normal tank: 

 

13. In the Navigator, switch to Elements. Select Tank10 and verify the PI 
Point for the Level attribute of Tank10 is Tank10Level.PV 

14. Check-In your changes. 

 

Show element templates based on inheritance 

15. Open the Element Templates in the Library of the Velocity Terminals. 
From the context menu, select Arrange By > Arrange By Template 
Inheritance. Result: Special Tank is shown below Tank. 
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8.3.10 Exercise – ABC Mining Company and Advanced Template Design (optional) 

 

This solo or group exercise is designed to maximize learning in a specific 
topic area. Your instructor will have instructions, and will coach you if you 
need assistance during the exercise.  

Exercise Objectives 

• Design Templates for AF, which use template inheritance. 
 

• Create elements, which use PI Point Data and Formula Data 
References from these templates. 

Problem Description 

You are installing a Data Archive and AF Server for ABC Mining Company and you 
are currently focusing on their truck fleet. 

 

ABC Mining Company has eight (8) mining trucks: 

ID Model 
License Plate 

Number 
Gas Tank Capacity 

SP1 Mining Car CA HYK427 210 US Gallons 

SP2 Mining Car CA HRZ648 210 US Gallons 

SP3 Mining Car CA HBB139 210 US Gallons 

SP4 Super Carry CA HAR990 317 US Gallons 

SP5 Super Carry CA HEED21 317 US Gallons 

SP6 Super Carry CA HQB932 317 US Gallons 

SP7 Mine Runner CA HOT263 500 US Gallons 

SP8 Mine Runner CA HEE563 500 US Gallons 

 

All of the mining trucks have some common measurements: 

Measurement Units Data Archive Tag 

Tripmeter  
(miles since last fill up) 

Mile SP1.Trip, SP2.Trip … SP8.Trip 

Gas Tank Level Gallon SP1.GasLvl, SP2.GasLvl … SP8.GasLvl 

Oil Level liters SP1.OilLvl, SP2.OilLvl … SP8.OilLvl 

Tire Pressure  psi SP1.TireP, SP2.TireP … SP8.TireP 

These measurements are sent back to the scheduling department with real-time 
updates via radio. 
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The Super Carry trucks and the Mine Runner vehicles capture additional data: 

Measurement Units Data Archive Tag 

GPS – Longitude Seconds (“) SP5.GPSLong… SP8.GPSLong 

GPS – Latitude Seconds (“) SP5.GPSLat… SP8.GPSLat 

 

The GPS readings are in Seconds (“) (from the Plane Angle UOM Class, where 
there is a relation between degree, minutes and seconds). The degrees and minutes 
are assumed. 

ABC Mining Company wants the Fuel Efficiency in miles per gallon (MPG) (double) 
for every delivery vehicle.  

Your task is to configure the templates, elements, and attributes required to support 
ABC Mining Company truck fleet monitoring system. 

 

Approach 

1. Use Import from File… to import the Truck Identification and the Truck 
Model Specifications tables. The XML files are located 
C:\Class\Exercises\03_ABCMiningCompany 

 
2. Create an element template General Truck for the trucks without GPS. 
 
3. Create an element named SP1 based on the template just created. 
 
4. Create another element, named SP2, based on the template just created. 
 
5. Define the attributes for the four measurements (Tripmeter, Gas Tank Level, 

Oil Level, Tire Pressure) in the General Truck template. Verify in SP1 and 
SP2 that data is received from the right points. 

 
6. Define the attributes for the data you can read out of the Truck Identification 

table (License Plate, Model).  
 
7. Define the attributes for the data you can read out of the Truck Model 

Specifications table based on the model of the truck (Gas Tank Capacity, 
Nominal Oil Level, Nominal Tire Pressure). 

 
8. Create a derived element template Truck with GPS for the trucks with GPS 

(Super Carry, Mine Runner)  
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9. Define the attributes for the GPS measurements (GPS Latitude, GPS 
Longitude) in the Truck with GPS template. 

 
10. Use PI Builder to create elements for the remaining trucks in bulk. Verify the 

attributes for the trucks are correct. 
 

 
 

 
11. Categorize the attributes by grouping them in categories and display them in 

those groups by checking the  checkbox in the upper right 
corner of the attribute Configuration Panel. 

 

Category Attributes 

Gas Tank Gas Tank Capacity, Gas tank Level 

Identification License Plate, Model 

Oil Actual Oil Level, Nominal Oil Level 

Tire Pressure Actual Tire Pressure, Nominal Tire Pressure 

Trip Data Trip Meter 

 
 
12. Add a new UOM class Fuel Efficiency that has unit-of-measure MPG as its 

canonical unit. 
 
13. Add an attribute for the Fuel Efficiency, Data Reference= Formula. For the 

Fuel Efficiency calculation, the mileage since fill-up and the current gas level 
are reported, so the mpg (miles per gallon) can be calculated. 
Hint: Formula: Tripmeter / (Gas Tank Capacity – Gas Tank Level) 

 
14. (Optional) Also produce the Range calculation in miles for each vehicle (fuel 

efficiency * remaining fuel). 
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15. (Optional) Add a further unit-of-measure Liter per 100 km (abbreviation: 
l/100km) with following formulas: 
MPG = 235 / l/100km 
l/100km = 235 / MPG 
Display the Fuel Efficiency in liters per hundred kilometers (L/100 km). In 
order to convert from MPG, the Formula option will be used when specifying 
the conversion). 

 
 
 

Try to do this exercise on your own before referring to the exercise solutions section 
at the end of the book. 

 
 

About Attribute Categories 

Categories can be used to group AF objects like elements, attributes, or tables together to 
facilitate the administration of those objects. To add an attribute to a category, simply select one 
or more categories from the Categories field of the attribute’s Configuration Panel, or 
alternatively write the category name. If that category does not exist yet, a prompt will be shown 
to ask if this category should be created. 
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8.4 AF and Future Data (optional) 

Data Archive 2015 introduces the ability to store future data, which allows to handle 
data with timestamps up until January 2038. January 1970 remains the past limit for 
all tags. 

 

 

 

Future tags should be used when storing data that is not collected sequentially in 
chronological order. For example, process or operational data should be kept in 
historical tags because it is measured and collected in real time. On the other hand, 
forecasts or any form of predictive data over an arbitrary time range are perfectly 
suited for future tags. 

 

Future data and analyses 

You can use future data as input to an analysis. You can also use an analysis to 
produce future data by specifying a future time stamp for the output from an analysis. 
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8.4.1 Advanced Configuration Options (new with Analysis Service 2015) 

For any scheduled analysis, the default timestamp for output values is the trigger 
time. For periodic scheduling, the trigger time is the scheduled evaluation time, and 
for event-triggered scheduling, the trigger time is the time that a specified attribute 
changes values.  

Using Advanced Option, you can specify the timestamp of analysis output values. 

 

 

Option Behavior 

Trigger Time Default value. The clock time that a schedule specifies or that an 
input value changes. 

Execution Time The clock time at which the analysis calculates the value. 

Relative to Trigger Time: A time specified by a PI time expression. Enter a valid time 
expression, such as a time relative to the trigger time or a fixed 
time. A relative time in the future will create events with 
timestamp in the future. For mapped output points this requires 
a future PI point (available for Data Archive 2015).  

Automatic Recalculation In case you expect that data from your inputs will be late-arriving 
or be out-of-order, you can request automatic recalculation for 
an analysis. The Management list allows to set this option for 
multiple analyses within one command. 

 

When can the Relative to Trigger Time option be useful? 

You need a daily summary for the raw material consumption in the plant for 24 hour 
periods (yesterday midnight – midnight today). Asset Analytics is used to calculate 
the sum. However, due to the operation in the plant it is not possible to have all the 
required input data ready with a delay of 10 - 15 minutes. With a scheduled daily 
execution at 12:15AM for the analysis the Relative to Trigger Time option is set T 
(today midnight) so the output result gets stamped at midnight (even though the 
summary is done 15 minutes later).  
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8.4.2 Directed Activity – AF Attributes with future data (optional) 

 

In this part of the class, you will perform a learning activity to explore the 
different concepts presented in this chapter or section. You may be invited 
to watch what the instructor is doing or perform the same steps at the same 
time. Your instructor will have directions.  

 

Activity Objectives 

• Create attributes which refer to tag with future data. 

• Use Asset Analytics to calculate forecast data. 

• Explore the display of AF attribute values with future timestamps in 
PI Processbook. 

Problem Description 

The amount of material, which is delivered by the trucks of the ABC Mining Company 
from the mine to the train station for further transportation, is tracked in order to 
compare it against a target production plan. The cumulative daily total of material 
that has been delivered by the mine trucks is reported into tags SP?.Load every 4 
hours. The production management department of the ABC Mining Company 
calculates expected loads for next four hours, which are provided in tags 
SP?.LoadSim.  

Your task is to calculate the cumulative material for end of the coming four-hour 
period. These calculations should be stored into future tags SP?.DeliveryPlan in 
order to do a comparison on a per truck basis between the actual delivered material 
and the corresponding forecasted deliveries. 

 

Approach 

Follow the instructor as he or she performs steps to simulate plan data creation and 
to create AF attributes in the General Truck template that will lead to the 
corresponding visualization in a PI Processbook display. 

 

Plan Data Creation 

Using AF Analytics, we will calculate a new forecast for the load delivery every four 
hours by adding the expected load for the next four hours to the current load of the 
truck.  
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Attribute Creation for General Truck template 

• In System Explorer, select the Library section, and open the General Truck 
template in the Element Templates section.  

• Select the Attribute Templates tab on the right hand side. To segregate these 
three attributes from the remaining ones, add an attribute category of Material 
Delivery.  

• Configure the attributes per the table below. The Load.Next4Hours attribute 
should be a child element for the Load attribute: 
 

 

 

Attribute Name Default UOM Value Type Data 
Reference 

Setting 

Load ton (Mass) Double PI Point %Element%.%Attribute% 

Load.Next4Hours ton (Mass) Double PI Point %Element%.LoadSim 

Delivery Plan ton (Mass) Double PI Point %Element%. DeliveryPlan 

For  the attribute category set to Material Delivery in all cases. 

 

Load: 

The actual cumulative truck load (on a per Day basis) 

Load.Next4Hours: 

The expected load for the next 4 hours 

Delivery Plan: 

The forecasted cumulative truck load (on a per day basis) 
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Calculate the expected load for the next 4 hours 

• In System Explorer, select the Library section, and open the General Truck 
template in the Element Templates section.  
 

• Select the Analysis Templates tab on the right hand side and create new 
analysis template Load Delivery Forecast (Expression type). 
 
The following calculation rules apply: 

Calculation Time Calculation Result Timestamp 

00:00:00 Initial Forecast for the day 
is the expected load for the 
next four hours  

04:00:00 

04:00:00,  
08:00:00, etc.  
until 16:00:00 

Forecast is the actual Load 
plus the expected load for 
the next four hours 

08:00:00,  
12:00:00, etc. 
until 20:00:00 

20:00:00 As the accumulation is on 
a per day basis, the value 
is reset to 0 at midnight. 

00:00:00 

 

How does your expression look like? 

 
_____________________________________________________________. 
 

• Set Output Attribute to Delivery Plan. 
 

• We want to do our calculation every 4 hours, and the result will be written 
with a timestamp that is four hours into future. Set Scheduling to Periodic. 
Click Configure to set a four-hour interval. Do not specify an offset, so the 
calculation is performed at the full hour. 
 
To write the results with a future timestamp, select Advanced… and set 
Relative to Trigger Time to *+4h. Check in. 
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• In the Navigator pane, select Management to list all analyses for the 8 trucks. 
 

• Enable checkbox in the top row to select all analyses. Select Backfill checked 
analyses operation. Set start to y and end to *. Then click on Queue to start 
the backfill process. 
 

 

 

  



Taking Full Advantage of AF Functionalities 

 

Page 225 

 

After the backfilling is completed, verify the results as follows: 

• Open one of the trucks under the Elements of the ABC Mining Company 
database. 
 

• Select the lines with the Delivery Plan and the Load attribute and select  
Trend from the right-mouse button context menu. 
 

• Set Start Time= y and End Time= *+4h and click on  Refresh button. 
Verify the trend curve with the forecast values: 
 

 

 

Tip: For some trucks, actual Load and corresponding plan data value can be very close 
together. You can zoom into the trend by dragging a rectangle. To revert to initial scaling, click 

on the  Refresh button. 
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8.4.3 Display of Attributes with future and historical data in Processbook (optional) 

• Open the ABC Mining Trucks Material Delivery.PDI file (located in the 
class\exercises folder) in Processbook.  
 

• Under View of the Processbook menu, enable Element Relative Display to 
open the Element Relative Display window pane.  
 

• Click on the Find and Add New Element Contexts button to open the Element 
Search dialog.  
 

• Select the ABC Mining Company AF database and search for the trucks with 
the name search pattern SP*.  
 

• Select the eight trucks SP1 – SP8 from the search results list and click on 
OK.  
 

• Select one of the trucks. The trend displays the data for a time period from 24 
hours back into the past until 24 hours into the future:  
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9. Communicating Important Events 

Notifications, which is a feature in Asset Framework, allows alerts to users in real 
time about conditions in their system that need specific attention. Corresponding 
actions can be taken to be pro-active or to resolve the problem of the current 
situation. The information is either sent via email or is passed onto a Web Service. 

The recipients for the notifications (“subscribers”) have the option to acknowledge 
notifications. In case a situation, that requires action, is not acknowledged in time, 
notifications can be sent out again.     

Examples for the use of notifications are: 

• Temperature is outside the normal range 

• Equipment is shutdown 

• Runtime counters have elapsed indicating a maintenance is required 

• Amount of supply material is below a critical minimum level 

Note: Notifications have been revised in the AF 2016 R2 version. In previous versions, there 
was a different concept for the Notifications, which is now referred to as “Legacy Notifications”. 
When upgrading the PI System to 2016 R2, existing legacy notifications can be migrated to the 
new concept using a dedicated migration tool. 

9.1 Introducing Notifications 

With AF 2016 R2, notifications are triggered when new Event Frames are generated 
in AF. Conditions for the trigger are defined in notification rules.  

The event frames generation may be related to different sources. It can be 
performed by asset analytics, by an Event Frame Generator (EFGen) interface, by a 
custom AF SDK application or a manual creation.  
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9.1.1 Notification Components 

 

PI Notifications Service 

The PI Notifications Service processes event frames defined in the Asset Framework 
(AF) in real-time and sends out email and web service notifications. The service is 
installed from the AF Server 2016 R2 Install Kit. 

 

Notification Rule tab (PI System Explorer) 

Notification Rules can be defined for individual elements or be created as a template. 
The User Interface for configuring notification rules in PI System Explorer is in a 
dedicated tab on elements and element templates: 

   

Note: There is no entry for Notifications in the PI System Explorer Navigator (bottom left corner) 
any more. 

The definition includes the trigger criteria, adding subscribers to the notification rule, 
and formatting the message to suit the needs of your organization. 
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Management Plug-In (PI System Explorer) 

• Allows management of analyses and notification rules on the AF Server. 

 

9.2 Delivering the Events 

Notifications Delivery Channels provide for the mechanism by which alerts are 
delivered to subscribers. With the standard installation of Notifications, the following 
delivery channels are available: 

• Email 
 
Email delivery channel supports sending emails with notification alerts via an 
SMTP Mail Server. 
  

• Web Service 
 
Web service channel supports providing information to a web service by 
calling one of its methods. 

Note: Legacy Notifications in earlier AF versions also supported OCS and Custom delivery 
channels. These are not supported with the new Notifications in AF 2016 R2. 
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9.2.1 Email Delivery Channel 

The settings for the Email delivery channel allow you to configure the primary and 
backup SMTP server to relay the emails as well as the “From” email address for the 
alerts. The IT department should indicate which servers and ports to use for the 
primary and backup SMTP servers. As for the “Sender Email”, this address is not 
validated and can thus be set to any address desired (i.e.: 
PINotifications@domain.com). In most cases, the Allow contacts to set sender email 
should not be enabled. 

Note: In the Azure-based learning (VLE) setup use notifications@pischool.int.  

 
 

Once the email delivery channel is setup, most email addresses should be provided 
by Active Directory (AD). If the AD does not include all email addresses needed, it 
will be possible to create additional emails within the Contacts section of PSE.  

  

mailto:PINotifications@domain.com
mailto:notifications@pischool.int
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9.2.2 Directed Activity – Email Delivery Configuration and Checkout 

 

In this part of the class, you will perform a learning activity to explore the 
different concepts presented in this chapter or section. You may be invited to 
watch what the instructor is doing or perform the same steps at the same time. 
Your instructor will have directions. 

Activity Objectives 

• Understand the required settings for the email delivery. 

Approach 

1. From PSE, select Contacts in the Navigator and navigate to Tools > Delivery 
Channel Plugins, then from the Email Delivery Channel Plug-In context menu 
select the Settings. 

 

 

 

2. In case of the Azure-based learning (VLE) setup, the mail server is installed 
on PISRV01. 

Note: The mail server on PISRV01 is configured just for some user accounts in the pischool.int 
domain.  
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3. Click on the Test… button to send a test email to student01@pischool.int. 
 

 

 

4. Start Microsoft Office Outlook and verify reception of the test email. 
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9.2.3 Web Service Delivery Channel 

The web service delivery channel allows Notifications to contact and provide 
information to a web service by calling one of its methods. To use this delivery 
channel, a web service must thus be available on a web server. 

About Web Services 

A web service is a method of communication between two electronic devices over the web. In 
most cases, it is a service hosted on a web server that provides methods to its clients. Those 
methods will usually wait for incoming information from one end, then crunch the data, to finally 
return the data to the same client or pass that information to another one. 

There are many web services commercially available, and many development 
environments offer templates and other tools to develop custom Web services. 

Example: A custom Web Service could process the received information and 
generate corresponding work orders in a customer Maintenance System: 
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9.3 Configuring Notifications 

Configuring a notification rule includes specifying the trigger criteria, adding 
subscribers to the notification rule, and formatting the message to suit the needs of 
your organization. 

1. Select element or element template on which Notification Rule will be 
created 

2. Create a new Notification Rule: 

a. Define the notification trigger conditions 

b. Add the subscribers 

c. Format the Notification message 

3. Test the Notification 

 

 

 

Note: If you have created a notification rule for an individual element, you can extend the scope 
to the corresponding element template by using the Convert to Template function. 
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9.3.1 Trigger Conditions 

The Notification Rules define the criteria that identify, which event frame generation 
will initiate a new notification. 

There are two possible trigger criteria modes for the Notification Rules: 

• Analysis 

• Event Frame Search 

 

Use the Analysis mode to trigger a notification rule on event frames generated by a 
particular analysis. 

 

 

 

Use Event Frame Search mode to trigger a notification rule based on event frame 
name, template and category. In the Event Frame Search mode, you can select a 
configured event frame template, from the drop-down list, and then configure the 
name and category for the event frames that will trigger your notifications. The name 
may contain wildcard characters that are supported by event frame search. 

 

 

 

For both the modes, you can add additional trigger criteria using event frame 
attribute values. Criteria can be any specified for any attribute in the event frame 
template that is specified in the notification rule trigger criteria. For example, if your 
event frame template defines an event like "downtime" but you only want an email 
about "unplanned" downtime, you can configure an attribute value condition where a 
"reason code" attribute on the "downtime" event frame template has a value 
indicating "unplanned" downtime. 
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Note: Very often at work, the measure of success is made on how many things are produced. 
For Notifications, the more alerts that are produced, very often the less successful the use of 
Notifications becomes. If too many alerts are provided to a recipient, she/he probably won’t be 
able to give each one of them the appropriate attention or response. This will make the 
implementation useless, as all of the alerts will become noise to the recipients.  

 

9.3.2 Directed Activity –Triggering the Alerts 

 

In this part of the class, you will perform a learning activity to explore the 
different concepts presented in this chapter or section. You may be invited to 
watch what the instructor is doing or perform the same steps at the same time. 
Your instructor will have directions. 

Activity Objectives 

• Create an analysis for event frame generation and build a corresponding 
notification rule on it. 

• Define notification trigger conditions. 

• Add a subscriber who will receive the notification. 

Problem Description 

We will configure notification for the tanks at Velocity Terminals. This notification will 
inform whenever tank levels are outside the target operational levels (either too low 
or too high). The notification is required only for the tanks containing HC1500 
because inappropriate quantities for that product is causing issues. If the tank is 
almost empty, the coating inside can corrode and will need treatment. If the tank is 
almost full, there is a risk that the material spills and causes environmental damage, 
which is even more critical. 

The emails alerting about the limit violation should include the values of the level as 
well as the value of the temperature, because this information is needed to assess 
the condition of the liquid in the tank.  

Under the Tank Element Template, we will create an analysis to create event-
frames, whenever level is outside the limits. Notification Rules will be created to 
trigger notifications when new events occur and the material is HC1500.    
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Approach 

Event Frame Template 

1. Open Velocity Terminals database in PSE, select Library in the Navigator and 
select New Template under Event Frame Templates. 

2. For the name enter Tank Level Excursion 

3. For the description enter Tank Level Outside Operational Targets 

4. For the naming pattern enter  
 
%TEMPLATE% for %ELEMENT% (%STARTTIME:yyyy-MM-dd HH:mm%) 

 

Once an event frame is created, what will the event frame names look like? 
 
____________________________________________________________ 

 

 

5. Check the option for Can Be Acknowledged 

6. Click on OK 
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Event Frame Attribute Templates 

7. Select Attributes Templates tab. Select New Attribute Template. 

8. Add attributes for Level, Temperature, Product and Level Excursion 
 

Attribute 
Name 

UOM Data 
Reference 

Value 
Type 

Settings… DisplayDigits 

Level percent PI Point Double .\Elements[.]|%Attribute%; 
TimeRangeMethod=StartTime 

2 

Level 
Excursion 

<none> <none> String  NA 

Product <none> String 
Builder 

String .\Elements[.]|%Attribute%; NA 

Temperature Degree 
Celsius 

PI Point Double .\Elements[.]|%Attribute%; 
TimeRangeMethod=StartTime 

2 

 

Tip1: Once you have entered the Level attribute you can use the Copy and Paste function to 
create another PI Point attribute which you can use to edit to create the one for Temperature 

Tip2: You can enter the setting for the Product attribute manually. Alternatively, select an 
attribute value from the menu and edit accordingly. Make sure the setting matches exactly to the 
above information. 

 

The Level Excursion attribute will be used to indicate, whether either the 
high or the low limit was violated. Setting the value for this attribute will be 
defined later on when configuring the analysis for the corresponding event 
frames generation.  

9. Check In 
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Analysis for Event Frame Generation when limits are violated 

10. Select Tank from Element Templates 

11. Select Analysis Templates tab and click on the blue link to Create a New 
Analysis Template. 

12. For the name enter Limit Monitoring 

13. Select analysis type Event Frame Generation 

14. For the example element select one of the tanks (e.g. Tank01). 

15. For the Event Frame template, select Tank Level Excursion: 

 

 

16. Rename Start Trigger 1 to Too High. Enter expression: 
'Level'>'Level|HiHi' 
 

Set severity to Critical. 
 

17. Add a new Start Trigger, set the name to Too Low. Enter expression:  
'Level'<'Level|LoLo' 
 

Set severity to Major. 
 

18. Whenever the level changes, we want to check whether any of the limit was 
violated. Therefore set Event-Triggered for Scheduling. 

Note: The scheduling defines how often the triggers will be evaluated. If this option is Event-
Triggered the triggers will be evaluated whenever there is a change for the attributes in the 
Trigger Expressions. This is usually how Analytics are executed if attributes are PI Point data 
references. Use Periodic in case the attribute is of another data reference (e.g. Table Lookup). 
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19. Click on Advanced Event Frame Settings...Check Save Trigger name to 
event frame attribute. Click on Map Attribute and select Level Excursion 
attribute. Click on OK. 

 

 

Note: the Warning  
“The selected attribute template will be converted to a Configuration Item and any existing 
configuration of the attribute template will be lost.”  
can be ignored. 

20. Check In. 
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Simulate the level is above the limit 

Note: The simulation for the level of Tank01 cycles the value every 10 minute with a violation of 
the low and high limit. You can either wait some time, so that the required value change occurs 
automatically, or you can force it with a manual entry. Note that a manual entry may be replaced 
by a new value from the interface too early to start the event frame 

21. Select Elements – Velocity Terminals - Locations - Montreal - Tank01 

22. Select Level Attribute – Settings 

23. Uncheck Read-Only. 

24. Select Product Attribute and change to HC1500 (we need that for later). 

25. Check In. 

26. Enter 98 into the Value for the Level attribute 

Verify generation of event frames when limits are violated 

27. Select Elements in Navigator Panel, navigate to Tank01 and select the 
element. 

28. Click on the blue Event Frames link on the General tab. 

 

 

Tip: You should have an event frame for Tank01. If there is no event frame, the reason might 
be, that the tank was actually already outside the limits. Re-enter a value.  
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29. Click on the Wheel icon  in the header line of the results.  

Click on Select Attributes. Click on  icon to add all four (4) attributes from 
the Tank Level Excursion event frame template. Click on OK. The list will be 
extended by the four selected attributes. Click on OK. 
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Create a Notification Rule 

30. Select Tank from Element Templates. Select Analysis Templates tab, select 
the Limit Monitoring Analysis. 

31. Click on the blue link to create a new notification rule template 

 

 

32. On Notification Rule Templates tab change the name to  
Critical Level Notification 

33. In the Trigger section, select the blue View/Edit Trigger link. 

34. Select the link to add attribute criteria  

35. Add Product Equal HC1500. Click on OK. 

 

 

36. In the Subscriptions section, select the blue View/Edit Subscriptions link. 

37. Expand student01 so that the email occurs and drag it into the Subscriptions 
section. Click OK. Check In. 

 

38. Start Outlook for student01.  

39. Change the value for the Level attribute of Tank01 to 99 and verify that you 
receive an email. 

Note: give the system some time to send out the email. It can even take up one to two minutes 
before the email arrives.  
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9.3.3 Trigger Criteria Options 

When the Trigger Criteria are defined, following options can be set: 

 

 

 

Resend Interval 

The time interval after which PI Notifications Service will send additional alerts until 
the event frame matching the notification rule is acknowledged or closed. 
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Non-Repetition Interval 

The time interval during which PI Notifications Service will not send similar alerts 
associated with the same notification rule. 

 

 

 

Event Frame Can be acknowledged 

Option to enable event frame to be acknowledged; the event frame template is also 
modified accordingly. This option is automatically selected if the event frame 
template has been configured for acknowledgement 

 

Severity Option 

This option applies only to event frame generation analyses. If you have configured 
multiple start triggers for your analysis, you may choose to be notified in these ways: 

• When the current trigger severity is higher than any trigger severity 
encountered so far. 

• When the current trigger severity is higher than the previous trigger severity. 

• Every time a trigger condition is true, regardless of its relative severity to 
other previous triggers. 
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9.4 Formatting the Information to Deliver  

The Notifications software includes a complete formatting tool, which enables you to 
define the formatting, and information that is included in email alerts. 

Global Default Formats 

The system provides one global format that is used as the default format. You can 
edit or rename the global format, but cannot delete it. Additional formats can be 
added. To access global default formats, navigate to Tools -> Global Formats . 

 

 

Custom Delivery Formats 

To edit or add specific Custom delivery formats for a particular Notification Rule, 
select the blue Message Formats link. The formats can be distinguished by their 
corresponding icons: 
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9.4.1 Directed Activity – Message Formatting 

 

In this part of the class, you will perform a learning activity to explore the 
different concepts presented in this chapter or section. You may be invited to 
watch what the instructor is doing or perform the same steps at the same time. 
Your instructor will have directions. 

Activity Objectives 

• Prepare a message-formatting templates for email message delivery. 

Approach 

1. From PSE, navigate to Tools > Global Format. 

2. Select the line with Global Default Email (color changes to light blue), and 

click on the Duplicate  icon above. Rename the new format as “Default 
Email with Table”. 

 

About Formatting Messages 

The Formats window has a Content section on the right side to add extra content to the 
message. From that Content pane, simply drag and drop, or double-click on the desired content 
to add it to the message. Only generic content can be added within the Global Formats section. 
Specific content can be added when configuring the Message tab for a specific notification rule 
or a notification rule template. 
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3. Select the Default Email with Table format and modify the formatting so that a 
table will be available to organize the information related to the notification. 
(See figure below) 
 
To add a table, use the controls highlighted in the screenshot above. When 
you add the Hyperlink, select the option to send the link as text: 
 

 
 
We will be able to use the link and open a related display in PI Vision. When 
sending an email to someone outside the organization with no access to PI 
Vision use the option to send a screenshot. 

Note: the mail server used in the AF class VLE environment does not support to include 
screenshots in the email! 

 

4. To perform a test send click on the    button.  
For the Email address, enter student01@pischool.int: 
 

 
 

5. Click OK. 
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9.4.2 Directed Activity – Configuring the Tank Level Excursion Notification Messages 

 

In this part of the class, you will perform a learning activity to explore the 
different concepts presented in this chapter or section. You may be invited to 
watch what the instructor is doing or perform the same steps at the same time. 
Your instructor will have directions. 

Activity Objectives 

• Compose notification messages from message format templates. 

Approach 

We want to define a particular format for the emails alerting about limit violations to 
send to our recipients. The message format includes a table with the values of the 
level and the temperature. The message should also provide a link into PI Vision 
allowing an acknowledgement as well as a display for the time after the limit was 
violated.   

1. Select Tank from Library -> Element Templates, open the Notification Rule 
Templates tab. 

Tank Level Excursion – Email with Table 

2. Click on the blue Manage Formats link in the Subscriptions section. Select 
the line with Default Email with Table (color changes to light blue) and click 

on the Duplicate  icon above. Rename the duplicated format as Tank 
Level Excursion - Email with Table. 
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3. Add the appropriate information to the table by dragging and dropping or 
double-clicking on the information from the Content pane on the right hand 
side. The second row of the table should include the Level information while 
the third row should include the Temperature information. If completed, click 
on OK 

 

4. In the Subscriptions section on the Notification Rule tab Click on the blue 
View/Edit Subscriptions link. 

5. In the line for student01 select Tank Level Excursion - Email with Table in 
the Configuration column. Click on OK. Check In. 

6. Verify with Outlook whether the new notification emails have the new 
requested format. 
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9.5 Acknowledging Notifications 

Acknowledgements of Notifications can be used to confirm that important 
notifications are read and acted on. 

Note: A pre-requisite for the Acknowledgement feature is that the Can be Acknowledged setting 
in the event frame template has been checked. 

Ways of Acknowledging 

Acknowledgment can be performed in two ways: 

• Display the event in PI System Explorer (Event Frame Search Result). Select 
the context menu function Acknowledge… 

 

 
 

When acknowledged, the red exclamation mark  changes into an . 
When you hover with the mouse over the OK you get information about who 
and when the acknowledgement was made. 
 

 
 

  

• Open the corresponding Event details display in PI Vision. Click on the 
Acknowledgement link for the event frame. 
To display the corresponding event details, either follow the Event Details link 
in the notification email or use the event search options in PI Vision. 
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9.5.1 Directed Activity – Commenting and Acknowledging Events 

 

In this part of the class, you will perform a learning activity to explore the 
different concepts presented in this chapter or section. You may be invited to 
watch what the instructor is doing or perform the same steps at the same time. 
Your instructor will have directions. 

Tank01 in Montreal is critical for the whole operation at that site. If the material level in that tank 
is not proper, it is the duty of student01 to add a comment on the problem and to acknowledge 
the notification to document that action has been taken. 

 

Activity Objectives 

• Read the information in the latest notification email for Tank01 and open the 
event details in PI Vision 

• Enter a comment on the current level status and acknowledge the alert. 

 

Approach 

6. In Outlook, open the latest notification email for Tank01. 
(If the email is quite new there is a high chance that the level has not yet 
returned to normal level since it started to violate the limit.) 

7. Click on the blue Events Details Hyperlink link. Details page for the event will 
be displayed in PI Vision. 
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8. If the level is still outside the limits, the event is still ongoing. In that case, the 
end time is displayed as In Progress. In case you continue to observe the 
display for some time, the time span covered in the trend will increase until 
the level returned to normal (PI Vision update rate is 15 seconds). 

 

 

 

9. Add and remove trend lines by selecting and unselecting them in the list 
below the trend.  

 

10. Add a text into the comment field and click on the Add button to enter. 
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11. Click on the Acknowledge button to acknowledge the event. Information 
about the notifications being sent, the comment and the acknowledgement 
are shown in PI Vision. 
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9.5.2 Directed Activity – Validating the Acknowledgment Process 

 

In this part of the class, you will perform a learning activity to explore the 
different concepts presented in this chapter or section. You may be invited to 
watch what the instructor is doing or perform the same steps at the same time. 
Your instructor will have directions. 

Exercise Objectives 

• Compare the commenting and acknowledgment of notification alerts in PI 
Vision and PI System Explorer. 

Approach 

1. Open the PI System Explorer and select Event Frames in the Navigator. 

2. Select New Search… from Event Frame Searches context menu 

3. Set Search to: Starting After 

4. Set Search Start to: *-30m 

5. Set Template to: Tank Level Excursion. Click on Search.  
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6. Click on the Wheel icon  in the header line of the results.  

Click on Select Attributes. Click on  icon to add all four (4) attributes. Click 
on OK. The list will be extended by the four selected attributes. Click on OK. 

 

 

7. Rename default Search name to Tank Level Excursions Last 30 Minutes 

8. Verify whether the event frames with Product= HC1500 have an annotation 
icon. If you hover over the Annotation icon it displays Notification sent to 1 
subscriber(s). 

 

 

9. Verify that comment and acknowledgement information from the previous 
exercise is displayed in PI System Explorer. 

10. To acknowledge alerts in PI System Explorer, select one or several lines of 
the event frame list. From the context menu, select Acknowledge… The icon 

in the acknowledgement column changes from Unacknowledged  to 

Acknowledged . 

  



Communicating Important Events 

 

Page 257 

 

9.6 Adding Contacts 

The Contacts section of the navigator panel of PSE allows for the definition of 
contacts. The contacts will be receiving the notification messages once they are 
triggered. This section defines the various types of contact objects that can be 
created and used by Notifications. 

9.6.1 Active Directory (AD) access for contacts 

Notifications normally gets the contacts and their addresses from the configured 
domain AD database. This prevents the administrator from having to do the tedious 
task of entering all of the potential subscribers and their contact information in order 
to start using Notifications.  

Each AF server provides the option to specify the domain and contact sub-folder, as 
well as the account needed to access Active Directory and retrieve contact names. 
By default, the account under which the AF server application service is running is 
used for Active Directory access. The AD access is configurable in the AF Server 
Properties dialog box (with Contacts being selected in the Navigator, go to Tools > 
Active Directory Properties). 

 

By default, the AF server is installed using a virtual account,  
NT SERVICE\AFService. However, the AF server service account can be changed. 
If the AF server service account does not have the necessary permission to read the 
Active Directory, no contact names will be retrieved in the Contacts list. If your Active 
Directory security is configured to allow the AF server service account to read the 
Active Directory, this is the simplest option. 

In the Active Directory Domain Name text box, enter the full DNS name of the Active 
Directory domain from which the contact names will be retrieved for the PI 
Notifications Service Contacts. 

In the Active Directory Contact Sub-Folder text box, enter the path to the folder 
containing the list of contacts for this domain. In larger Active Directory domains, 
contacts may be organized within sub-folders. The use of sub-folders can allow for 
faster retrieval of a list of Active Directory contacts. 



Building PI System Assets and Analytics with PI AF 

 

Page 258 

 

9.6.2 Searching for Contacts 

Because the AD database are often very large, contacts information is only available 

from search results. To search for contacts, click the  button under the 
Contacts section or use the search field. The star (*) can be used as a wildcard for 
that search. In case of the Azure-based learning (VLE) setup a search for student* 
will return all the student AD users (student01, student02, student03, student04). 
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9.6.3 Directed Activity – Adding Contact Information 

 

In this part of the class, you will perform a learning activity to explore the 
different concepts presented in this chapter or section. You may be invited 
to watch what the instructor is doing or perform the same steps at the same 
time. Your instructor will have directions. 

Activity Objectives 

• Create a new contact for Notifications. 

Problem Description 

For those who do not have entries in AD you can enter custom contacts one at a 
time. This may be appropriate for vendors or other contacts not in your company who 
you may want to receive notifications. Custom contacts are available to all AF 
databases. 

Approach 

Adding a custom contact in PSE: 

1. To create a custom contact, select Contacts from the navigator panel. 

2. Select New > New Contact from the toolbar and enter your name for the 
contact Name. 

3. Right click the contact for you and select New Delivery Endpoint 

4. Enter a delivery endpoint name (e.g. <your name> at Work). From the 
Delivery Channel dropdown, select Email.  
Fill in your work email address and check in your changes. 

 

5. (optional) Enter a second delivery endpoint for the home email address. 

Note: in the Azure-based learning (VLE) setup there are only some email addresses in the 
pischool.int AD you can actually use for sending emails to. Refer to the corresponding 
information in the Exercise section at the end of the book.  
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9.6.4 Notifications Groups 

A Notifications Group is an unordered collection of delivery endpoints, which includes 
Active Directory recipients. If a notification is configured to send a message to a 
Notifications Group, the message is sent to all members of the group simultaneously.  

9.6.5 Notifications Escalation Teams 

An escalation team is a delayed delivery group, which receives alerts on a 
notification only if a specified time period called the Escalation Period has elapsed, 
and the acknowledgement requirement is not satisfied. Acknowledgments will be 
discussed in a later section, but it is the ability to inform the Notifications server that 
the alert was acknowledged by a contact. 

A notification alert is sent to the first contact on the list. If the notification is not 
acknowledged within a specified time, then notification messages are sent 
sequentially to the remaining members of the escalation team until the notification 
instance is acknowledged. 

Building escalation teams is very similar to building groups and so they can be 
included in the subscribers’ area of a notification. Keep in mind that if an escalation 
team is added to a notification, that does not require acknowledgements, they will 
never receive alerts.  

9.6.6 Subscribing Contacts to Notifications 

To maintain subscribers of a notification, navigate to the Notification Rules tab for a 
selected element or a selected element template, and then click View/Edit 
Subscriptions in the Subscriptions pane. 

To add contacts, endpoints or groups to existing notifications, drag and drop them 
into the Subscriptions list. To remove, select a line with a subscription and click on 
the Unsubscribe icon on the top. 

9.6.7 Dynamic Endpoints (since AF 2017 R2) 

You can configure an email delivery endpoint as a value of an attribute. This 
provides an additional flexibility in situations where notification emails can be sent to 
different recipients without making changes to the notification rule template.  
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9.6.8 Directed Activity –Sending Notification Alerts to different email addresses 
depending on the current time 

 

In this part of the class, you will perform a learning activity to explore the 
different concepts presented in this chapter or section. You may be invited to 
watch what the instructor is doing or perform the same steps at the same time. 
Your instructor will have directions. 

Exercise Objectives 

• Create an analysis to define an email address depending on current time. 

• Switch email recipient for notification emails  

Problem Description 

To balance the workload for the people responsible to handle tank level excursions, 
the notification emails should be sent to different email addresses depending on the 
actual clock time according to the following rules: 
 

 

Note: The above rule is likely not a typical real situation, but has rather been selected to allow a 
convenient check-out during the class training.  
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Approach 

 

Create an Analysis to set the email address according to the time 

 

1. Open the PI System Explorer and navigate to the Tank element template. 
Create a new analysis, Email Address Setting. 
When you map the output, select the option to save output history. Set the 
value type to string. For scheduling, select period of 30 minutes, no offset. 
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Tips: 

• '..\|SiteID' refers to the attribute SiteID in the parent element of 

the tank (which is the site) 

• To start a new line, use Shift-Enter. 

• Do not use blanks for the Variable names. 

• To check the analysis, select an example element and run Preview 
Results. 

• To get initial value for the Notification Email Address (is calculated 
only every 30 minutes), switch to management tab and perform a 
Backfill for the last hour. 
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Create a dynamic endpoint that refers to the Notification Email Address 
attribute and create a related subscription.  

 

1. Select Library in the Navigator and open the Notification Rule Templates for 
the Tank element template. 

2. Click on the blue View/Edit Subscriptions link 

3. Expand Dynamic Endpoints in the Contacts section and select Notification 
Email Address from the dropdown of the attribute list. For the Endpoint 
Name, enter Dynamic Notification Email Address. Click the Create button. 
 

 

Note: the Warning  
“Value must be a valid email address at delivery time.”  
can be ignored. 

4. Select the line with the existing subscription and click on the Unsubscribe  
icon on the top. 

5. Expand Dynamic Endpoints in the Contacts section and drag Dynamic 
Notification Email Address to the Subscriptions list. Click on the dropdown 
icon in the Configuration column and select Tank Level Excursion - Email 
with Table. 

6. Click on OK to exit the View/Edit Subscriptions dialog box. 

7. Check in the changes. 

8. Verify whether email delivery is performed as intended. (requires you keep 
system running for a while).  
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9.6.9 Directed Activity –Sending Notification Alerts in Escalation Sequence (optional) 

 

In this part of the class, you will perform a learning activity to explore the 
different concepts presented in this chapter or section. You may be invited to 
watch what the instructor is doing or perform the same steps at the same time. 
Your instructor will have directions. 

Exercise Objectives 

• Assign several contacts to an escalation team 

• Understand and apply options for an escalation team. 

• Explore the sequence of notifications for an escalation team. 

Problem Description 

You want to change the strategy, which people in the organization are informed in 
case of a level limit violation. In order to avoid a transitional period, you want to 
suspend the notification emails during the time, when you reconfigure the system. 

Two people from the operational personnel, the tank operator and the safety 
engineer) can handle the situation when the tank level has exceeded a limit. The 
tank operator should be informed first. In case he does not take action within 5 
minutes, the safety engineer should be informed as well. Do not send email to 
student01 anymore. 

Use the following email addresses: 

Tank Operator: student02@pischool.int 
Safety Engineer: student03@pischool.int 

Note, that if you are executing this exercise in a local language environment, email addresses 
for local language accounts corresponding to student02 and student03 are not supported.  

Approach 

1. Open the PI System Explorer and select Management in the Navigator. 
Choose Notification Rules type. 

 

Note: The status displayed here is based on the notification rule configuration only. The status 
does not give information on whether the notification is running or in error. 
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2. Enable the check box in the header line to select all notifications for the ten 
(10) tanks, then click Disable selected notification rules. 

Tip: By selecting any combination of lines with rules, you can start or stop the selected rules. 

3. Select Contacts in the Navigator. 

4. Create a new escalation team called Tank Personnel Escalation Team by 
right clicking the Escalation Teams folder and selecting New Escalation 
Team. 

5. Add the tank operator (student02@pischool.int) as well as the safety 
engineer (student03@pischool.int) and select a 5 minutes Escalation period. 
Do not repeat the escalation sequence, if the alert was not acknowledged.  

 

 

6. Select Library in the Navigator and open the Notification Rule Templates for 
the Tank element template. 

7. Click on the blue View/Edit Subscriptions link 

8. Expand Escalation Teams in the Contacts section and drag Tank Personnel 
Escalation Team to the Subscriptions list. Click on the dropdown icon of the 
team name to expand the team members. Select Tank Level Excursion - 
Email with Table for both. 

9. Select the line(s) with the other subscriptions and click on the Unsubscribe 

 icon on the top. 

10. Click on OK to exit the View/Edit Subscriptions dialog box. 

11. Check in the changes. 

12. Select Management in the Navigator. Start the notifications in the same way 
as they were stopped before. 
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Question for different Escalation Option Settings 

Assume you have set to repeat the escalation three (3) times, in case it was not 
acknowledged. How many emails will be sent out, if no action is taken by the 
operators and the violation is there for more than an hour? When will the last email 
be sent? 

Answers:  _____ emails will be sent, the last email is sent ______ minutes after the 
problem started. 

 

Explore the escalation sequences (optional) 

After some runtime (> 30 minutes), several new level limit violations will have 
happened for Tank01 and Tank02.  

Note: The simulation of the tank levels repeats the same pattern all over again. The cycle times 
depend on the tanks. Tank01: 10 minutes, Tank02: 30 minutes, Tank03…Tank10: > some 
hours.  

1. Select Event Frames in the Navigator. 

2. List the event frames for the Search named Tank Level Excursions Last 30 
Minutes (if still displayed from previous activities, click on the Refresh button 
in PI System Explorer Toolbar) 

3. Select a completed event frame (End Time not empty) for a Low Limit 
Violation of Tank02. Select Annotate… from the context menu. The 
Annotations lists the email sequence. 

 

 

 

Hint: Click on the Wheel icon  to show a column with Description information to get more 
details on the email that was sent.  

4. Select a completed event frame for Tank01. Can you describe why no 
escalation was sent? 
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9.7 Delivering Notifications via a Web Service 

9.7.1 Web Service 

The web service delivery channel allows Notifications to contact and provide 
information to a web service by calling one of its methods. To use this delivery 
channel, a web service must thus be available on a web server. 

About Web Services 

A web service is a method of communication between two electronic devices over the web. In 
most cases, it is a service hosted on a web server that provides methods to its clients. Those 
methods will usually wait for incoming information from one end, then crunch the data, to finally 
return the data to the same client or pass that information to another one. 

There are many web services commercially available, and many development 
environments offer templates and other tools to develop custom Web services. Just 
to have an idea of a Web service, the http://www.webservicex.net/ website offers 
samples like a Global Weather web service.  

The configuration necessary to send information to a web service via Notifications 
will be done when creating a new Delivery Endpoint of type WebService from the 
Contacts section of the navigator panel in PSE.   

9.7.2 Web Service example: The Work Order Generator 

This is a custom web service designed to act as an automatic work order generator. 
Imagine a notification that would trigger whenever a piece of equipment needs 
maintenance. Via the web service, the notification would pass all necessary 
information to the maintenance system so a work order can be generated. For this 
training, a SQL Server database called “WorkOrderGenerator” will act as the 
maintenance system. This database is hosted on your local SQL Server instance. 
The web service itself should be available at the following URL: 

http://localhost:85/WorkOrderGenerator2013/Service1.asmx 

 

 

 

http://www.webservicex.net/
http://localhost:85/WorkOrderGenerator2013/Service1.asmx
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9.7.3 Directed activity – Validating the Web Service Functionality (Optional) 

 

This solo or group activity is designed to maximize learning in a specific 
topic area.  Your instructor will have instructions and will coach you if you 
need assistance during the activity.   

Exercise Objectives 

• Understand the functionality of the sample Web Service for a Work Order 
Generator 

Approach 

The NewWorkOrder method allows a user or an application to create a new work 
order entry in the SQL Server database by passing the following information: 
equipment name, failure type and action to take.  

From the web page of the web service, click the NewWorkOrder method and enter 
something for the EquipmentName, FailureType and ActionToTake fields, then click 
the Invoke button. If the following shows up, then work order was successfully 
generated. Again, remember web services are not meant for user interaction. 

<?xml version=”1.0” encoding=”UTF-8”?> 
<int xmlns=”http://localhost/”>1</int> 

You can go ahead and query the WorkOrderGenerator SQL server database to 
confirm that the new work order was successfully created in the system. 

 

1. Open the Internet Explorer and got to: 
http://localhost:85/WorkOrderGenerator2013/service1.asmx 
(There is also a link for that under the favorites) 

2. Click on New Work Order. Enter the parameters: 

a. For the EquipmentName, enter Reactor1 

b. For the FailureType, enter Pressure Too High 

c. For the ActionToTake, enter Check Pressure Relief Valve 

3. Click on Invoke. Record the Work Order Number that is returned. 

4. Re-open the page (click on the favorites link again) and select 
GetEquipmentNameFromWorkOrder. Enter the work order number from the 
last step and submit. 

5. Open SQL Server Management Studio and connect to PISRV01.  

6. Expand  
Databases > WorkOrderGenerator > Tables > dbo.WorkOrderGen table. 

7. From the right-mouse button context menu, execute Select Top 1000 Rows. 

8. Locate the last entry to verify whether the new work order entry has been 
added. 

http://localhost:85/WorkOrderGenerator2013/service1.asmx
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9.7.4 Directed activity – Creating a WebService delivery endpoint (optional) 

 

This solo or group activity is designed to maximize learning in a specific 
topic area.  Your instructor will have instructions and will coach you if you 
need assistance during the activity.   

Exercise Objectives 

• Familiarize with the creation of a Web Service delivery point for the Work 
Order Generator. 

Approach 

To add a custom delivery endpoint in PSE: 

1. Select Contacts from the navigator panel. 

2. Select New Delivery Endpoint from the right-click context menu of the 
Delivery Endpoints folder. Enter the name Work Order and a description and 
select Web service delivery channel. Check-In. 

3. Enter the web service address 
http://localhost:85/WorkOrderGenerator2013/service1.asmx 
and click on Get Web Services 

4. Select NewWorkOrder from the drop-down options under Web method. 

 

5. Check in. 

http://localhost:85/WorkOrderGenerator2013/service1.asmx
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9.7.5 Directed activity – Automatically Creating a Work Order in the Maintenance 
System 

 

This solo or group activity is designed to maximize learning in a specific 
topic area.  Your instructor will have instructions and will coach you if you 
need assistance during the activity.   

Exercise Objectives 

• Set up different types of subscribers to a notification. 

• Demonstrate how Notifications can provide PI System information to a work 
order system. 

Problem Description 

In addition to alerting people by sending emails, you would like to create new entries 
in the work order database for the critical tank level events.  

Approach 

To add a subscription for another delivery endpoint in PSE: 

1. Select Library from the navigator panel and navigate to the Tank element 
template. Open the Notification Rule Templates tab. 

2. Click on the blue View/Edit Subscriptions link in the Subscriptions section. 

3. Expand Delivery Endpoints in the Contacts section and drag Work Order to 
the Subscriptions list. You are informed that you have to configure the Web 

Service:  

4. Click on the spanner icon and use drag and drop to set for the three (3) web 
service methods’ parameters:  

a. For the EquipmentName, set Tank name:Value At Start Time 
(from Element Template Attributes: Tank) 

b. For the FailureType, enter Event Frame:Name 
(from Event Frame Properties) 

c. For the ActionToTake, enter Level Excursion:Value At Start Time 
(from Event Frame Attributes: Tank level Excursion) 

 



Building PI System Assets and Analytics with PI AF 

 

Page 272 

 

 

5. Click on OK. 

6. Check In the changes. 

 

To verify the work order entries:  

After some runtime, several new level limit violations will have happened for Tank01 
and Tank02.  

1. Select Event Frames in the Navigator. 

2. List the event frames for the Search named Tank Level Excursions Last 30 
Minutes (if still displayed from previous activities, click on the Refresh button 
in PI System Explorer Toolbar) 

3. Select a new event frame. Select Annotate… from the context menu. The 
Annotations lists that notification has been sent to two (2) subscribers. 

 

4. Open SQL Server Management Studio and connect to PISRV01 and access 
the dbo.WorkOrderGen table contents again. Verify whether new work order 
entry/entries have been added. 

Note: the work order database accepts event frame names with a maximum of 50 characters. If 
names are too long, no entry is made is made in the table 
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9.7.6 Exercise – ABC Mining Company Notifications (optional) 

 

This solo or group exercise is designed to maximize learning in a specific 
topic area. Your instructor will have instructions and will coach you if you 
need assistance during the exercise.  

Exercise Objectives 

• Create a new analysis to detect tire pressure problems (implement into 
general truck template) 

• Create a new analysis to detect low gas level problems (implement into 
general truck template) 

• Distinguish the different root causes of truck problems 

• Create corresponding notification rules (apply to general truck template)  

• Create custom format to provide detail information about the issue in the 
notification email 

Problem Description 

ABC Mining Company wants to set up two types of alerts, which will be configured 
later for sending emails to the manager on duty (student01@pischool.int). 

ABC Mining Company management wants to be alerted under the following 
circumstances: 

• Tire Pressure is more than 3 psi below or above the nominal pressure value 
for more than 5 minutes. Severity for this problem is Critical. 

• If any vehicle’s gas tank has less than 50% gas left, they need to be aware so 
they can schedule a return to the refueling station. 
Severity for this problem is Major. 

Approach 

In order to build the analyses and notification rules that can be applied to all types of 
vehicles, the target element template must be one common to all vehicles (in this 
case the base template General Truck). 

1. Create a new event frame template Truck Operation Issue with following 
attributes: Actual Tire Pressure, Gas Tank Level and Issue Root Cause. 

2. Create a new analysis template Tire Pressure Monitoring. 

3. Create a new analysis template Gas Tank Level Monitoring. 

4. Create a new notification rule template Truck Problem Notification and use 
the Event Frame Search option to generate notifications whenever there is a 
new event frame based on the Truck Operation Issue template. Subscribe 
student01 to it. 
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5. Duplicate the Global Default Email format and change the new format Truck 
Problem Email so it will send emails of the following format: 

 

 

 

Use the following information how to set up the email fields: 

 

 

6. Assign the Truck Problem Email format for emails to student01. 

7. Check in. 
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10. AF Best Practices 

The following recommendations provide some guidelines on how to best setup your 
AF asset structure based on experience from existing AF installations. 

Be aware that in real life you cannot follow all these recommendations! 

 

• All elements should be based on a template 

Even if the template has no attributes in the beginning 

Easier maintenance 

• All elements at the same level should be of the same type 

Enterprise at the first level, Site the second level, Area the third, etc. 

Easier use of relative references from child-elements 

• Do not only consider Bottom-Up approach 

Try to achieve a well-designed structure, plan for the usefulness of the 
AF model 

• Categories for elements attributes and analyses 

Organizes large numbers of attributes/elements 

A fast way to search for elements and attributes 

• Always set the unit of measure explicitly 

PI Point attributes: set source unit for the tag 

Formulas: set units for all variables and the result 

Analyses: use the Convert() function 

Avoid defaults 

• Use inherited templates 

Allows Flexibility but keeps the standardization 
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• Build Different Views specific for your users 

Use element references 

 

 

 

 

 

 

• Use Enumerations 

Limit the choices that  
can be entered in attributes 

 

 

 

• Use Hierarchies of Attributes 

Group details or aggregations on a different level 

 

 

 

 

• Use all Data References 

Many options with Table Lookup and for String Builder 

 

• Keep relational data in relational database 

Link AF Tables to results and views 

Use Cache and Parameters  
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https://pisquare.osisoft.com/community/all-things-pi/af-library 

 

To improve your AF Skills visit the AF Community Library in PI Square!  

The library is full of tips and tricks, displays, hierarchies, and templates here. See 
what others are working, ask for feedback or collaboration, and start exploring how to 
use PI AF to address your business problems. 

To learn more about best practices with AF, explore the Asset Based Example Kits 
that are available from the AF Community Library! The Asset Based PI Example Kits 
are designed to help you learn how to apply asset- based PI to common, industry-
specific business objectives. 
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11. Final Exercise 

11.1 Modeling a Wind Farm in AF 

 

This solo or group exercise is designed to maximize learning in 
a specific topic area. Your instructor will have instructions and 
will coach you if you need assistance during the exercise.  

Exercise Objectives 

• Design a complete AF database. 

• Choose the optimum tools to perform the requested tasks efficiently. 

• Understand the difference between importing AF tables and linking Microsoft 
SQL Server tables. 

• Explore the AF attribute categories. 
 

Problem Description 

You have 50 Wind Powered Turbine units in your wind farm and you have Data 
Archive tags built for them. The engineers have interesting data in various 
spreadsheets. You also have maintenance data in a Microsoft SQL Server. You 
would like to integrate all that data into AF using a common template. 

Approach 

We will create an asset database primarily using the PI Builder tool. Much of the 
work will be accomplished within Microsoft Excel. 

There is a spreadsheet pre-configured for you to use in this exercise: 
TxLakeWindFarm_WPUs.xlsx 

The Data Archive tags used in this exercise are already created. 
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Modeling the assets 

1. Create a AF database TxLake Windfarm to represent the wind farm. 

2. A top-level element should be created under which you will create all the wind 
turbines (i.e. Wind Farm). 

 

 

3. Configure a Wind Turbine Template and create an element for the first wind 
turbine based on the template. 

 

 

 

4. Create two AF tables: WPU Models Specifications (information about the 
four wind turbine models is obtained from TxLakeWindFarm_WPUModels 
spreadsheet) and WPUs Identification (information about the fifty turbines is 
obtained from TxLakeWindFarm_WPUs spreadsheet). Both files are located 
in the C:\Class\Exercises\04_TxLake Wind Farm folder 

Hint: Information on how to import data from an Excel File into an AF Table can be found 
in the exercise solution section. 

5. Configure the necessary attributes to model the data available in the two 
tables. 

6. Create and configure the necessary attribute templates to model the real-time 
data coming in the Data Archive tags (TxLakeWindFarm_Tags.xlsx). 

7. Open the TxLakeWindFarm_WPUs.xlsx spreadsheet to see how many 
turbines this wind farm has and then use a blank spreadsheet to create the 
AF elements using PI Builder. The wind turbines are to be called 
WPU_TxLKE001, etc. and based on the same template. 

8. Validate that the wind turbines were created by opening PSE. 

Hint: Because the tag naming convention includes the wind turbine name, it is possible to use 
substitution parameters in the template to populate the PI Point data references. 

  

file:///C:/Class/Exercises/04_TxLake%20Wind%20Farm
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Importing SQL Server data 

9. Create a new AF table linked to the wind farm maintenance system (Microsoft 
SQL Server database: WindFarmMaint) 

· Under Table Properties, select Link. In the 
dropdown for Connection, select <Build>  

· Use the Microsoft OLE DB Provider for SQL 
Server driver. 

· Enter the Microsoft SQL Server instance 
name you noted at the beginning of this 
exercise. 

· Use Windows authentication. 

· Enter the Microsoft SQL Database name you 
noted at the beginning of this exercise 
 
 

 
 
 
 
 
 
 
 
 

· Link to the TxLakeMaint table (SELECT * 
FROM TxLakeMaint). 
 

 

 

 

10. Create and configure the necessary attribute templates to model the data available from 
the Microsoft SQL Server relational database. 

11. Create attribute categories to organize the attributes into logical groupings. 

 

About Attribute Categories 

Categories can be used for various AF objects, such as the attributes. Attribute Categories are 
used to group attributes together so it is easier to look, search or perform aggregations on the 
attributes of a AF model. Categories are not extensively used in client applications like PI 
ProcessBook or PI Datalink. However, certain analytics, like the roll-up calculation, take 
advantage of this feature. 
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Adding Analytics 

12. Add an attribute to show the last hour’s average generated power (kW). This is a running 
average over the last hour on the instantaneous generation attribute (.GenWatts tag). 
There is no need to archive the result of this calculation. 

13. Add an attribute to show the WPU effectiveness or yield (%) with the following formula. 
The results of this calculation should be historized. The calculation should be executed 
every minute. Backfill 1 hour worth of data for the first 10 wind turbines. 

Power / Rated Power * 100 

14. Calculate the Total Power Generated for the whole wind farm in MegaWatts by using a 
rollup analysis.  

 

Tracking important Events 

15. Lake Wind Farm’s engineers would like to keep track of high-speed winds; knowing the 
duration of wind gusts (speeds faster than 90 mph) is essential for performance analysis. 
Furthermore, engineers need to know what the average rotor speed and the maximum 
power generated are during a wind gust. Backfill the events for the last hour for all wind 
turbines. 

 

Visualizing the data (Optional) 

16. Complete the PI ProcessBook display TxLakeWindFarm_WPUStatus.pdi and make it 
Element Relative to monitor the wind turbines of the TxLake Wind Farm. 

17. Use PI Vision to visualize the high wind speed events. 
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12. Exercise Solution Section 

12.1 Azure-based learning (VLE) setup 

There is a dedicated setup in Azure (cloud based computing service from Microsoft), 
which is prepared to perform the exercises of this class. The setup consists of the 
following two machines: PIDC.PISCHOOL.INT (domain controller) and 
PISRV01.PISCHOOL.INT (application server). The training is carried out on 
PISRV01.  

The Windows domain accounts available for this training are: student01, student02, 
student03, and student04. For localized environments, the following accounts have 
to be used: 

German: de-student01, de-student02,de-student03, de-student04 
Spanish: es-student01, es-student02,es-student03, es-student04 
French: fr-student01, fr-student02,fr-student03, fr-student04 
Japanese: ja-student01, ja-student02,ja-student03, ja-student04 
Korean: ko-student01, ko-student02,ko-student03, ko-student04 
Portuguese: pt-student01, pt-student02,pt-student03, pt-student04 
Russian: ru-student01, ru-student02,ru-student03, ru-student04 
Chinese: zh-student01, zh-student02,zh-student03, zh-student04 

The Mail Server is configured to support the following student accounts: 
student01@pischool.int, student02@pischool.int, student03@pischool.int and 
student04@pischool.int. 
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12.2 Exercise Solution: Applying Expression Analysis Syntax  

Problem Solution Hints 

Get a ten-minute 
“rolling” average of the 
SensorX attribute 

TagAvg(‘SensorX’, ‘*-10m’, ‘*’) The TagAvg() function gives 
the average of a tag over a 
given time period. 

Get the time-weighted 
total for the SensorY 
attribute over the last 
24 hours, but only if at 
least 80% of the values 
used in the calculation 
are considered “good”. 

IF  
PCTGood(‘SensorY’, ‘*-24h’, 
‘*’)>=80 

THEN TagTot(‘SensorY ‘, ‘*-24h’, 
‘*’) 

ELSE NoOutput() 

or 

TagTot(‘SensorY ‘, ‘*-24h’, ‘*’, 80) 
 

 

If… Then… Else… statements 
can be used in the PE syntax. 

The PCTGood() function gives 
the percentage of “good” 
values for a tag. 

The TagTot() function gives 
the time-weighted total of a tag 
over a given time period. 

The amount of time the 
Mode attribute was 
“Manual” during the 
past four days. 

TimeEQ(‘Mode’,’t-4d’,’t’,”Manual”) TimeEQ() 

The amount of time returned is 
in seconds. 

Display “Overload” 
when the Level 
attribute is greater or 
equal than 90 , 
“Normal” when 
between 10 and 90 
(excluding the 
boundary values), and 
“Empty” when lower or 
equal than 10. 

If ‘SensorX’ >= 90 then 
“Overload” else if ‘SensorX’ <= 10 
then “Empty” else “Normal” 

If… Then… Else… require the 
ELSE clause to be present. 
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12.3 Exercise Solution: ABC Mining Trucks  

Step-by-Step Solution 

1. Create tags required for the exercise from the file 
ABCMiningCompany_Tags.xlsx located in 
C:\Class\Exercises\03_ABCMiningCompany (or the location specified by your 
instructor). 
(not required in case you are using the Azure-based learning (VLE) setup) 

 

2. Create two tables Truck Model Specifications and Truck Identification. 
To avoid manual entry, tables can be imported from files 
C:\Class\Exercises\03_ABCMiningCompany\Truck Identification.xml and 
C:\Class\Exercises\03_ABCMiningCompany\Truck Model Specifications.xml.To 
import the tables, select File > Import from file. Verify the result under Library 
> Tables: 
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3. Create the Base Template. From within PSE, select Library > Templates > 
Element Templates > New Template. 

 

4. Name the template General Truck. 

  

5. Select the Attribute Template tab. 
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6. In the white space, right-click, then select New Attribute Template or select 
the New Attribute Template button in the menu. 

 Or  

7. Create the attributes standard to all the trucks. 
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Attribute Type Data 
Reference 

UOM Settings 

Actual Oil Level Double PI Point liter %Element%.OilLvl 

Actual Tire 
Pressure 

Double PI Point psi %Element%.TireP 

Gas Tank Capacity Double Table 
Lookup 

US 
Gallon 

SELECT [Gas Tank 
Capacity] FROM 
[Truck Model 
Specifications] 
WHERE Model = 
@Model 

Gas Tank Level Double PI Point US 
Gallon 

%Element%.GasLvl 

License Plate String Table 
Lookup 

 SELECT [License 
Plate] FROM [Truck 
Identification] 
WHERE ID = 
‘%Element%’ 

Model String Table 
Lookup 

 SELECT Model 
FROM [Truck 
Identification] 
WHERE ID = 
‘%Element%’ 

Nominal Oil Level Double Table 
Lookup 

liter SELECT [Nominal 
Oil Level] FROM 
[Truck Model 
Specifications] 
WHERE Model = 
@Model 

Nominal Tire 
Pressure 

Double Table 
Lookup 

psi SELECT [Nominal 
Tire Pressure] 
FROM [Truck 
Model 
Specifications] 
WHERE Model = 
@Model 

Tripmeter Double PI Point mile %Element%.Trip 
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8. Create a derived template for the truck model with GPS Data. 

 

9. The Truck with GPS Data template is derived from the General Truck base 
template. 

 

10. Add attribute templates for GPS Latitude and GPS Longitude to the template 
for the Truck with GPS: 

 

Attribute Type Data 
Reference 

UOM Settings 

GPS Latitude Double PI Point seconds %Element%.GPSLat 

GPS Longitude Double PI Point seconds %Element%.GPSLat 
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11. Check in and refresh the Browse window, If you right-click Elements 
Template in the tree on the left hand side, you have the option to arrange 
templates by template inheritance. That way you will see the relation between 
the templates. The default is to arrange by name. 

 

 

12. Create individual elements for the eight (8) trucks currently operated by ABC 
Mining. Name them according to the initial table with vehicle listing. 
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13. Verify all the expected fields are present in the individual elements 
representing the appropriate model. Truck SP1 is shown below for reference: 

 

14. Verify all attributes are being updated based on the PI Points. For example, 
Gas Tank Level is based on %Element%.GasLvl but the tag should be listed 
as SP1.GasLvl with the appropriate Element ID in place of %Element% 

 

15. Add a new UOM class Fuel Efficiency that has unit-of-measure MPG as its 
canonical unit. 
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16. Add the Fuel Efficiency calculation to the base template. As mentioned in the 
hint, the Fuel Efficiency can be calculated using the gas tank level, trip meter, 
and gas tank capacity. Assign MPG as the Default UOM. 

 

 

17. Add a further unit-of-measure Liter per 100 km (abbreviation: l/100km) to 
UOM class Fuel Efficiency. 
Enter the formulas as below: 

 

 

 

18. Add Fuel Efficiency (European Units) as a child attribute for Fuel Efficiency. 
Assign L per 100 km as default UOM. Use a Formula Data Reference and 
refer to the Fuel Efficiency. Set Result UOM to MPG: 
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19. After adding this to the base template, check in the template, then verify the 
elements have the fuel efficiency attribute added. 
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12.4 Solution: How to import data from an Excel File into an AF Table  

The following steps describe how to import data from an Excel file (here: 
TXLakeWindFarm_WPUModels.xlsx, located in c:\class\Exercises\04_TxLake Wind 
Farm folder) 

 

Step-by-Step Solution (64-bit PI System Explorer) 

In PI System Explorer, navigate to the AF table or create one as described in Create 
AF tables. 

1. In the Library pane, expand the Tables node, and select New Table. 
The table details display in the right pane.  
 

2. Click Import. 
The corresponding window opens. 
 

3. Click Build. 
The Data Link Properties window opens. 
  

4. On the Provider tab, select the provider according to the version of Microsoft 
Office that you are using and click Next. 
 
For Office 2007 and higher: select Microsoft Office 12.0 Access Database 
Engine OLE DB Provider.  

Note: though we have Excel 2016 (16.0.4266.1001), do not select Microsoft Office 16.0 
Access Database Engine OLE DB Provider 

javascript:CVPortal.components.lcContent.loadDoc(null,%20%7b%20docid:%20'GUID-1432C8C0-A11D-41DD-9C8F-BE061B5B57C9',%20filename:%20'GUID-1432C8C0-A11D-41DD-9C8F-BE061B5B57C9.xml'%20%7d);
javascript:CVPortal.components.lcContent.loadDoc(null,%20%7b%20docid:%20'GUID-1432C8C0-A11D-41DD-9C8F-BE061B5B57C9',%20filename:%20'GUID-1432C8C0-A11D-41DD-9C8F-BE061B5B57C9.xml'%20%7d);
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5. On the Connection tab, specify the following and click OK. 
 
Data Source 
The location and file name of the workbook: 
c:\class\Exercises\04_TxLake Wind Farm\TXLakeWindFarm_WPUModels - 
2014.xlsx 
 
User Name 
Login credentials of a user that has been granted read access to the 
database or workbook. Keep Admin, blank password. 
 

6. On the Advanced tab, in the Access permissions list, select Share Deny 
None. 
 

7. On the All tab, select the Extended Properties value and click Edit Value. 
 
The Edit Property Value window opens. Enter: Excel 12.0 
 

8. To verify that the spreadsheet is accessible, return to the Connection tab 
and click Test Connection.  

9. If the settings are valid, a Test connection succeeded message displays. 
 
To dismiss the window and return to PI System Explorer, click OK.  
 

10. To define the data to be returned from the spreadsheet, enter an SQL query 
in the Query field. To dismiss the window, click OK. 
 
Into the query line, enter: SELECT * FROM [Models$] 
 

11. To review the resulting data, examine the Table tab. If the query is specified 
correctly, the tab contains a table displaying the results.  
 

12. To save your changes, right-click the table node and choose Check In.  

 
 

Step-by-Step Solution (32-bit PI System Explorer) 

1. Open the .xlsx file in MS Excel and Save as Excel 97-2003 Workbook (.xls).  
 

2. Follow the same steps as above. 
 
As Provider, select Microsoft Jet 4.0 OLE DB Provider 
Under Extended Properties, for Excel 97 – 2003, enter Excel 8.0 
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13. Resources 

13.1 Training Options 

The OSIsoft Training page is located at https://learning.osisoft.com.  
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13.1.1 Instructor Led Training 

Instructor led training at our public training site - Our classic offering - Learn about 
the PI System at OSIsoft Training Centers with classes in several languages and 
growing! 

 

Instructor led training at your site - Our personalized offering - Learn with customized 
curriculum and get coaching at your site, at your time, with your data!  

13.1.2 OnLine Training 

Small Private Online Courses - Our latest offering - Learn about the PI System from 
your own office or home, on your own schedule, with your own data!  For more 
information go to https://pisquare.osisoft.com/community/Master-PI 

 

On Demand Learning:  YouTube Channel - Learning Anywhere, Everywhere - Learn 
about the PI system by watching any of our 1000+ free videos on You Tube!  Playlist 
for various topics are available to help guide you through your training topic. 

 

VLE – Virtual Learning Environment - is a fully functional PI System running in our 
Microsoft Azure cloud. We have a wide array of defined labs, from PI ProcessBook 
to AF to developer technologies. 

 

13.2 OSIsoft Community 

PI Square is OSIsoft’s Community.  Here you can make connections with  

• other OSIsoft employees and customers; 

• PI Dev Club to assist in your development projects; 
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13.3 Tech Support 

We recommend visiting the Tech Support site, http://techsupport.osisoft.com. 

 

 

 

From here you have many options.  

• You can download anything your company is licensed for using the Download 
center.  

• You can view OSIsoft’ s Roadmap to get information about the most current 
releases and predicated release dates and features for new version or 
products.  

• You can login and view your support calls, both currently open and previously 
closed.  

• You can also search through our Knowledge Base to try and troubleshoot any 
issues you may be having on your own. 

The phone number and email address for OSIsoft Technical Support: 

• Phone: (01) 510 297-5828 US or search 
https://techsupport.osisoft.com/Contact-Us/ for your local contact number. 

• E-Mail: support@osisoft.com 

• Before you contact Tech Support, collect 

o the name of the product and the version number..  

o Determine the PI version and build numbers using the Operation > 
Version option in SMT.  

o Get computer platform (CPU type, operating system, and version 
number) as follows: 

http://techsupport.osisoft.com/
https://techsupport.osisoft.com/Contact-Us/
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▪ On Windows, right-click on My Computer icon and select 
Properties tab. 

▪ On UNIX, type uname -a 

o Note the time that the difficulty started, and be prepared to report the 
contents of the message log at that time. The message log is found in 
the Operation > Message Log Viewer option in SMT.  

o You will likely also need the PIPC log covering the applicable time 
range. This log is located in \\pipc\dat. 

13.4 Further Questions 

For questions about Licensing, if you are in the US, you can find your salesman 
listed at http://www.osisoft.com > Contact Us > US Sales. If you are outside the US 
you can find your salesman listed at http://www.osisoft.com > Contact Us > 
International Sales. 

For questions about existing Support Issues, you should call technical support at 510 
297-5828 or visit http://techsupport.osisoft.com > My Support > My Calls. 

For questions about unresolved training issues, contact your instructor or email 
learning@osisoft.com. 

For all other questions, please contact our Customer Service group via email at 
customerservice@osisoft.com. 

 

http://www.osisoft.com/
http://www.osisoft.com/
http://techsupport.osisoft.com/
mailto:learning@osisoft.com
mailto:customerservice@osisoft.com
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14. Software Versions Used in this Document 

The list below describes the software versions used in this version of the course. 

Software Version 

Windows Server  2016 

Data Archive Server 2018 SP2 (3.4.425.1435) 

PI System Management Tools 2018 (3.6.3.30) 

AF Server 2018 SP2 (2.10.5.9050) 

PI System Explorer 2018 SP2 (2.10.5.9050) 

PI Analysis Service 2018 SP2 (2.10.5.9050) 

PI Notifications Service 2018 SP2 (2.10.5.9050) 

PI Vision 2017 R2 Update 1 (3.3.0.9) 

PI Web API 2017 R2 SP1 (1.11.0.640) 

PI Datalink 2019 (5.5.0.0) 

PI ProcessBook 2015 R2 SP2 (3.6.2.271) 

Microsoft Office (64-bit) 2016 

Microsoft SQL Server (64-bit) 2014 (12.0.2000.8) 
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15. Appendix A Substitution Parameters 

Defining the Substitution Parameters  

The substitution parameters are listed in the following table. The ones in bold are the 
commonly used “Name” substitution parameters.  

 

Parameter  Will be replaced by this object’s name:  

%..\Element%  

The name of the owning element of the element in which 
the attribute resides. To retrieve further ancestors, use the 
‘..\’ notations, such as %..\..\Element%.  

%|Attribute%  
Name of the root attribute or attribute template that holds 
this data reference. 

%..|Attribute%  
The name of the owning attribute in which the attribute 
resides. To retrieve further ancestors, use the ‘..|’ 
notations, such as %..|..|Attribute%.  

%@Attribute% 
The value of the attribute referenced. To retrieve further 
ancestors, use the ‘..|’ notations, such as 
%@..|..|Attribute%. 

%\Element%  
The name of the root AF Element in which the attribute 
resides.  

%<Environment 
Variable>%  

The matching System Environment Variable’s value. For 
example %COMPUTERNAME% is replaced with the 
name of the computer on which the Data Reference is 
executing.  

%Analysis%  
The name of the analysis if it can be obtained from the 
context.  

%Attribute%  The name of the attribute that holds this data reference.  

%AttributeId%  The attribute ID that holds this data reference.  

%Database%  
The name of the AF Database in which the attribute 
resides.  

%Description%  
The description of the attribute that holds this data 
reference.  

%Element%  The name of the AF Element in which the attribute resides.  

mailto:%25@..%7C..%7CAttribute%25
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%ElementDescription%  
The description of the element in which the attribute 
resides.  

%ElementId%  The element ID that holds this data reference.  

%EndTime%  
The local end time if it can be obtained from the time 
context.  

%Model%  
The name of the model if it can be obtained from the 
context.  

%Server%  
The name of the default Data Archive of the AF Database 
in which the attribute resides.  

%StartTime%  
The local start time if it can be obtained from the time 
context.  

%System%  The name of the PI System in which the attribute resides.  

%Time%  The local time if it can be obtained from the time context.  

%UtcEndTime%  
The coordinated universal (UTC) end time if it can be 
obtained from the time context.  

%UtcStartTime%  
The coordinated universal (UTC) start time if it can be 
obtained from the time context.  

%UtcTime%  
The coordinated universal (UTC) time if it can be obtained 
from the time context.  

.\ The current reference 

[.] 

The default object of the parent collection.  For example 
.\Elements[.] |Temperature returns the temperature 
attribute from the primary element of the current 
reference’s Elements collection. 

[@filter=text] 

The search string in text (e.g. Tank*) matches the given 
filter.  Supported filters are: @Name, @Index, @Template, 
@Category, @ReferenceType, @Description, @Type, 
@UOM. 

[@Index=#] Returns the result at location # from the collection result. 

For a complete list refer to “Substitution parameters in data references” in Chapter 
“Configuration of data references” in the PI System Explorer User Guide, version 2015, 
p. 124 ff. 
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16. Revision History 

Revision Reviewer Description 

2010 Martin Bryant Initial version of the Building PI System Assets 
and Analytics with AF class workbook. 

2012 Linda Payne Revision to include comments from instructors 
after few classes’ delivery. 

2012b Louis-Philippe Pagé-Morin Revision to include new features of the 2012  

2014 Alejandro Molano AF 2.6 Update, added Asset-Based analytics 
chapter, Event Frames chapter and EF 
visualization using PI Coresight and PI Datalink. 

2015 Linda Payne, Gerhard 
Polenz 

Replaced Pizza Delivery Vehicles by Mining 
Trucks Application, updated for Azure-based 
learning (VLE) setup 

2015a Linda Payne, Gerhard 
Polenz 

Updated for PI Server 2015 
Revised chapter AF Object SecurityTerm, added 
chapter for Future Data 

2015b Gerhard Polenz Revised exercise 6.2.3 (PIVOT table), Changed 
chapter 9.6 (Future data now created by AF 
Analysis), 
added chapter 12.6. How to import data from 
Excel 

2016a Gerhard Polenz 2016 Software Upgrade. 
Coresight related parts rewritten, EF-related 
exercises revised, attribute traits, attribute 
properties, multiple Asset views, ACE optional 

2016b Gerhard Polenz 2016 R2 Software Upgrade. 
Complete re-write of the Notification section 

2016c Gerhard Polenz new VLE VM security, new student passwords 

2017 R2 Gerhard Polenz 2017 R2 Software Upgrade, Coresight->PIVision 

2018 Gerhard Polenz VLE based on Windows 2016 Server (PISRV01), 
added DisplayDigits, removed PE, Totalizer and 
ACE chapters 

 

 


